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Preface

Keyboard: Comypuiter Scivnce with Application Seftware (Thired Eclition); a series of cight
bouks for Classes 1 1o 81 s a concerted offon 1o impar knowledpe abowt computers wsing
okl I.flll'."rl"htl‘l'lj.} .ll“i il"ll[.'r.'li'ti'ﬂ.' .I[]F]H iﬂl{,’h. [:n-rnpl,ﬂtr LI 1Y 3 ji].'E[Zii'I-'llil'IH ﬂl"lﬂj wrleles-
ranging sulyect with limitless opportunities for creativity and application, Today computers
influence every facet of our lives, In the highly competitive world wie live in, a basic
working knowledge of computers is essential for suceess, There is, therefore, a great desire
to introduce computer education to children al an carly age, There should also be enough
room for them 1o explore and create on their own.

This series introduces the subject in language that is simple and direct, Technical
vocabulary is introduced where necessary and all such terms are defined at the end of
each chapter. Comic etrips, icons, engaging characters, and illustrations make the leaming
process an enjoyable experience.

The content is based on extensive feedback from teachers, and an the latest trends in
computer education. Particular care has been taken to update facts and figures, and to
include information about the latest devices in the market,

The focus of Books 116 5 is on learning the basics of computer science; on understanding
M5 Oifice 2013 and using KTurtle, as a programming language.

Books b to 8 move beyond elementary concepts and introduce Publisher 2013 (Flash
Version C53), HTML 5, Dreamweaver {(Version C€53), Photoshop (C53), Microsoft Small
Basic, and Visual Basic (Version Microsoft Visual Basic 2013 Express), This edition also
gives them the potential opportunity for hands-on experience of sound and video editing
through the programmes, Audacity and Lightworks.

With a strong emphasis on developing 21* century computer skills: critical thinking,
communication, collaboration, and creativity—this edition of Keyboard: Computer Science
with Application Software will prove 1o be invaluable for students and teachers.
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Key Features
tach chapter in this booli is introduced
through two delightful characters,
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Assessment Tools FOR TEACHERS :
Exercises * The downloadabde teaching
contain both objective and descriplive questions, resmurce ks an exciting niew
and test leamers on all aspects of conceptual theory digital teaching aid thal
covered in a chapter, oiffers reinforcement and
assesument materials.
Group Project * The Test Generator is an innovative,
encourages students to collaborate and exchange edsy-to-trir assessment 1oal. It has been
iddeas on comman project, designed to aid teachers in creating a
variaty of test papers from an exlensive
pood of questions for effective evaluation,
In the Lah
challenges students o apply the concepts The course is also supported by:
learned to rial-life situations.
' i fa) Teacher's Noles within the Student's
Books that provide impeartant information
Worksheets and suggestions on creative approaches
4 i 10 & ¢ 7
unit-based and conforming 1o the continuous Chiipter. or 2 Toplc
assessment recommendations of various boards. (b Teaching Guides that include lesson
plans, the complete answer key 1o the
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Introduction to
Access 2013

Bl LI " No probilem, Goggle, .
f .5I'EI Z", in mﬂ;.:.tﬁ;: / { wall help your recal wihat maam
| H_"w ey 'I_ll ﬁ |, taghe and alse cel pou samething
i - o, HOOUC MICTOSOE Access il T

But am nac able o
- recollecy whar she caughe
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A Database Management System (DBMS) arranges all
your data in an orderly manner so that you can retrieve
information easily whenever you need it. It is like keeping
files in a drawer of a cupboard. In this chapter, you will

learn about databases and Access 2013, a popular database = Whit F'rlr.-‘-t-:h'il-":;.:-. =i
managerment application » Batuinase Managomen
YvEEET

* Introducimg Accets ]{I-|,-.'I
WHAT IS A OATABASE? + Creating a Databiase
Every organization has to maintain data peraining to its .uL,[.Ilnl.l.'I:m..Flr”.PLl
business, employees, and other relevant information, For :_i-:!._- {5y
example, a school maintains data on their dudents’ personal + Tataling, Sorting Fiterngand

details, their academic and co-curricular achievements, and Searching Datq
an the details of their teachers and administrative staff,

This data needs 1o be available to a user easily and promptly. This data needs to be updated
regularly and thus, it is preferable to organise the data into a database,
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A tlatabiases is shply an angantsed collection of data, Dataluses arrange information in such o
wiry that any specific plece of infomation can be easily accesseel.

Elements of a Datahnse
Theere ares fowir dlifferent types of dhatabases:

LoHierarchical 2, Network 3 Relational 4, Object-orienied

Of these, the relational database moded is the maest popular, A relational ditabase ssores data
i the form of tables, A tabile arganises data imto rows called records and columns called fields,
Recoeds and fields together make a table, Each record defines information about one entity am
gives complete details about i1, Each field defines information of a certain type for all records,
Tables, fields, and records form the elements of a relational database.

For example, see Table 1,1 callid EmployeeDetails showing ficlds and reconds,

Table 1.0 EmphoyeelTetails tabile with fledds and reconds

Farkhy
| EmpNo | EmpNane EmpTele  EmpEmail
Recoeds | E1001 Kaza Amir BRI EEETH Raza_amiretpmail com
E1nz Beenish Jvid EEIALERE Boonish_lavic®valwo.com

It has two records that contain information aboul two entities, Raza Amir and Beenish Javid. I
has four ficlds that contain information of the same type for these two entitics. For example, the
field EmpEmail comains the email address of cach entity.

The other two elements that we are going to learn abaut in this chapter are keys and data types.

OATRBASE MANAGEMENT SYSTEM

Database management involves creating, modifying, deleting, and adding data in a database.
The software that performs these functions is called a Dalabase Management System (DBMS).
Access, MySQL, and Oracle are some popular DBMS software.

Functions of a DEMS

When a lot of data is stored in various files, there is a possibility of data redundancy, data
inconsistency, incorrect data, etc. A DBMS provides an easy solution to all these problems as il
allows centralised control over data, A DBMS provides the lollowing benefits:

Reduces data redundancy  Data redundancy means duplication of data. For example, a
school may have two separate files to maintain student records, one with students’ addresses

LEFORD a

TR | ey



and the other with thear phone numbwers. A DIMS itegeatis thase twe biles it a simgehe
database tle, Now . the data s stoned ot a 'qlrb!:|l|' !ﬂﬂl 0 Ehwe dlatabvase, b, data r|u|]||-|_',||:ii_|-ﬂ
s rerducesd o vrtually eliminated

Controls data imconsistency Suppose studdent addresses ane stored in b Giles, Hus
Intormation and Fees Intormation’, A student intorms the bus in-charee abour a change in
ackiese S0 the new address will be retlected in the *Bus Intormation” file but the same «hange
mte Mol B made i the Fees Informaation” Ble, Hence, the o Gles wouold have two different
Audiisesaes for the same student, This will not happen in a properly maintained database.
Hiealiv. there will be no redundancy and any change in one tile will be automatically updated
mvenow here else,

Facilitates sharing of dala  Different users can use the same database o extract data based on
their individual needs.

Eniorces standards A DBMS makes it possible to apply certain standards in data representation,
These stancards could be an organization’s own standards or national/international standards.

Ensures data security  In a DBAS, the database administrator has complete control over the
datzbase and ensures that the data is accessible only to authorised people. Dirferent categories

of users can be given difierent permissions. Some may have
the authaority fa anly view the data, while athers may have the Did you Know? ﬁ
authority io modifv data too.

The standards may be
PR & . e defined far names and farmats of
Maintains integrity A D]?-MSI s?ppﬂris database imegrity. v ileiiséis diakim Sty
Suppose a database contains information about the marks repoat formar, ete. Stanclardy in 3
scared by the students in an examination. If the maximum centraised darabase envieanment
marke are 100, vou can have rules 1o make sure that the :::mﬁ‘i “ﬁ;‘:‘;:rcr’" oy
database accepts numbers only in the range of 0 to 100, AT ﬁﬁ:up

INTRODUCING ACCESS 2013

Microsoft Access is one of the popular DBMS applications. s fatest version is Access 2013, 1t

it & redational database, where data is stored in the form of tables. A relational database uses
miuligle 1ables 10 organise data and creates relationships between these tables to retrieve

data. Each specific piece of information in a table is called a value, A value is located at the
interset tion of a column and a row, The total number of values ina able s the number of rows
multiplied by the number of calumns.

Records in a table are amanged according to a common reference valise known as the primary
key or thi key field,

A primary key, Is one ior mose) columnis) whose values uniguely identity every row in a table,
The value in the primary field is different for every recond aned thus helps to identify records

3 OXFORD
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uniquely, For example, in a table containing information about students of Class VI, the
column RollNo behaves as the prinunr ke as gvery student has a unigue roll number,

flements of Access 2013
Arcess 2013 includes a new user interface (Fig. 1.11 as compared 1o the previous version. The
elemonts are:

Restore Dirwn
Program jcon  Qeick Access Toolkar Tilebar Help  Minimize  Madmize  Clow
g =" RiE T Catsbasad: Dotabaie Cllml N DnemeniZn. 7 o = :.:-l
h pows  CEEATE  TOTUEWALBATS  pATHRAAEANG S TARR !-rn-]—|
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Fig. 1.1 Access 2013 Interface

Title bar It appears at the top of the window and displays the B - - s

name of the active database and by default, displays the path to H-Lpn-m: =2

the falder where it is stored. It also provides tools for managing the um

program and the program window. 4R

At the left end of the title bar is the Pragram icon. When you click = Minimize

this icon, a list of commands with the option to Restore, Move, [ e S

Size, Minimise, Maximise, and Close is displayed iFig. 1.21. | x Close AT

To the right of the Access Program icon is the Quick Access Fi. 1.2 Program fcon merd

Toolbar. By default, the Quick Access Toolbar displays the Save, options

Undo and Redo buttons. You can customise it to display more .

commands of your choice (Fig. 1.3, H - ¢ _‘!

At the right end of the title bar, there are four buttons: Fig. 1.3 Quick Access

Toolbar

The Help button opens the Access help window where you can search

for any information on Access 2013,

ol 4 !
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Minimise, Restore/Maximise, and Close buttons are on the right side of
the bar (Fig. 1.4), 7T - 0O X

Fig. 1.4 Control buttons

Ribbon This is the area below the Title bar, The top of the ribbon
has a set of tabs. Clicking the tab displays its associated set of commands. Back armen
Commands are organised into groups. The main tabs are FILE, HOME,
CREATE, EXTERNAL DATA, and DATABASE TOOLS,

FILE tab It has commands that help manage Access and Access
databases, Click the FILE tab located at the extreme left of the ribbon o
open the FILE menu and the Backstage view.

Commands available in the FILE menu are Info, New, Open, Save, Save
As, Print, Close, Account and Options. You can go back 1o the database
and the ribbon by clicking the back arrow (Fig. 1.5,

Mavigation Pane  This is the area on the left of the window and it displays
your database objects. When you open a database or create a new one, the
names of the database objects appear in the Mavigation pane.

Tabbed document Database ohjects appear as tabbed documents. The
tabs can be seen on the tab bar.

Status bar  This bar is present at the bottom of the window., It displays
information about the current database and includes buttons to
change views,

Fig. 1.5 FILE menu

Datahase Dhjects
An object in a database could be any of the following:

Table It stores the data in a database.

Form It lets you enter and display data in a customized format.

Query |1 retrieves data from one or more tables based on a selection criteria
Report It displays data in an easy-to-read format for printing.

Macro It automates tasks that are performed often.

Module Contains programming statements written in VBA programming language.
We will learn about tables, forms, gueries, and reports in this class.

Starting ACccess 2013

To start Access 2013, select Start » All Programs (Fig. 1.61 » Microsoit Office 2013 iFig. 1.7:p
Access 2013 (Fig. 1.8).
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Fig, 1.6 Sclect All Programs Fig. 1.7 Select Micrasoft Fig. 1.8 Select Access 2013
Office 2013

This will display the start screen of Access 2013 (Fig. 1.9).

CREATING A DATABASE

To create a new database,
vou can choose an Access
template that has various built-
n tables, queries, forms, and
reports that are ready to use.
You can alsa search online for
more templates,

Or
You may create a database

Iroim scratch by clicking Blank
desktop database.

Fig. 1.9 Start screen of Access 2013

Creating a Database Using a Template

In order to create a database using pre-defined templates,
follow the steps given below:

1. In the Access 2013 start screen, click on, say, Conlacts in

the Suggested searches row to display a list of available
templates (Fig. 1.10),

2. Select, say, the Desktop personal conlact template
{Fig. 1.11). It displays a description of the template and

asks you to enter the name of the database under File
Name.

You can either use the default location that Access shows
below the File Name box, or click the folder icon 1o
select another location,

Fig. 1.10 Gallery of Contacts
tempiates

ﬁlEI?EL'IJI B
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3. Click Create.

Access creates the database and displays
the table in Datasheet view (Fig. 1.12).

o T AT b ey iy Wy
PP P P s bt i s o
hj ls T,
B ] Wty s S e
o nerry, o o B i e i
M b Dl

The Mavigation pane displays all
the objects.

ey @ E R O ey

i i = — o T -1

] | = [ Top Tip E}
_ Bt IF Access displays a security wamning message
ﬂh in the message bar and you trust the source of the

_ tempane, chck Enable Content.

Fig. 1.11 Desktop persanal contact manager screen
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Fig. 1.12 The database file created
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Create a Database from Scratch

If none of the existing templates fits your needs, you might start with a blank desktop database.
The steps to create a blank database are;

1. Click Blank desktop database (Fiz. 1.9).

2. Type a name for your database in the File Name box (Fig. 1.14). The default name is

Databasen.accdb ( where n is a numeral in sequence, i.e, 1,2, 3...... S0 0N},
" OXFORD
L] B £E a M VEEHTH miii
] B | L] E EEEE ® L
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3. Yau can either use the default location that Access : SO
shows below the File Name box or click the folder . —b] - )
scon to select anather location (Fig. 1.13). Click | | e—

Creale. | 5
You will see a blank table — Tablel — in L B =i

Dalasheet View where you can add data (Fig. 1.14).

, Fig. 1.13 Blank deskiop database
By default, the first field in each new lable is an 10

field, This is the primary key, an g TR e T e
entry that will uniquely identify uoai CIEATT  EXTIMGALDATA  DAMMMMETOOLS  TMDS  tamy |
each rec.urd in the table. No bwo b w8 12 & g:-:k- e __:::'lr“ piin '
recards in this table can have the Wom St Marmbes Comnry 0 Y =l
same value for the primary key i s s e !
field. You can also rename it. Let T Access Obje.. @ =] 3 == =
us enter the first record. e | I —

4. Select the empty cell below = !
Click to Add in the table. Enter Fig. 1.14 Blank table — Tablel — in Datasheet view
Sonia Khan and then press the
Tab key to move to the next field TR — = T—
IFiE f.13k BOME CAERTE  FETPRIGALDATA  OATABAME TEXmS  FELSG  TaRE
Motice that the icon inthe record [k s 12 & g::..- 2 :u.l..";.,. s ._
selector has changed to a pencil W A Wi Commty i ™™ it T
to indicate that this record has s deioo_ Prptie
not been saved yet. Thevalue 1 | All Access Dbje.. :;:; N T T
appears in the ID field, the name | Pencilicon , # I.HI#II Sosaben ||
of the second column has changed | B3 ™=
to Field1 and Click to Add label Fig. 1.15 Adding fields to a table

has moved to the third column,
5. Click the pencil icon in the record selector o save the record before you move on. |
b. Click the cell below Click to Add, and then enter the information shown in the new cell

{Fig. 1.16). Press Tab after each entry.

Notice that two tabs appear on the ribbon — FIELDS and TABLE — under TABLE TOOLS.
Top Tip __:

H you de not save the first record, Access increments the ID value every time you add a new field to the record.
For example, if you add seven fields, Access assigns the value 7 vo the 1D Field of the firsz recard. To avoid this
probéem, you simply click the Pencil icon in the record selector afoer yout enter your first value in the fiest
This sawes the recosd with the value 1 assigned to the |0 field, and subsequent records will be numbered m‘“ﬂ“m‘l_ iy,
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Fig. 1.16 Entering values jor the first recond

7. Mow, rename the field names to some meaningful names. For example, double-click the 1D
field name and rename it EmplD,

i 7 BE % o T ¥ o= Fm
B Repest skp 7 ox the oty e R A
fields and rename them as |4 4y 13 @3 ¥ Bambomn S s e 3
shown in Figure 1.17. B M R i W ¥ e e
9. At any lime you can save AR Acces # - 3"_*;_#:“ — :hl_“ _:h"_
the table by clicking the ';“-. | T Y oo
Save button on the Quick i
Access Toolbar,

Fig. 1.17 Renamed field names

10. Under Table Name enter
a name, say, Employees and then click OK (Fig, 1100 1o close the table and add it 1o the

Tables group in the Navigation pane (Fig. 1,195,

Fig. 1.10 Save As diadog box

Fig. 1.19 Employees table
added to the Mavigation pane

: T E—
o All Access Obje... @ «| | _TopTip ¥
[Ermcpees - | i Yau can rename ar dedets
Wbk 2 | arable by right-clicking it in
- &L!:Iu ] Bl empioyees I tihe Mavigation pane and then
sefecting rhe required option,

Haming a Field
Rules for naming a field are as follows:

s A field name can be 1 to b4 characters long.

s A field name can include letters, numbers, and some special characters. The underscore {_)

sign is allowed and is often used.

= A field name cannot have a period (.}, an exclamation
mark !}, brackets ([ 1) or the grave accent ),

e A field name cannot start with a blank space.
s A field name can be in upper, lower, or mixed case.

-

a

Did you Know?

Youl can change the field
niame at any tirme even if the table
contains data.
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SUTTING DATA TYPES
St 4 data Type fon a el Belps tocontinl what you can enier in . el Notidoe 10 Tishs thus

dlata iy i availaliles i A cess MY E
Talile 1.2 Dt dypues o Ar e M

Shot ] Tead It 1e e 1o store texd, cambimataons osf tiemd are] nombsers (ke arkekresses), ol
mumbiers that will not he wsed i calealations {likt= phicwse: rumbsees aned gradal eodes,

M can store up b 255 4 haracters,

Long Text i is wseed 1o store long text like notes and descriptions, It can store up io 63,555
¢ haraciers,
Sumibser i is ueedd for sumeric data that will be used in calculatinns.

Date/Time 1 stores date and time values. You can digplay the dates and times in various fomats

Currency Yoww can specify various currencies and display them in different formats,

AutoNumber It stores an integer that increments automatically as you adld records. I the tabie
does not have a primary key, then AutaNumber uniguely identifies the records, If
vou delete 3 recond, its AutaNumber value is not reused, and remaining records an
not updated. The 10 field in a new table is automatically assigned the AutoNumber
elatatypu.

Yes/No This can have anly one of two values, True or False. You can adjust thie Fuemal sething
1o display as Yes'No or TruefFalse,

OLE Object  This stores praphics or objects such as a Microson Excel workshest or Micrasodt Word
document,

Hyperlink This is a clickable path 1o a folder on your hard disk, a network Jocation, or a wetnite

Attachment  This is used 1o attach a file 10 a record in the same wary you attach a file to an emal
message.

Calculated It is wsed 1o store the results of a caleulation based un other felds in the seme able

When you create a field by entering data in the Datasheet View, Access examines the data o
determine the appropriate data type for the field. But, if you want to change the data type, o
the following:

1. Click the field header whose data type you want te change.

2. In this Formatting group of thee FIELDS tab, chick the diop-dosn mens amosy of the Data
Type option, Select the regquired data vype fromm the dropecosn st that appears (g, 120

i FiLamia mn
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i 120 Dada Type drop-tloswn lise

_ Click to Add
Arather method is o selieet a data type and then add data o the feld, |, i r“h
Uk thae el dhowvny menu arowy of the Click to Add field and seleet | 13 s

data tvpe B 1000 Meoww, ackd data te this fleld. &7 Cymency

Ry Date & Time

UPEHING AX EHISTING DATADASE [ e

i | i ' i & FE R 2
Yor Con opeen an existing database in Access 2013 by following the th“kowilpc Svatend

Ad Ficks Tet
sl privien Below: i,
AL Lgng Tt

1. Select FILE» Open.

_.I sty e
. ! . Do
2. Selet ! Compuler in the center pane and then click on Browse = St
i the Open page that appears. You can open a file by selecting keticulated Figld .
either Recent, OneDrive, or Computer (15 1220, Pk 3v Erefidy
Fiz. 1.21 Click to Add
|..-.-.|.....:-: [ TeSLET oLt Pamp————— ey SRl TTUSE. S R SPU TR IR - B ill"ll"l'l"i!.'l'l-'l-n nuengs
b= F-I
Dj}E‘ﬂ 1. Choose the drive and
L Freiie L] "
s hae databiase in the Open
A inslsne ~ by P wmorn dialog box that appears.
Ay el |y i ’ |
(] Cumpen e Select the required
¢ Divaliig databyase and then click
d rarana od the Open button,
il

Fig, 122 Open soieen
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MODIFPING TABLE DESIGH

Sometimes you may need to change the table design after creating a tahle: In Datasheet View
you can add, delete, rename, move, and change the data type of a field (Fig. 1.23).

T = —
R % o R TT R e L] Databusel  Detaben Ehlberdt DO Dovamenilant. 7 E &

e
joRil  CEAE]  UmmesLBwEs  DATARASI OGRS | LM TARE j'!l

1 i ] mequaed
b_-l"" AR 12 -:_35 IS G i T - LF1H Euu-u.:_.,q—n :';:L jr."l' lads| :T:-Hl;n::-:* .|u @
St Veer I e S higas i
g 1::' ';'_H'.r_; Ulad [l * L".r..unni_q:- i E,_I::::,.:,F.,:._: H.,'_' PR WS ] rehuenl T
Ll s Dty Fieprdii Foimafirg I wad o waliian &

Fig. 1.23 FIELDS tab under TABLE TOOLS

Add or Delete a Field

1. Click the column header to the right of which you want to add a field with the required
data type.

2. Click the required data type button in the Add & Delete group on the FIELDS tab. A new
field named Field1 is inserted. If you want 1o delete a field, click the field to select it and
then click Delete in the Add & Delete group. Click Yes in the message box that appears, to
permanently delete the field(s).

T Lewprpers
move & Field SR e : —
] | L Sora e 15-ca- Manager I E b T
1. Click the column header that 2 Semsea Crmamary

you want 1o move, Fig. 1.24 Drag o move field

2. Drag it to the left or right. Notice the thick line that

appears on dragging. Release the mouse button Mo Totaks
(Fig. 1.24), Bty SE e 5P Spefing
A= 2 Delete = ﬂm‘[}

Eeaads '!&1'

HidesUnhide Fields or Columns =M

. 11[ oo Height ...
1. Click the column header. If you want to select [ RE—— ’

mare than one column, press the SHIFT key, Hide Fieldy

Ushide Fields
1 Freeze Fields

2. Click the HOME tab. In the Records group, click
the: More button and then click Hide Fields

Ualreesr &8 Faeldi
F- 1.25). Now you cannot see the hidden fields in 03 B it
Datasheel View. _
Fig. 1.25 Records group on the HOME tab
LY FCHLLY
FEEARIE “ B Em ® 2
I B N BOEE & B =
- o 58 BEE EDEE BEB &o il



3. Inthe Records proup, click the More button and
click Unhide Fields to open the Unhide Columns
dialop box (Fig. 1.261 You can select and clear check
boxes to control which fields should be visible.

To Freere/Unfreeze Felds

If you have a number of fields in a table, you will not
be able to see the entire set of fields until you scroll 1o
the right. You can freeze the required fields you wish to
see.

1. To freeze the fields, click the column header,
2. Click the HOME 1ab, In the Records

group, click the More button and (e
A Top Ti 1me)
then click Freeze Fields iFig. 1,25, i
MNow you can see all the reeze The cammands to hide, unhide, freeze and wnfreeze
fields while scrolling on the right. columns are also available from the cantext meny that opens
when pou nght-click a feld mame.

3. To restore the fields to their previous
state, click More in the Records

group and then click Unfreeze All Fields.

To Change a field's Format
1. Click the column header.

2. On the FIELDS tab click the arrow next to the Format [ Did you Know? _ﬂ
text box in the Formatling group,

: The farmac lisc may be unavailable
3. Select the required format. For example, in Figure fior some fields {for example, text)

1,27 the format for the date on which the employee depending on the data type of the field
joined is being changed.

0 Bl % c*- ¢ Dotsbussls Detsbare DYTsS0HY Dot urmem TR
HOME  CREATH  [OTTRRGA BATA  pefapsdd T0MAT PO TERG
b s 17 O Boasres Ui Hreestose cTiios i Sewies
Vo T _mﬁﬁm -;.1 L_"';"""'""'"" R
" Taal [ S 13 7 4 PO Firbira Sy Fr—
Warwi AR O s . - h
CI s T [STES N
I e e e
w1 Tumg
= Pomakhe Mg 408 004 we T
A Sabuars Dy ik 11-13-JO0E 1188 ":'T:_' .
(R T L e AT T e s -

13 OXFORD

[ L T



y

PRACTICE TIME

Rawa has 1o crewte & talile callid - p—————r

StudentAdmission . dwown Stutlendil) « | StudentName - StudentCourse - Studentfes ©

Alegside and then Tie has to do [sat it M o
(503 Dhues Al MCA SEnag

the Fllowvangy 500 R brini BToch, 85600

L Remame the hidd StudentFee | 50 Aaan Exsa BTach, 23000
| MCH 33000

16 Fee Ansolnt. | 508 Perans finumi

il
s

-

M the StudentMame field 1o the right of the StudentCourse field
Hidhe the field StudentMame and then unhide it

DCrelete the field Fee Amount 3s it ts no lomger needed

Could you hedp bum with the eps he needs to foliow?

SOLUTION

1
A

E}H}'{rﬂm

By rmpan

Open a blank darabase and create the tble with the congents 35 shown in the figure above,
To rename the field, StudentFee:

3. Double-click the Field header and type in the new name — Eee Amount

To move the field, StudentName, to the right of the StudentCourse field

a. Chick the column header StudentMame

o Drag it to the right afrer the StudentCourse field Relegse the mouse buman.

To hide the feld, StudentName:

a. Click the column header

B Select the HOME tab. in the Records Broup, cick the More button and then click Hide
Fields. MNow you cannat see the field in Datasheet View

To unhide the field, StudentMame

a. Select the HOME tab in the Records Broup, clsck the More button and then click Unhide
Caolumns.

b This opens the Unhide Columns diafog box, Duselect thie check box to make the field visible.
To delete the field, Fee Amount

a. Chek the column header,

B Click Delete in the Add & Delete group on the FIELDS rab

€ A message bow with the message 'Da you want to permanently delete the selected
field(s) and all the data in the field(s)?" will appear
d. Chek Yes to permanently delete the fied,

u [ gE =
B B @ EEEE @ ©
EE_mueE _smeE sew o



TOTALING, SOATIRG, TICTCRING, AND SEARCHING DATH
Yo e beart o to swm, soel, and flter data in Execel, Youw cam elo thee samee in Acciss oo,

Caleulations in Ootashoet Yiow

Avcess 2001 has o feature called Totals that makes i i :-:-Hllu A A1
| ¥ ' | i & LIRS
easier b perform mathematical calculations with data. - T -
This festure lets you find out the sum, count, average, | o e
ete., for your data. G e s 43
1 biaww Liranp 1Y &L

1. Let us creale a table called StudentDetails in Datasheet 8 A Tavew ke
? 3 Srbear Blam B

View as shoswm in Figene 120, B3 St (pba L ey

|,:!| = e 3 Tatak
F.::I::h M Z Spating
Ell= ;" Rinlicki Dl‘h"'

Fig. 1.29 Records proup
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Fig. 1.30 Totals funcisns

Sorting Data
You can sorl the information stored in a table based on the values in one or more fields in either
ascending or descending order,
1. In the Tables group, double-click StudentDetails 1o open the mble in Datasheet View,

2. Click the drop-tlown menu arrow of the TotalMarks ficld to display 2 menu of sorting and
filiering optians (Fig, 1.32),

n L
|

T} sl
[ T T LIFE = Ipfalieds « fagle o

Fig, 120 Table in Datasheet View

2, Mow click Totals in the Records proup on the HOME
tah (Fig, 1.21),

1. This shaws the Total row at the hattom af the
datasheet. In the Total row, click the field 1o he
summarized, in this case, TotalMarks, Then select a
function from the list. Let us select Average (Fig. 1.3,

4. You will get the average of values in the TotalMarks
column (Fig. 1,31},

T Sisdnribaiady
Rlo - Mame - TotalMarks - Grade -
1 Mg i 445 Al
d Dean Al £13 &7
1 Hawdd @lia 559 BL
4 Hisa vulva 544 &)
3 Han Berw B4 |
i S=@cor Heds & A
¥ lboan ey 455 &1
i Aas Bany P Nk
9 Eadwan Ham 13 03
15 Sweem Dbl 1230z
- fNew| g L]
Total [+]  mmia

Figg. 1.31 Takde showing the sverage value
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Fig. 1.32 Sorting and filtering aptions

4, The upward pointing arrow to the right of the
TotalMarks field indicates that the table is sorted in

the ascending order on this field.

5. Click Sort Largest to Smallest to rearrange the
records in descending order of TotalMarks,
The downward pointing arrow to the right of
the TotalMarks field indicates that the table is
now sorted in the descending order on this field
(Fig. 1.34).

6. If you wish to undo the sorting, on the HOME tab, in
the Sort & Filter group, click the Remove Sort button
(Fig, 1.35).

Filtering Data
If you wish to filter data do as follows:

1. In the column you want to filter, click the arrow to the

1, Click Sorl Smallest to Largest 1o

rearranpe the records in ascending
order of TotalMarks (Fig. 1.3,

=
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Eaiibe - Biane - Grade .
I g A Bavvd ! tﬂlu
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Fig. 1.33 Data sorted in ascenting e
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fl Descending  T5) Advanced~ |
fo Remove T Toggle Filter
St FIJII:[

Y #1 Ascending W Sedection -
Filtes

Fig. 1.35 Sorl & Fillter group

right of the Grade column header and clear the Select All check box (Fig. 1.361.

2, Now select the grade that you want to see
in your datasheet. You can select as many
as you need. Here, A1 and A2 are selected.

Top Tip

Anather option to sort data is: On the HOME

Access 2013 will display the rows with the tab, in the Sort & Filter group, click Ascending

corresponding values you have selected and
will hide the rest (Fig, 1.37).

Mote: You are not deleting any data, just hiding it.

OXFORD 16
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or Descending button to arrange the records in
ascending or descending arder, respectively.
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T oateertenm ': i L -
Boifiz - Rgms - Tetafiers - | EMER;, O s-dsr - R e T
= igmgp By eyt i I"-_*1a-'. 1 Aoy B -ﬂ-. |
1 T &) FERN R o | 2 Der= By
1 S man J!I'-P'l:l e = | 3 Eopor 0w Al
2 FiEm Ve s Tl = | i e £ A
1 Eiwg S e “azirm Il R
8 Bqmemy K i AT = Fig. 1.37 Ficerad data
TS By aim a1 T
1 ber= S b 1= Tz i
¥ Saer b ] = £ 3. Aner vou click OK. an icon
i S Taine g = =: s Be A &
. e . Fe appears o ingdicate that the
column has filtered data,
- - i vou point at the icon. Acowss
a1 t:l‘— i . LA G Ll - A
2013 will dizsplay the filter
Fig. 1.36 Select All eption critenia e 1L38 -
Top Tip ﬁ}“ e !
- il w Rk - Tomdatu - ade A O P A e |
You can alia sefect the column - :""_____'__u" . E! p——— T
header and click the Filver burtan T # Saneor s =L
il the Sort & Filter group on the T e Sawts £ AL
ditiganhoochid e kslonans Fig. 1.38 Display fifnee criesia

4. Toremove the filter, click the Toggle Filter button in the Sort &
Filler group on the HOME tab ‘Fiz. 1.39 . The datasheet will go

back to the original state.

advanced Filtering

You have seen how to do simple filtering in Access 2013.

T odmeany T raaer

- ] g S ‘;--_'IJ-"-\.'I.'- |
il

: W Toppetne
fe4 R Em |

Fig. 1.39 Togele Filter cption

Follow these steps for =
advanced ﬁllE‘l‘il‘lE.' Rty - fame - DERMANRLS Orate - Ciersdse -
1. Click the arrow 1o the right sowrst | :J SRS
of the TotalMarks column hoodictey ™
header. You can also eesssame : i iy . i
select the column header il ey il
and click the Filter button y S 7= S e |
in the Sort & Filter group | w1 eemaseaes i P ;
on the HOME tab. From ' — -
the menu that appears, - .
click Number Filters, and - G
click Between... in the
submenu (Fig. 1400, Fig. 1.40 Number Filters submenu
17 O FORD
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2,

The Between Numbers dialog box appears, Type 350 in e - =
the Smallest text box and 450 in the Largest toxt box and S o
click OK {Fig. 1.41). [ & [}_l e J
Fig, 141 Belween Number;
dialng box
. You will now see only records of those students having
total marks in the range of 350 to 450 (Fig, 1.42). Rl +  Wame o [TERRMERA Gy
3 Desan A8 | : 1
. To remove the filter, click Toggle Filter in the Sorl & § ity eakd "
Filter group on the HOME tab. If you click the Toggle ol huir

Filter button again, the current filter will be reapplied. Fig. 1.42 Filtored records

Searching for Data

To search for data quickly, use the Search box at the e —

bottom of the Access screen, moiires - [ Fiame | | TecawAmus | Gesde .
| ¥ by i igd Al

1. Enter part or all of a ward, phrase, date, or number in 2 Doas Al a1 Al

1 st i) " ol

the Search box and press the ENTER key. Let us, for | o | i

example, enter Raza in the Search box. | :f“:::,:: . —
. Access 2013 highlights the corresponding characters i) e
in the first record that matches your search (Fig. 1.43), ibssatetlane ok
1% Bowyrei Healnd 135 KX
. Ta find the next matching record, press the ENTER | inew .
key again, Access finds all records that match your Boih @ shares (b wp | sidnas | idmuss
search data, anywhere in your datasheet, Fig. 1.43 Search record bs hightighted
5 "I'I
PRACTICE TIME J
Create a table named Employees, using —— i —
the data given alongsideand dothe LRG| EmpiName DeptiNo _ Salary () |
' foflowing. E101 | Asiya lqh.'l._l _ 10 B5000
"1. Find the torad of Satary. E102 Alvina Hussain | 20 45000
Y2 Sorchewbleintheascending | £103 | Amber Sharig | 20 54000
m— d — ' -
. uscorEmptine E104 | PalwashaAman | 30 | 56000
S memmenthedornons” [eins. | el 10 45000
! Eﬂﬂﬂ'lﬂ-m&r‘" i PRI NP —
-~ £106 | Manal shamsi |30 | 49000
i
ey & AT @ 18 .
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BEE mL

Filter all ghe neg orck, o [hepuat st

Numbier (s e Ay fﬁ'ﬂ‘ﬁm pName
—_— il ¥ =

B Filter all the regoniy whiee salary O EIOR At leglal
FIvalier afein S0

I i Labda Alarn
B b b B the wpy Ol ol ks
SOMLTIGN
ooCwane iy tabily Crpligees in Datasheer View
Ti

Uhard thee 1t gl =..1|.1r-|.- il aff tha E"l"l|'.l:l'l':|l1:|:"!|

LIk Totals i the Records fitoup an the HOME taby, This willl shaw the Total /o & e
bottom ol the datashes

[
2 Inthe Total row, select the Salary fiefd and then select the Sum funcnon oy w gor-the
surmi of all the values i the eofurmn

3. Tosort by EmpName in ascending order

A Chek the armow 1o the nght of the EmpMame calismn header

B Chck Sort A to Z in the drop-down meny ta woet the da i ascending grder
4 Tosert by Salary in descending order

2. Click the atow ta the right of the Salary column heades

B Click Sort Largest to Smallest in the drop-dewn meny 105077 the dacs in descendmg onds
5 Tofiler 2% the teddrds of DeptNo 200

2. Chick the arrow 1o the fight of the DeptNe column hezds:
5 Destiect Sebeet Al Select the check box of daza 20 and ek DK

€ You will see 28 reconds of Deprie 20
& Toremove the filter, chck Toggle Filter i the Sort & Filter group on the HOME ts
6 Tof(iter 2l the reconds where Salary is greater than 50000

2. Chck the armow o the nght of the Salary column header, dick Number Filters, 30 o cc
Greater Than m the submeny

b The Custom Filter dalog box appears. Type 50000 and click OK. You will now sae anly
thaowe fecords whese salary i greater than 50000
£ Toremove the filves chck Toggle Filter in the Sort & Filter group o the HOME t3b
7. Tossarch for the record of Palwasha;
= Type Palwasha in the Search box at the botsom of the Acces soreen and pres the ENTER

key, Access bughlighs the st recosd har marches the ssarch keyword Palwasha
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Database an organised collection of information  Field  a column ina talle that contains some

or data information about the record
Database management system 2 set of programs  Primary key  one or more fields that uniguely
that allows storage, modification, and retrieval identifies or identify every record in a table
of information from a database Datasheet View  the view that is used to enter
Record information about an entity stored in a row data in a table

= Microsoft Access is a DBMS application thal
can store and manage a large volume of data.
hs latest version is 2013,

* The database objects in Access 2013 are tables,
forms, queries, reparts, macros, and modules, filkee, 2 Borct ks,

* You can create databases using a template or o You can also sum, sort, or filler data i Access
fram scratch, 3013

The Datasheet View is primarily for entering
data in a table. You can also insert, delete,
rename, move, hide, and freeze columns;

change the data type of a column; search,

= A data type specification for a field controls
what you can enter in that field.

Objective Type Questions
1. Choose the correct option,

a. It lets you enter and display data in a customized format,
l. Table il, Form iil, Query v, Repot

b. By defaul, the first field in 2 new table is
I. Mo i 1D ili. SNo w. all of these

€. A data type that can hivee anly ang of two values, Tree or False,
. AutoNumber B Numbor i, Yes/No iv. Lurmency

d. Which of the following is an invalid fiekl name

I. Student'sMame il Student. Mame ik, Stuclomt_MNamige iv, Studeat Namwe
OXFORD
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& A primary key
i. Cannot be repeated H. Unicuecly identifios a record
iil. Can be of the AutoNumber data type iv. all af those

f, This data type allows alphanumeric characters and special symbaols more than 255.
i Shor Text if. Long Text fil. Mumber v, AuloMNumber

Descriplive Type Questions
Answer the follewing.

a. What is a DBEMS? What are its advantages?

What are the six database objects?

\What are the bwo ways of creating a database!

What are the rules for naming a field!?

List the varigus data types available in Access 2013,

What is the difference between hiding and freezing a field!?

List the steps to show the Total row in an Access 2013 table.

Ali's teacher wanits 1o Grganise all the personal data fnami, age, e4c) and academic data
textracurricular interests, achievernents, etc.) of the students in his class. Al suggests he uses a

DBMS (Database Management System) for this purpose. Analyse the advantages and disadvantages
of wsing a DEMS for this task.

i. You have been asked to create a database for the school's cricket team wsing Access 201 3. You
realise that you can either use a template or develop it yourseli. Compare both ways of creating the
database and state your preference.

j. Your task is 1o create a database to track the progress of 5 different teams that all played in a recent
Football World Cup. Create a database using M5 Access for any five teams of your choice. You must
include the following fields in your table:

IO

ik

» matches played * winning team * |osing team
= poals for o poals againgt
Application-Based Questions
a. Consider the table alongside: [MemNo | Name | Quantity = PurchaseDate |
i. Can ﬂ:ﬂn; be taken as a primary key? If | 5, Sharpener | 100 13-03-2014
no, why not T
ii. What is the data type of the field, 102 sl 120 13452014
Iembin? IRLE Pan | 120 18-04-2014
b. Caonsider the table an the right: 164 | Pencil 200 21-05-2014
i What could be the primary key field in -~ | 105 | Clips 00 21-05-2014
this tahle? o
g E.I o ag o L L P e
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— T
i, Sugeest suitable data Wpes  [Q oy, g :
fiar the fields of this table. e u[::-m " Managee a/1a/2008 o]
W ool Clers a2/ s 2o [
A large database file of customers. { ‘HH’;"""“"""""T "
is maintained by Ayro Bank Lid, . _

Suppest 4 suitable method of

searching for the record of a particular account number.

The oypdivns in the Number Fillers menu are listed below.

Equal  Does Not Equal  Less Than  Greater Than  Between
VWhich aption will you select to do the following?

Tor display all records with salaries in the range of 50000 to GOOOD.
i, Tov display all records with a salary below 50000,

iii. To display all recoeds with a salary above 50000,

i To display all records with a salary other than SO00.

v. To display all records with a salary that is exactly 50000,

Jitiran has ereated a table for recarding the details of all the salesmen in his team. He has applied

ng on the SalesmanMame field and the TotalSalesAmaount field, .
Which sorting has he applied to the SalesmanName field if the up-arrow appears in the caluma

header?
Which sorting has he applied to the TotalSalesamount field if the down-arrow appears in the

column header?

st
i

‘ IN THE LAB

1. The class teacher of VIII has asked Hassan, the monitor, to create a table having details of 10

H

students of the class, Hassan has created a table with the following fields:
AdmissionNo, Name, FName, LName, TeleNo, DOB, BusAvailed (Y/N), BusNo.
Can you help Hassan assign data types to the fields, and enter 10 records to complete this task?

The spons academy of Grand Logic institute maintains the details of all those studemts who have

poined the academy on pari-time or full-time basis, The fields in the table are
ID, Name, Gamejoined, Calegory (Part-time/Full-time), AmountPaidMonthly.
Can you create a table structure based

e I I T

on these fields and enter 10 records? . . f‘ T T R -] Gy
. Aleading car showroom in the city ; ﬁ ﬁ :ﬁx
maintains the details of all the cars in the 3 Jaaz orcia Ha £ 5, 000.00
showroom in an Access able, | o= e e
The fields in the table are: 1D, Model, | 8 C-Claw PR Fa.13,35,000.00
Manufacturer, Price, and Quantity. s hawy g
Dayan, an employee of this showroom, | ; L :; :ﬁ:ﬁ:
50 G-claw Mercades i 11,5400, 00
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Working topethes, find oul mone abowt the four different types of databases: hierarchicai, natare

reitieanal, and chaject=anented.

o Mo e they apersed

o Are there similaritios between them?

o VWt are the differences between theme!

o Which style appears o be the casiest o use! Why!

Ty illusteide your findings you are going (o create a growep presentation. Yoo will need 1o 20e examoles
frarm azach of the different types 1o demonstrabis your analysis.

25 TEACHER'S NOTES
e [hscuss thee advaniages of databases with the shudents. Use real-life examples.
o Fapalain thie imygestance of having 4 primary key in a tahle
o Euplaln the differences between Bl and Acciss,

o This concepls of applying o valbkatbsn rle and speciiying validation est in Datasheet View mav be
taken up inforally in chass, as thie stucents voubd neguine knowledges of thise concopis roe the solution

il 2.4 o b thee Laly,
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chap tE;-

access 2013:
Design View, Queries
forms and Reports

= tahle in M5 Access can be crezted in two ways — using
the Datasheet View or the Design View. In the previous
chapter, we have leamt sbout the Datasheet View and how
to work with tzhles in this view. Let us now learn how to

. « Create Table in Design ¥

- " ' ) o L) rt . - - . t A=
create & table in the Design View. The Design View gives us .0 3
more control in setting the properties for tables, forms, etc. prcanicy

Although, vou can create a tzble in the Design View, data - Reparts
can be added onlv in the Datasheet View. \We will learn

maore about the Design View in this chapter.

In 2 database with thousands of records, finding information is difficult. Access provides 1e1-
like forms, queries, and reports to make this job easier.

Forms can provide an easv-1o-use method for entering and editing data for those who are 10
tramiliar with Access,

Queries allow you to select data irom a table or tables as per vour requirement. They allow
to change and re-arrange data, and then use it as a source for forms and reports.

OXFORD a4
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Reports give us data in a printer-friendly format, We will discuss these features of Access as we

proceed further in this chapter.

CREATE TABLE IN DESIGN VIEW
Open Database] that was created in the previous chapter,
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Fig. 2.1 Databased

To add more tables to the above database, click the CREATE tab. In the Tables group, there are

twio ways 1o create a table:

Click the Table button to open a table in Datasheet View,
In the previous chapter, we had leamt how to create a table
in Datasheet View.

Or
Click the Table Design bution (Fig. 2.2) 1o open the Design
View.
This option is the one we will focus on here, The Table
Design screen consists of two parts (Fig. 2.3):

B EE

fApghcation Table
Pty

Temgiaie

Table ShaeePoint

Tahles

Fig. 2.2 Tables group on he
CREATE taly

(a) Field Definition Grid 1t allows us to specify field names and data types for the table.

We can also give an optional description for each field,

(b} Field Properties Pane 1t allows us 1o enter more detalls for each field, like field size, etc.

The top half of the Table design page consists of the following:

1. Field Selector: Click an any field selector to select a field. You can then insert a row above
the selected field, delete a row, or drag a row up or down to reposition the field in the table.
The field selector box also identifies the primary key field af the table by displaying the
Primary Key icon (a small picture of a key with a right-pointing arrow).
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Design View

3. Field Name: Here you list the field names for the table you want to create.
1. Data Type; Here you specify the type of data that the field can contain. When you add a

news ficld in Design View, it is by default
assignead the: Short Text data type. You
can change a field’s type by clicking on
thes arrewe et to the entries in the Data
Type column, Selict a niw data type fresrn
thies Tist that appears.

4. Description: It contains an optional
deserigtion of the field,

Let us now create a tabli having the
ficdeds — EmplD), EmpMame, EmpSal, antl
Erngel dizpatiar,

1. In the Field Definition Grid, under Field
Name, type Emplld as the fiest field name.
In thi: Data Type coll next 1o it, sesbesct am
apprepriate data type from the diop-down
list that appeers on clicking the drop-
tlewery mcenw arreaw (g, 2.4,
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f. Toadd damain atable vou must switch from Desien View
> Datasheet View. Click the View drop-down menu arrow

[n &2 Views group on the DESIGN tab Pz 2.3 Select Fig. 28 St
- [ WL,
Datasheet View. Datasheet View

Sstiing the Frimary Key

The Primary Key field contain: unique data far each record, Bvery table needs a priman kev to
iSentfy reconds uniquely, Access sorts table data by the primary kev field. Access does not add
a7 1D fie'd automaticallv to new tables in the Design View.

Thare are two wavs of seiting the primany kev in an Access Top Tip —— Tael
2013 =hie. The first mathod 15 as follows: —

Taselect 3 with
1. Select the field to be ot a5 primany key, mutriple figlds, mﬁ:}m
CTRL by and diick the Field
Selector for exch Rafd,
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2. Click Primary Key in the Tools group on the DESIGN lab,

Alternatively, i ;_.E?EI'.E'!' !"_"-1
1. Right-click the field selector of the column thal will be the -iEFI Copy ‘

primany key. 1 ;T :.;:”,_, !
2, Select Primary Key from the context menu iFig. 2,90 - LA |
After vou sel the primary key, a key icon will appear in the grey :!E Brepertes |

Fig. 2.9 Primary key apiig.
in the conlext meny

selector area to the left of the field's name.

&I W (g ol
Top Tip = Top Tip T
When you save a table without Access does not allow you to d:-r_m a
ereating a primary key, you allow Access prirmary key field once set. However, if you sull
to automatically create a primary key fiekd wish to delexe it, firit remove the primary key
named |D of AutoMumber data type. icon, and then delete the field.

Removing the Primary Key

To remove the primary key, click Primary Key in the Tools group or in the context menu. The
small key in the row selector will disappear. The Primary Key button works as a toggle to turn
key fields ON or OFF.

To add a Lookup Field

A Lookup Field is a field with a list of values from which a user can choose the desired value,
Rather than typing individual values, the values appear in a drop-down list. Let us add a new
field called 'Grade’ in the Employees table, whose data type will be set to Lookup field.

1. If you are adding the field in the Datasheet View, first click the field header and select
Lookup & Relationship from the drop-down

: Lostap

list that appears. & Thes kool v ahes  boobatt Rebd, whuch gl # e 01150

In the Add & Delete group on the FIELDS |; - ATy R e

tab, click More Fields button, A drop-down (= B oot i i e i R

menu appears. In the Basic Types section, by GRS e

s - R aked Cu L D manl

click Lookup & Relationship. s

In the Design View, click the drop-down

menu arrow in the Data Type cell next (o

the new-field ‘Grade’, and select Lookup

Wizard... in the menu that opens, — =

e s

Any of these actions will open the Lookup Fie. 2.10 Lookup Wi

Wizard screen 1 of 3 (Fig. 2,100 e Up Wizard screen 1 of 3
et 2 !



Click 1 will type in the values that | want and then click Next,

The Lookup Wizard screen 2 of 3 appears. Leave the Number of columns set o 1 and click

iy the first cell in the Coll columm. Enter the data and press Tab inot Enter) alter each one to
mone Io the nest row, Click Next b, 2010,

Click Fimish,
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The Lookup Wizaed scroen 3 of 3 appears (Fig 2,120 You can assign a name 1o the new fickd.
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Fig. 2.11 Lookup Wizard screen 2 of 3

Fig. 2,12 Lookup Wizard screen 3 of 3

The column ‘Grade’ appears next to the EmpSalary field in the Dalasheet View. To enter

data, just click in the first cell, a drop-down menu arrow appears, On clicking the arrow,
vou will get the list of values you had entered earlier, Click the value you want in the

field (Fig. 2.131,
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eld Properties Pang

Fig. .13 Lookup field in Employees table

_--

In the Design View, the Field Properties pane appears in the lower half of the screen. You can
use it to control data entered in a field and the appearance of data on screen. It allows you o
specify certain field characteristics and properties, for example, size, format, validation rules, eic.

Field Size This is the maximum size for data stored in the Text or Number fields,

For Text data, the field size determines the maximum number of characters, The Shorl Text
data type has a maximum of 255 characters.

For Mumber data, field size determines the range and how many bytes can be used for storage.
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* Format This specifies how data will be displayed.
MNumber and Currency Formals  You can choose {rom seven ]III'E-E_IE{iI'_tEId lormals, i.e,
General Number, Currency, Euro, Fixed, Standard, Percent, and Scientific. You can also
create custom formals,

Date and Time Formats  You can select from the pre-defined formats: {Iieneml Date, Long
Date, Medium Date, Short Date, Long Time, Medium Time, and Short Time.

Logical Formals The default display is Yes/No. Other pre-defined formats for logical dag
are True/False and On/Off. B

» Input Mask This facilitates data entry and  Top Tip s
controls what the user enters in the field. Yo nsert & row i Design view, seiect the el

For example, the input mask for a phone selector above which you want o insert a row and

Vi ey click Insert Rows, To delete a row, select the field
number could be (......] selector you want 1o delete and click Delete Rows.

» Caption This is an alternative name for

the field to make the field name more T r—r——.
explanatory. It can contain up to 2048 - HOME  CREATE  ENTERNALDATA
characters. T f ‘\ @- I;:::

* Default Value This value is automatically Vg h::'-' Buidder TuﬂLﬂ:ﬁﬂ é%lm
filled in the field when you add a new Views Tosn

record to the table.
* Validation Rule A validation rule limits the value that the field will accept.

For example, if the validation rule for a field is <= 100, it means that the field must contain
a value less than or equal to 100. If you enter a value greater than 100, you will get an emo
message.

= Validation Text This is the error message that appears when the value entered in a field
violates the validation rule.
= = -;.--:'h.':l
[ Top Tip e

'_J
| You can also enter a validation rule in the Datasheet View by clicking the Validation
button in the Field Validation group on the FIELDS rab under TABLE TOOLS.

* Required Enter Yes if the field should always receive a value during data entry. The default
value of it is No, which means that the field can be left blank,

* Allow Zero Length  This property is used for Text and Memo data types. If Required is Yes
and Allow Zero Length is No, data must be entered in the field during data entry, If both
properties are set o Yes, the field can be left empty.
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PRACTICE TIME ”@,

A Pabihd Sl ivsastains el avacderme olesass ol i stoelenes i an Aceess, rakile | etk 10

thae tabilis are pram Bedin,

[FieldName . DataType Properties
S1ulld Sheirl Test Primary Koy, Field Size - 4
Test] Numbser Reruired - Yis

Validation Rube - =1 amd == 100
: . Validation Text - Enler marks n the e 1 4o 108
Tusst2 Mumber Required - Yis
Validation Rube - >=1 jml == 110
i | Validkation Text - Enter marks in the ange 110 100
Averapge | Calculated | Expression — {[Test 1] + [Tesi2|i2
b L F-F_!-_dl'lrpu—ﬁ-ingh.-
Cirade Lookup Ficld | prades - A1, A2, B1, 82, C1, C2, F

Type YesMo There ate two typees = Classroom program, distance program.
| The check box is schected for Classroom program,
Default Value - Yes

1. Creare the above able 2nd save ip a5 AcademacDecails,
2. Swich o rthe Datasheet View and enter 10 records,

SOLUTION

1. Create a new darabase, The new database wil open with ane table, Tablel, in Datasheet
View. Mow click the View drop-down menu armow and select Design View, Save the rable a
AcademicDerails

2. Mowin the Design View, for all the fields, type the Field Name. wlect the Data Type. and enter
the Description

3 Toser StwlD 35 the prmary key, chick is Field Selecter, and in the Tools group on the Design
taby, chck Primary Key Then, click in the Fleld Size et box o the Field Properties pane, and
change the see from 255 o4

4 Selecr the Fleld Selector of Test and do the following:
& Select Yes a the value of Required Mow, the lietd cannoe be kel blank when you enter data.
b Click the Validation Rube text box and type >=1 and <= 100

a1 OXFORD
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¢ Chck the Validation Text text box and type Enter marks in the range 1 ta 100

Select the Field Selector of Test2 and lofiow the same procedure as for fietd, Test

Select the Field Selector of Average and do the lnllovang

a Inthe Expression text bos, type ([Test1] + [Test2])/2

o In the Result Type, select Single Mow you will get the output in decimal numbers.

For the field, Grade, select the data type as Lookup Wizard... and do the followsng

3 Inthe fiest sereen, chck "1 will type in the values that | want” and click Next.

b. In the secand screen, chek in the blank row below Col), type the grades and then press TAR
o the down arrow key, After entering all the vatues, click Mext.

8 Inthe therd screen. chick on Finish, Mow, select the Field Selector of Type. Set the Default
Value a: Yes

o W

=

9 Tosave the table, click the FILE tab and select Save. The Save As dialog box appears. Type the
file name as AcademicDerads and chck OK.

10 Chek E! 10 close the table

11, Nonw, click the View burton in the | yerm—

Views group on the DESIGN tab. Select I:.-:.“ #] el _;-' T ;”"“l";lﬂm -1 FE .

Datasheet View. This opens the rable jﬂ'ﬂ a7 " ssa o
xm [ " 57 e ¥

in the Datasheet View allowing vou tal " » 50 A3 %
s n- -.u W7 43 =

to enter records. Enter 10 records. Frve

records are shown m the figure alongside

Monce that you can enter marks in the Test? and Test2 fields only in the range of 1 to 100, If you

try to enter any value bepond this, the message you have specified earlier will appear. The Average is

caiculated automatically. The Grade field is a loakup field, 50 values are entered by choosing from a
drop-down kst The Default value of Type is Yes, ie, the check box is checked

DUERIES

An Access query is a method of getting answers to questions about data. The query can invalve

a single table or multiple tables to answer a question about data. Here, we will be working with
a simple query based on a single table. Some examplos are:

* The list of students who got grade A1 in all five subjects,

* The list of employees who get salaries above Rs. 50000 a month,

Access saves each query as a new query in the database. A saved query can be run again at any

time in the fulure.
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The CREATE tab has the commands for creating queries (i 2 140,

B B % - 5 Doisbwed | Ditshme CALRRASORT, Dasumen.. PARLE VIR ECE
HOME  CRIATE = ENTHRMAL DATA  DATARATETONNY  [HERS  TAB S A
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l‘l'ﬂ"i-ﬁ!" Table Tible Sharefod  Quewy Query Form Farm  Bark Repos Repon Blark  Wwesw
Do labi-  Wased Dign Brign Farm L2 Masr Fore - Lrmys Prymn rd
Tlﬂ'l-ﬂ-ﬂ- Tuksay Caarior [ _::.nrh Mg flode & |
Fig. 2.94 CREATE 1ah ogtinons
There are two methods of creating a query: through [3 e
Query Design and through the Query Wizard, We —_— ,‘"‘:'"f" i e
will use the table Empinformation i, 215, 0003 ek et s m
E B T P | L m
o B ] drnan Llyawe] A m
Uﬁlﬂ'ﬂ HUEI'L[ UJIIEI'H .|-u LET o 1Y HErE 11}
i oo bpa Wl fovme i
If yous want to creale a query using the Query loasr.  Akga Bt il »
H ' ] i
Wizard, follow the steps given below: :m bidioa e o "
1, Click Query Wizard in the Queries group on the -2 _===is s 8
CREATE tab (Fip. 2.14). Fig, 2,05 Dimipelrlormiibioss Rildi

2. The New Query dialog box appears (g 2 16 Select Simple Query Wizard and click on

i = ”m_ - 1 et b s e s
-  Creamish Gy emd
| Fied Daplesiars Qe y W Vi i s B ey oy W S R
f-mﬁ..'f'l'_d
I Tulmr Py i b e . | rlrl‘dljllf !r|l I
# adabis Frais Fr— o
Aot .
S — Cr— e —
[y s ——— | | LLa :
LY Vid K o | fid
H ::'I e Fald
oy Lo ] B o _| TR |
Fig. 2.16 New Query dialog box Fig. 2.17 Simple Query Wizard screen | of 1

3. Simple Query Wizard screen 1 of 3 appears (Fig. 2.17). In the Tables/Queries box, select the
table that contains your data and then add the fields that you want to see in the query resulls.

Make use of the arrows as shown in Figure 2.17 to add or remaove fields.
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o Toadd a field, select it in the Available Fields  “7opTip 1:. :

list and then click [E‘! or just dovble-click it You can move alf the felds in Available
+ Remove fields by selecting them in the Fields to Sebected Fields at once by chcking
. Ciala = and move all fields from Selected Frelds 15
Selected Fields list and clicking IZI Available Figlds by clicking ==

Click on Nexl after selecting the fields.

4. Simple Query Wizard screen 2 of 3 appears

Fin. 216, Select Detail or Summary and click on Next.

Simple Query Wizard screen 3 of 3 appears (Fig. 2.1%. Type E query name in the text box,
select Open the query 1o view information, and click on Finish.

(¥ ]

It T 0 v ] P P Qe T

: -.Hmhltﬂ'll'i_:l.!-'l" s
_:—E_I____ & E_il:pﬂ-qlﬂﬁll'nrr-ﬂrﬂ :
i |
- —
- —— Tegtn d P RS AT T ey e T O
{'= :"-! LT
I e o et b et Ty o ooty B ey w e
| = :l o G PRy B v e
1 :h:‘ﬂ | =, iy o ey e
el _:-. |
l Fin— . I
. Lr- i b
o |} rl—FI_g?trt- gen || - )| l . E:Il
il

Fig. 2.18 Simple Query Wizard screen 2 of 3 Fig. 2.19 Simple Query Wizard screen 3 af 3

6. The guery result will appear in Datasheet View

= > m (Fig. 2.201,
10

Eom2 20 Using Query Design
- g‘:: i Follow these steps to create a query in Query Design:
B 0 1. Click Query Design in the Queries group on the
_jeos - CREATE tab.
i Fo - ;
| eoos E% 2. The Show Table dialog box appears where you will
| E00s 1 choose tables iFig, 2.211,

= - lick the table you will use and then click on Add, or

Fig. 2.20 uutput of Click the table you will u :

just double-click the table.

Emplniormation Query
You can repeat this step to add several related tables.

3. Click on Close when you finish adding the tables,
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Shene Tube ) WG 4. The Query Design screen appears (Fig. 2,220
Ty | | mos | Here you will select the felds 1o be included in the

—————— oery: by-ssing ome:of the Sollowing ways;

* Double-click the field, It will be placed in the
first vacant column of the grid.

il |
. Chr
— = e
Lasl || o ]' y
J ¥ i
Fig. 2.21 Show Table dialog baox Tmpal
[
* Click Ihrf field :If!d drag it 1o the required T L
column in the grid, '
Or e | E‘I ‘
. [
* Type the field name directly in the oerd £l . O ]
required column in the grid, P
Double-click the asterisk (*) 10 include all o
the columns of the table. - e seiacEems- e
Figure 2,2 shows the grid with the Fig. 2.2 Query Design screen
selected fields.
Fieit | pmpm | Enphame Empta TR E‘ E
Table | Ewvplof prmadipe Lmpled presaias Emple pipaatize i Emplrdormalion
San
@ I @ m | B
Cofteria
“ -
om HE

Fig. .28 Fields in the Query Design Grid

5. You can arrange the fields in the order you want them in the query results. To change the
order, select the entire column and drag it to the new position (Fig. 2.24),

Field | tmpis Fagpblasms Emplal % E
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Fig. 2.24 Reamange a field in the Query Design Grid
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b. To hide one or more columns, clear the Show ll.
shows the check box cleared for the EmpName field
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Fig. 2.25 Hirle a column in the Query Design Grid

hoekbiox for those columns, Figure 2,23

= Chaase the field 1o sort by and choose Ascending or Descending from the comresponding

Sort box (Tig. 2.0
Ascending as the sorting option.

Fig. 2.26 Sort in the Query Design Grid

For emmple here we have chosen EmpDeptNo as the sort field and

8. In the Criteria of EmpSal field, type >=50000 so that only the records of employees having 3

"|'_|I

salary equal to or greater than 50000 are displayed (Fig. 2.27

|r.-=-uu | EmplestMo
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Fig. 2.27 Criterion for EmpSal specified in the Query Design Grid

Running a Query
Toruna query:

Click Run in the Resulls group on the DESIGN t1ab iFig. 2,28, The output for the query will be

displayed as shown in Figure 2,29,
To close the query, clickmin the Query Design screen,
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Fig. 220 Run option in the Results group
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Saving a Query

You can save a query in one of the following ways:

# Click the FILE tab and select Save in the menu that opens.
Or

= (Click the Save button on the Quick Access Toolbar. Fig. 2.30 Save As dialog box

When you save a query for the first time, a Save As dialog box appears. Type the Query
Mame and click on OK (Fig. 2.30),

FORMS

Forms provide an easy way to enter, edit, delete and view data in a table. There are J ways o
create a form in Access as given below:

* Lsing the Form command = Using Split Form * Using the Form Wizard

We will use the Emplnformation table created earlier in this chapter for learning how 1o
create forms.

Using the farm Command
One of the ways in which you can create a form is by using the Form command;
1. Click the table, Emplnformation, in the Navigation pane.

2. Click Form in the Forms group on the CREATE tab. This method creates a simple form that
uses all the fields in the table, It displays the form in Layoul View (Fig. 2.11)
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Fig. 2.31 Fosm design using the Form command

The DESIGN, ARRANGE, and FORMAT tabs now appear on the ribbon under FORM
LAYOUT TOOLS.
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3. Select the text box and resize it.
4. On the DESIGN tab, do the following:

a. Click on Logo in the Header/Fooler
group. The Insert Picture dialog box e
appears (Fig. 2.32). Select a picture & thse
and click OK. B
b. Click on Title in the Header/Footer e
group. Type ‘Employee Information’

as the title for the form (Fig. 2.33),

i m R
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Fig. 232 Insert Picture dialog box

G| Employee Information

Fig 233 Mew title of the form

c. Click on Date and Time in the Header/Foater group.
A Date and Time dialog box appears, select a formal

and click OK (Fig. 2.34).

d. Click the Themes button in the Themes group and

select a required theme,
5. Select the FORMAT tab and do the following;

a. Select the label and using the Font Color button in the 0 s

Font group, change the text colour to blue.

b. Click anywhere inside the blank area of the form.

. Click the Shape Fill button in the Control Formatting
group. Select a colour from the colour palette.
The colour of the form would change as shown in

Figure 2,35,
6. Chick the FILE

e ANE FOMT name and click O
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Fig. 2.34 Date and Time dialog box

tab. Select the Save option in the menu to apen the Save As dialog box




Using Split Form Y el gesiatica

You can also create a form using the Splil ——
Form oplion: .

1. Click the CREATE tab l et

2. Click the More Forms button in the Forms [ e e e

4.

(LT EFTIY e

group. Access creates the form in the o il oo ;

s T T ] » LIF“ View Form View
upper-half of the window and displays EE: —— - ;
the table in Datasheet View in the bottom |y
half (Fig. 2.37). Fig. 237 Form created wssng the Splhit Form opticon

The two views are separated by a bar that
can be used to resize the height of the two views,

Click the Form View button at the bottom-right end of the Stalus bar to enter or change data.
You can use either the upper or the lower half. Both parts of the window activate the same
field and the same record at the same time.

Click the Layout View to format the form.

Using the Form Wizard
Follow these steps to use the Form Wizard:

1
r 5

3.

ERE B W mE

Click Form Wizard in the Forms group on the CREATE tah.

Form Wizard screen 1 of 3 appears (Fig. 2.340. Select the table from the Tables/Queries drop-
down menu and select the fields you wanl in the form. Click on Next,

Form Wizard screen 2 of 3 appears (Fig. 2.349). Select a form layout. The default selection is
Columnar, which you can change if required, Click on Next,

| e bkl S e W R b g i gpas e B e B!

J

Wi o ol S S EE W T

Il
TR §

_—
—
_

——
= =
o
| -
pr—
B
—

[T

Fig. 2.38 Form Wizard screen 1 ol 3 Fig. .39 Form Wizard screen 2 of 3
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4. Form Wizard screen 3 of 3 appears T iy, 2400, Give a namda 10 the form. Select the oplican by
Open the form to view or enter information. Click Finish 1o create the form,

The formatted form will appear on the screen, You can now add maore records o your form or

view already existing records (Fig, 2410
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Fig 2.41 Formatted foem with fields

=

Fig, 2.40 Form Wizard screen 3 of 3

|

REPORTS

Reports are an effective way to present your data in printed format, You can control the size
and appearance of everything on a report, Thus, you can display the information the way you

wanl (o see it,

Microsoft Access provides many ways to create a report. Two are discussed here:

« Using the Report command
o Using the Report Wizard

Using the Report Command
To use the Report command do as follows:

1, Open the database. Select the base table or query in the Navigation pane.
2, Click an Report in the Reports group on the CREATE tab to display the report on the screen
iFige, 2420,

3, Click the Layoul View button 1o format the repart. For example, here the heading has been
changed 1o Employee Details.

4. Click the Print Preview button to see how the repart will look when printed on paper.
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Fig. 242 A repon created using the Report command

Using the Report Wizard
Follow these steps to use the Report Wizard:
1. Click Report Wizard in the Reports group on the CREATE 1ab.

2, Report Wizard screen 1 of 5 appears (Fig. 2,431, Choose the table or query, add the fields
that you want to see in the report results, and click Next,

3. Report Wizard screen 2 of 5 appears (Fig. 2.44). Select the grouping level within the repart
and click Mext, Here the grouping level is by EmpDeptNo.
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4. Report Wizard screen 3 of 5 appears (Fig. 2.45). In this screen you can set the sort order ang
the summary options. You can sort data by upto four fields,

Here it is being sorted only by one field, EmpSal. By default, sorting is in Ascending order,
Click the Ascending button to change it to Descending.

5. Clicking Next will take you to Report Wizard screen 4 of 5 {Fig. 2.461. Select the type of
Layout within the reporl.

In the Orientation section, select either Porlrait or Landscape. Click Next.
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Fig. 2.45 Report Wizard scroen 3 of 5 Fig. 2.46 Report Wizard screen 4 of 5

6. Report Wizard screen 5 of 5 opens (Fig. 2.47). Type a title for the report, which will also be
the name assigned 1o the report. Select Preview the report and click on Finish.

The report will appear on the screen (Fig. 2,48,
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Fig. 247 Report Wirard screen 5 of § Fig. 2.48 A report created using the
Report Wizard
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ning a Report

(lick the Print Preview button at the bottom-right side of the status bar. The ribbon changes
a5 showen in Fige 24
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Fig. 247 PRINT PREVIEW tab options

Select the desired options and click

Print. T!'H's will open the Print dialog —
b Fage. 2,560, -
fms Ry
['j!- Ve 18 Do bk et KX ¥
when BN
Click FILE and select the Print option Se— Cavture
in the FILE menu. The Print dialog box T : —
appears Frg. 250, B - T ol |
— ol oL iEh
Select the required options and click i 2
OK. | Coma ] (=) (o]

Fig. .50 Print dialog box

PRACTICE TIME pra":

The Computer Soence reacher has asked the studencs of Class Vil to
ereate & table named TeacherDerails with the fields gven below:

N —

| FieldName  DataType Description |
Tizac b 103 Shot Texl Teacher 10 as Primary key
Teachesr Name Shont Toxt Mame of the teachos
i oo Birth ChatesTimie Dot of Birth
Catiifeer Leakup Field  Gender as M iMaled or F (Female)
Lhegairtmse=n Lestabeupe Fieled Departments: Kinderganen, Primary, Seconclary,
Senior Secondary, Prancipal, Office
Eranes ool Jreiningt  Ddates T e o joining the school
aalary fumbss Momhly salary
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Then they have to do the fallowing

®  Enter 10 records

® Create aform for data entry and format it as per their chowe along with 3 loga

®  Create a query to display Teacher 10, Teacher Name. Department, and Date of Joining in
descending order

®  Create areport for the query createdin the previcus step. The1epor 510 be grouped by departmen,

SOLUTION

| Create 2 new database The new database will open with one table. Table, in Datasheet View,
Naw chick the View drop-dovwn menu amow and select Design View,

I Access will prompt you to save the table Enter the Table Name as Teacher Details and ciick OK,

3 Thiswill open the table in Design View. Type in the field names, select the required data types
and enter the descriptions. Select the Teacher ID field and click the Primary Key butzon in the
Tools group on the Design tab, 1o make it the pamary key fiekd

5. Click the drop-down manu arrow of the View button in the Wiews group on the DESIGN b,
and gwitch back to the Datasheer View

5 Enter %0 records. Lise the TAB key to move fram one column to the next

& Chck Form in the Forms group on the CREATE tab to create a form, The form will appear on
the scréen m Layout View.
a Click the DESIGN =b.
o Click Logo in the Header/Footer group The Insert Picture dialog box appears Select a

suirable bogo and click OK

Click Ticke in the Header|Footer group and type a new title

Click Date and Time in the Header/Footer groun. Select a suitable format and click OK
Click Themes in the Themes group and select 2 theme of your choce.

]

R &

Click Fonts in the Themes group and select a font you prefer.

Mow, select the FORMAT tab.

Click Shape Fill in the Control Fermarting group. Select a desired Calour fram the Calour
paliece thar appears

v Click Save on the Quick Access Toolbar. The Save As dialog box appears. Type
frmTeacherDetails and chck OK.

7. Now, tocreate a query, click Query Diesign in the Querfes group on the CREATE tab. The Show
Table dialog box appears Select the Teacher Derails table. Chek on Add and then chick on Close
B Duag the Teacher I, Teacher Name, Department and Date of joaning felds from the table to the
Query Design Grid
a. Select the Ascending opoon in the Sort menu of the Date of Joinang field
b, Chek Rum e the Results group on the DESIGN rab o run the query,
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. S thee query as gry Teacher Decails
4 Mo seleat the query gry Teacher Devaiks in the Navigation pane. Click on Report in the
Reports proup on thit CREATE tih The repart will appear on the screen
4 Savee the repoot as it Teacher Dealls
B W yond weh to print thie repoe, click FILE anel select Pring in the menu that Opers
¢ Selhect Print Preview m the centre pane if you want to we how the report will look an paper
iw chck Prine
d - In the Print dalos box that appears, select the required options, and click OK.

T T A LT

LOmpu
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Alter vou have finished wirking on the computer, vou should save your files and log out, shut down, and
wwilch o the monitor before leaving the room. This will help vou make a ueelul contribution to saving
tectricity, in the same manner you de by switching off fans and lights befare leaving the room.

Datashee! View  the view in which vou can enter Field Name  the name assigned to a feld that

anid miochily the data in a tahile appears as a column hﬂ:-ltllng in the First rowe of
Design View  the view in which you can modify A database table
the: struciure of 2 tablo Data Type  a property that restricts entries in 3
Row/Field Selector  the grey box ot the left end field to a specific type of data
of cach o bn the field definition area Primary Key 2 field or a combination of fields
when a 1able's structure bs displayed in that uniquely identifies a record
Dussign Vi Query  a method of getting answers 16 questions
about data
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Form  a way for viewing, entering, editing, and
deleting data in a table

Report  data presented in an easy-fo-read,
printable format

memory Bytes

* The Design View window is made up of wo
parts: the Field Definition Grid and the Field
Properties arca,

#  The Field Defimtion Grid consists of the Field
Selector, and the Field Name, Data Type, and
Description columns,

* You can select multiple fields by pressing the
CTEL key and clicking the Field Selector.

s A primary key field should have unique
values. Access displays an error message il you
atternpt to enter a value that ks already present,

* Inthe Field Properties area, you can specily

Field Size, Format, Inpul Masks, Field Caption,

Objective Type Questions

1. Choose the carrect oplion,

a. In Access, the Short Text data type may contain a maximum of

i. 255 characters i. 256 charactiers

b. Which property is sé to Yes so that data in a field ks mandatory?

i, Caption ii. Required

. ‘Which of the following is not a view for displaying a report?

i. Print Prewview i, Design View

d. Which data type could be used for the field, Remark or Comment?

i. Short Text il. Long Text

e, The validation check reguired 1o have a value within the range 1 10 500 in the RollNo fiedd would b
fi. »>=1 AND <= 500

i, ==1 OR <= 500

LT 46

Grouping Level the level by which recosds
are groupéd in a repart, When you group on
a field, the report adds a group header and
foater around each group of records that have
the sami= value in thal field. |

Defaull Value, Validation Rule, Validation
Text, Required, and Allow Zero Length,

* A Lookup field is used o restrict the data
entered in a field 1o a Hst of valees from an
existing table or a list of values that you created.

s When a field has a validation rule, Access
checks the entered data to make sure il
confarms lo the rule. If the data violates the
rule, an error message is displayed. The entry
is accepted only when valid data is entered,

= The CREATE tab has options o create Quernics,
Forms, and Repors.

iii. 65535 characters v, 1024 characlers

i, Default Valwe iv, Allow Zero Length

iii. Layout View iv. Datasheet View
ii. AutoMumber iv. Mumber

iil, =1 AND <= 500  jv. >=1 AND < 500



Descriptive Type Questions

amswer the following,

a. Deseribe the four parts of the Field Definition Grid

b What are the dhflerent wiys of setting a field as a primary kiy?

e, Why is a form prefesred over the Datasheet View for erering datal
Hiw will you switch from Datasheet View to Design View and vice versal

e What do vou understand by the AutoNumber field in Access? Can you change the data type of any
el b AutoMNumber?

t Give a validation rule such that a user can enter only the values 1, 2, or 3

g ompare the hwo methods of creating a table in MS Access (Datasheet View and Design View). Which
vne would you prefer to use 1o record the advantages and disacdvantages of using the Internet?

h. Access 2013 allowe you to define field properties such as size, farmat, input mask, and validation
rule. Analyse the impanance of each field property for a database with hundreds of entries,

. Using the information you collated for Question 3 of Chapter 1, create a form 1o enter the
intormation about the teams that played in the World Cup, You may use any of the three methods
tsee page 43 of your Keyboard 8 book if you get steck) 1o design the form. Make sure to list the
steps vou will take to create the form and give reasons for your cheices

Application-Based Questions

a. Consider the table given — — e
an right and answer the | AdmnNo  Name Class  DateofAdmission HIHE"]
iollawing: A1243 | Munechkhawar | Xl | 05-12-2013 | Pakistani

i. How many records and

Gekhs cre theve jn thie.  |ooioa | oemkit [ AL} GIFI0N | Pakistani

table? A1233 | DeenaRahim | Xl | DB-25-2013, | Pakistani
il. Which field can be a

cuitable primary key?

fii. What will be a suitable data type for each field?
iv. Which property would you s¢1 20 that the field ‘Mationality’ automatically has the value

‘Pakistani'!
b. M. Shanza Jamil locks after the transport department af Alsan Public School. He has decided o

maimiain a database of all students poing by the school bus,
I Suggest any six fiekds which you think must be present in this table.
fi. Suggest suitable data types for the fields identified by you,
il Which field can be set as the primary key!
€, The Sports Academy of Karachi wants to maintiain the details of all its members in a table named
Sports Academy. Can you work oul which property of the following fields should they set in the

Field Properties pane for the given field descriptions!
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Ficld Name  Deseriplion et il satsiiahong)l |

Member ID ) shmrrl h-r_- nr 3 charm:rft!-

Mame it shnul.l:l IJ-e nf maximum 30 chnr.mm
Mobile It should not be left blank and it should display
..15|__,_f| ey JRL, S e

5!:1][!; |-'E|II'bE'EI ]I ,|_-;|,|-| |_'|.f an-!r- I::II'II'!' m |.]'|E |Jg|: Du:j;gl |'.||'_'i|||:'-|r.l3":|" L.‘-IHI'n Tﬂ'ﬂl’l'!i-. Bﬂﬁkl'_‘l H"I“ Hﬂl"ll:l Hﬂ"

Charges It should be in the range 1500 to 3000; olherwise i dniphm message ‘Not in the range’,

Category 1 for Schoal Student ar 2 for i.'renﬂral

d.

In a student table having the fields Rollng, Name, Address, Phone, and Salary, the Salary field is the
odd ane out (It is an imporant fiekd of an employee table but irelevant in the case of a student tablel
Similarly, identify the column which should not be present in the tables—Book Details and Membe
Details—that belong to a library database used to record information on the library’s members and
the books it has.

i. Table: Book Details

ISBN  Title  Author | Publisher | Author Address | Noof Capies | Price |

i, Table: M:nﬂm I.'l:hihi
D .'*-.:me n"-'lnl'.nln 'a".llidrHS |Im:nmr.- | Qu.‘mhﬂ.'

Consider the following Query Design Grid:
What changes would you make in the Query Design Grid to perdorm the loHowing tasks:

i, To display only ltem 1D, _ | :
Quantity, and Price, e [ [hapiee Sheiaty i:'" i | E
ii. To display only those Fopm 5 | i |
records with Price less i ' " @
than 100, =
i, To display only those am B . T |

records having Quantity greater than 5.
iv. Todigplay records in descending order of Price,

% IN THE LAB

1

. Amya Hospital maintains the details of all its patients in a table named Patient Details that consists

of the following fields:
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Field Mame Data Type  Caption Field Size  Properties

1 Suandamnlwr  Paioeni 113

i Narme Shist Tew) First N I

L st e Shiwt Timd Laist 8w 15

Fame Mumbior Maalsile 1o Irnpaiat sk | I

EmergenoyName  Shorl Tox Emwerpency Name 15

EmergencyPhone - Numboer Ernergendy Phome Topouat Mk 1 _ b

Rubw has recently joined the hospital and has been asked by Ter manageer o de the followvingg Lisks:
1. Create a form, and format it as per bee choace.
b Enter reconds of any 10 patients in the hospital,

Can vou help Ruby in this task?

krimpson hotel maintains the (o0 | : |
details of all the rooms inthe Field Ni-mt MT’#. w Data L be |

hevtel in 3 1able named Room RoomMNumber  Mumbor Bnom Mumilier
Dietails that consists of the fields | pogmType Lookup Ficld  Room Type | Ganeral, Suil,

shown in the table alongside. Haveli
:;LTJ;':;E“‘“::LE Ei’::: BedType ; Lookup Field  Bed Type - Singhe, Dol
manager to do the following | Rate | Number
tagks: RoomStatus | Lookup Field = Room Status Available, Mot
a. Create a dorm and save it as Availabie
irmRoomDetails. Enter 10
recards of existing customers, Field Name  Data Type Properties )

k. Create 4 query 1o display all

2 Emplovee 1D Short Text Primmary Koy
the roams with ‘Available’ as i hmary Key

the status and save the result as Emgs Mame | Short Test
gryAvailalxeStatus Date Hired Date / Time
Help Rahman with this task. Salary Mumder | 1t should be by the FaIgs
. Alsan Py, Lid, maintains the details of SOLCH b UCKMD; esthaernise
temparary employees of the compary A MRS A,
in a able named TempEmpDetails that ey iime Yos § Mo Dihaull Valie — Yios
cunsits af the fields shown in the tabde

Comuments  Long Test
tny ther righil,

Hassan, an L?mplrj}'lll_' of Alsan, his
ity |H-"aiHI1!.'IJ. i |;|,,_||-[ui|| thie {r:llm'.'in!.:. Lasks:
4. Frter 10 mecards in Datasheet View.

b, Creals a Hepo in s ereking veder of sablary and save it as gpeAscendingSalary.

Can you belp Hassan with this task?
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4. The class teacher of VIl has asked | Field Name ) MT!’F' ~ Properties _i
Gazni to create a table, Sdent RollNo Number i B
U:II;IHE. uﬂ'n .[h; sichds as listed in the Svi Mame “hort Text
table on the right. - e

) , kup Field It can be A, B,
He nosy has o do the tollowing: Grade Lookip D. or E L

a. Enter 10 records in Datasheel View, sy
b. Create a query o display records o1 students only with .-*. E,rarde and save it as cp‘g,.ﬂr.'.tde
c. Create a query to display records in ascending order of Stu Name and save it as qryAscending
M,
d. Create a report grouped by the Grade field and save it as rpt Grade.
Help Gazni with the steps to carry out the tasks assigned.

5. The Science teacher has asked Mariam to create a table ScienceMarks, consisting of the fields
mentioned in the table alongside, and then do the following tasks:
a. Enter 10 records in Datasheel View,

b. Create and print a repart 1o Eicld HI]'IH Data Type = hﬂpﬂ'ﬁ!l
digplay Total in descending ————— | -
arder and save it as RaollNo | Numnber P"m”:' 1 A
spiDescendingTotal, Sty Name | Short Text '
Mariam is not sure of the steps ;uignmr;-ﬂt Marks | Number | Marks out uf 50
to complete this task. Can you i, ey loalotad " lewlates 200 of the
bl her secriember Shemd Assignment 20% Calcula calculales o
| assignment marks B
GROUP PROJECT Test Marks Mumber Murl::. it nf tEIIJ
Spaorting data is great for creating | Test 80% | Calculated Jl mltl.ll-'llﬁ ﬂU""’n ﬂ“hﬁ“
and using databases. Have you - lEil markﬁ -
considered why this is the case! | Total | Calculated | Sum |:|F Asmgnmenﬂﬂ‘}?-
Carry out some research about the | and TesiB04S.

last cricket world cup (men’s or - : E—
women's) and find out the final results of all the teams.

Working as a proup, create your own database using this infformation. Determine the fields required o
enter the data, such as how to enter and access the data and how to generate reports,

Have vou completed the task in a different way 1o other groups in your class? Share your ideas and
compare your findings. Learn from one anather and make any changes to your own database,

5% TEACHER'S NOTES
Explain the uses of a primary key in a labbe by taking real-life examples.,

#  Demanstratic hisy W set the properties in the Reld Properties pane, and the results obtained by selecting
ehiffiorent oplions.

« Spend some time discussing the working of the validation rule and validation 1ext, and their impartance.
Discuss with thi: sudents the usefulness of the Query, Form, and Repor features in Access.

o fe »
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Lists and Images
in HTML 5

Moy, Togek Lndem
r T}
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tor e in HTAAL This s a Goggle Sew, pou huve learmr the
bulleted kot and an amageinie [/ ¢ Dasks of HTML an clrs 11&'//'

e el wou 3 heie moee
about it todey. "

-

In Class 7, you have learnt how to create an HTML document

L s B . T____-——_'.._.__.-—-----"-—-"".1I
m a teod editor such as Notepad and view it in 2 wely browser.

You had also leamt about some basic HTML tags and
aitributes using Cascading Style Sheets.,

* Creating Livi

In this chaper, you will learn how 1o create different types of = Hesting Lt
i A s Ingerting lmiages
lists and how to insert images in an HTML document, 2 -

Let us first recall the properties of the HTML elements as discussed in class 7 (Tahle 3,11,

Talde 3.1 HIML Properies

| Text Properties Descriplion Values Examples
Coltur Specifies the coloar name, hexadecimal colour  Color: red
i fureprownd colowr | value, RGE colour values Codor: 2243535
: if thi: texd Color: rgb (45,65, 150}
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AR Sets il i mangzin

I margin-liettom; mangin-lefl;

erarpin: Vs Spx Spo '.

si;-i'll..-i

propedics inone. | margin-right; margin-top g
ﬂl:'-l.|.:lh'lll:|h I
matgin-bottom  Sets the fixed Length ' maﬂ.;m bottom: lem
- bottom margin o | Default value is Opx
- an element in px,
P, S0, €16+
margin-left Sets the left margin | Lengih margindleft; 2em
of an element in Deefault value is Opx
P, i, om, efc.
margin-right | Sets the right-margin | length margin-right: 10px
of an element in px, | Diefault value is Opx
pt, £m, etc, i
margin-tap | Sets the top margin | length margin-top: 3cm
| of an element in Default value is Opx .
P, pt. om, efc. '
scription Values.  Examples
RN J
border i Sets all the border | border-widsh, border-style, border- | border: solid 3px green
properties inane | colowr
 declaration _
barder-width | Specifies the width thin, medium (default border-widih: thick
' ' of the border  thick, length (you can define the | bosder-width: 5px
_ thickness of the bordet |
- horder-style Specifies the style | none (no border), dotted, dashed, | border-style: |:I.uhn:I
| ! of thee barder solid, doubsle, groove, Adge, inset, | border-style: inset .
g -, I—
border-Colour 5|:H3|:1||E!- the colour | colour name, or cobour value ' border-colon maroon
| of the harder |
background- | Speciiies the | colour namecolous value! hackground-colar;
Colous background Colour I| transpannl pedlenw
5d s mE_ B B i
[ O EEEE © & a
ie_uSE_SEEE @mEs 8O



backgeound- | Spoecifies the URL of the imag hackgreund-image;
urli'sky.jpg’!
background- | Specifies the initial | Ledt teplelt contre/left bottomright hackground-position:
position position of the lep/rigght centrefright bottomicentre cenlre
| background image | topfcentre cenlreicentre hodlom
| x-pasitian, y-position
| X%, Y% .

[Tt e vy P packground
I attachment: fixed

e - hackground image

' attachment the background fixed
' image is fixed or
scrolls when the
user scrofls the rest
L of the page
| background- | Specifies whether | repeal background-repeat:
repeat the background repeal-x repeat-x
image is repealed | repeal-y
O Mok no-repeat
CAEATING LISTS

HTML supports several types of list elements that we can include within the <body> tag of the
document. These elements may be nested, i.e., one set of elements can be embedded within

another.

list ltem Tag
Wi use the list item tag <11> to define each item of a list. Once we define the list items with the

<11 tag, the list appears in the web browsers in bulleted form (by default).

Let us type the HTML code given in Figure 3.1 1o see how the <113 tag works. See the output of

the code in Figure 3.2,
The different types of lists that we can creale in an HTML document are:

o Unordered lists
T @
e Ordered lists Uié gou Kaoer?
f An unordered Bt wses bullers
» Description lists {symbols) as the list-itern marker. An

ardered list uses numbers or leccers of
the alphabet 21 the list-iem markers.

1
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P U feenst Vew Wy ] Ot Ut RS WO B 5 B )
1 u L e

- El'.ln.l'-.th LY "|
<head> 3 List-ci ” _li.uu-_r...._-.lr.““
|

<head> *  First List [sem
<oy [ *  Secomd Lint Bem
<l~Fust List Ttem< g "

| <i=%eoond List Itemoii=

Sl |

Fig. 3.1 Creating a ligt Fig. 3.2 An unordered (or bulleed) list

Working with List Propertiog

Using li_llE' list properties, you can specify the style and position of the list-iterm marker. Various list
properties that are common to both ordered and unordared fiste are given in Table 3.2;

Table 3.2 List propesties

Description | Value(s) . Eamples |

This is uted to set all fist list-stybe-position; list. list-style: square |

properties in one declaration | style-image; list-style-type  inside |

list-style-position | Specifies the position of the | inside list-style-position: |
| fist-itemn marker outside inside |

Note: Anather property called the List-style-typs propery is used 1o specify the type of
list-item marker and has different values for ordered and unordered lists, We will discuss this
property under <ul> and <ol> tags.

Unordared List Tag

An unordered list is used for items in which the ordering of items is not impartant, An
unordered list is also called a bulleted list,

The list is defined using the <ul> and </wl> tags. Each item in the list is defined using the
<iix tag,

The bullet style can be added to the list items by using the list-style-lype property as given in
Takle 1.3,

Here, a circle specifies a hollow bullet; a disc specifies a solid round bullet; and a square
specifies a square bullet,

The list properties for an unardered list are given in Table 3.1
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Tabbe 8.8 List propertios foe an unerdored list

el T e

listesty Iewimnage  Specities the image that will be | none (delaultl, o path of 1 liststylesimiage: g
used as the list-item marker thes image 10 he used] s ("abc. gif')

the list-item marker |

list-sty le-tvpe Specifies the bullet stvbe that will | none, dise (default), circle, | liststyle-type

be used as the list-item marker | or seuare | stare

The HTAL cade given in Figure 3.3 will explain how to create an unordered list. Figueree b4

shows the output.

= irode] - Mosepad iz |
Fis ES1 Fe—at Wiew Mol
|"!DID'CTTF'EIJ-MP'

| =himl=

<head>

=nfe~Creating Unordered List<tigle>

| wgivle pe=Tiexticest>

| ul [Est-sryle-type: square}

</stvie>

/head

| <hody )

| <h2>List of Subjects in Science</hl>
| =l

<E>Physics<H>

<E>Chemsmy-i>

<E>Binlogy<B> A
<l

<body>

< hml=

Fig. 3.3 Creating an unordered list

Setting an Image as List-ltem Marker

You can use an image to mark the list items in
an unordered list. The address of the image is
specified using the list-style-image property.
Consider the following HTML code in Figure 5.5

to learn how to set an image as a list item
marker. The output is shown in Figure 1.6.

List of Subjects In Science |

= Phymica
& Chienizatry |
* Biology

Fig. 1.4 Unordered list with souare bullis

7] wodel - Motepad ai | 00

pE e om e e o e Em RE e Cm ome=

head> -
<title>Creating Unordered List</tstle>
<style type="lexticis">

ul {list-style-image: url("smiley.gil’))
<fytylex

</head>

<body=

<hX=List of Subjects in Science</Mh2>
“gl>

=E>Physics</li>

<B>Chemistry</li>

<b>Biology-<T>

<ful>

</body>

<yt~ -

—

Fig. 3.5 Setfing an image a5 2
list-iterm marker

...



Ordered List Tag
An ordered list defines & list of items

in which the order of

The e Ve feman Ten Vol items matters, An ordered st is alsa called a numberad list,
List of Subjects i Science The list items are enclosed within <o1> and </a1> lags,
o Ordering of the list items s given by a numbering scheme,
o e using Arabic numbers, letters, or Roman numerals.
% biclogy The list property used for an ordered list is given in the
marker
Table 3.4 List property for an ondered list
list-style-type Specifies the type decimal {default), lower-roman, | list-style-type:
| of list-item marker | upper-roman, lower-alpha, or | lower-alpha

|t

The HTML code given in Figure 3.7 will explain how to create an ordered list. Figure 3.8 shows

the output in the web browser,

a7

T} il - Skl ] e e ’ﬂ-l-ﬁ
T Il-.i'ﬁ :.r_?!'-_"'""l"!'"‘_“-l'-"t. [
OOCTYRE hims> - |_l| I e Festn Tash bidw
<himl=
rwqil I List of argan systems kn the hunan baody
<iyh i A Dipntice $ynsm
Esi-myle-fpen: B. Esmpirakety Syviins
o oy €. Cunaluinay Systmm
mﬂhmh D Hefvewh Byuleii
<ha>List of organ sysherms in fhe bumes body<hi> . H-“-E
e B 1 Rapradariig Lymum
<BrDigextive System</A> 1, Erdscrna Spumm
s Beapesiary & ystem= i .
coreuatoey 3 ystear</i> Fig. 2.8 Ordlerad list
:Hmm- Sysiem</E>
Excrewy 8 ipsperresli=
et S e NESTING LISTS
P """‘"'*m el Apart from creating ordered and unordered
MTW £ lists, HTML also allows nesting of lists,
q:'dp You can nest any list inside any other list.
= For example, an ordered list can be nested
S— = within an unordered list, or an ordered list

can be nested within another ardered list.



—

Rkl Ryt S 3 o) The HTML code in Figure 3.4 on the ok
L lema e e i ;
“DOCTYIT hereds s shows how nesting of lists works,
lm—
o Rl » i a .
SR o Vs Thar autput of this code is shown in
T =
Lok fhuanien e spperacnm Fryoure 3,70,
e L L)
| = e
! I_HI.
Y tiiistirn of S il gyl
| g " Classification of Sources of E""ﬂ' o ——
b e B oSl "
| e ! 1 O o R £f ceourimey
| e e S b Solm ‘Wl Ty, B v Natgrul Rvarove. fole evmyr, wowsd ma g o
| mhmah byt Senatericdle Ty sl e foiie o b hﬁmum—u.ﬁhdh
| el | T O Rt o plvynacal s -
Iq.'ﬂ'\- | i Eﬂmu
o ¢ bnemi =f " Kmmmr
agls i b | 4 TR Lompal! Prtaelewm i
| et Sl She Forwood, Charcralef=
1w Ll <o Merommnesio 5 :
[ =3t < L iqad Privain Gaseg | Fig. 3.10 Nested lisis
e
g
‘ -

Fig. 3.9 Creating a nested list

=
PRACTICE TIME n@“
i}

Creace a simple web page using HTML to give some tips to ensure healchy and proper functioning
of the human eye. Set the following properries:

« Background colour should be yellow,

+ Paragraph text should be in blue. Fone size should be large and fonr showld be Arial

» Heading level 2 should be centre-aligned, in red,

3 - .
and in upper case. L:'-'_—H_: -y E: _Iq_'h:nﬂ
* Unardered list in maroon, medium fong size, omir o=z
in Comic Sans MS font. The list-itern marker THECant 0 Byt
. Cuyle = "lasioyy >
should be a dise u‘m:tL-u-cnuq-nuruLl upper=ae)
rl:-l:ir'ﬁ:h;l::r..-ﬂ. .“-HHT |
SOLUTION T i o
1. Type the HTML code in Notepad as given T r
alongside, ﬁh“ﬂmhﬂwm I
4. Setect File » Save As. mm:""'l"“’ |
3. In the Save As dialog ba, choose the lacation ;“;-{..‘.'M' e
where you wish 1o save the document. iﬂdmﬂ;-ﬂmw
4. Enter the file name with the extensian him fio, o
(eyeshtm) or hemi (eyeshemil), and click Save. =
oxroRp g .
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5, Towew the file ina web browser:

2 Open Internat Explarer, {15! 'w:-_-_ﬂli!":-;iii i &
b Select File» Open, o, o
¢ Click on Browse in the Open dialog box CARE OF EYES
vhat appears. Do tha 45agwing & aith NEAThY mper
d. Select the file eyeshemd and click Dpen. 4:1-'&‘-‘:1!?::-&
e When ghe WI'I‘I diah:.g bﬂ[[ﬂm X mﬂﬂ#ﬂn#‘ﬁnﬂ
click OK to open the page, The web page hemis o i
appears in the browser as shown in the
frgure on the right
pescription List Tag

The description list tag is used to build a list of definitions.
The tags used for creating a description

list are: Top Tip I‘ﬁ
<dl> Description list ?_

e : In HTAL 401 the <dl> mag defined 5
<dt> Definition list term - definition lar, while in HTML 5.0 the <di> tag
<dd> Definition [ist description defires 3 deseription list.
e = The HTML code given in Figure 3.11 will make
SDOCTYPE himb> =[l  the working of description list tags clear,
<tarit>
et s i e The output of the code is shown in Figure 3,12,
“style
:;q'mhnh-.‘-rl : '

. I-.- 1 ﬂ L I
T e
<arad £ ]
ety I DEFINITIONS
A2 Deftiom <> I ST

; P e sl Ty 18 0 S Ca b e, mal e
il repewable mﬂﬂﬂﬁﬂﬂlm{.hﬂ Vomryy vy, wha b ores sl oy et et v Lrmted e e o e
ued apais
apais el agaiercidds
soaroey unce wsed cannot be proreiled BB
shart period af mevidd> L
q&,m e - p——
w'h"'-': Fig. .12 A descrigion list
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INSERTING IMAGES

We can use various types of Tonts and Bsts in an HTML document as per our requirement. Similarly
we can add graphics or images 1o make the document look more aliractive, You hayve q'lln_-.lri-l:-
learnt howw to insert im-'iﬂtﬁ a5 a hﬂﬂ]igrﬂund uging (e hafkgrﬂu“d.imagn property. Here wy
will learn how to insert an image to support the text. web browsers support a number of praphic
formats like jpeg, gif, iff, etc, Given below are some of the most widely used formats:

. GfﬂP"fiﬁ Intercha nge Format (GIF) is the best format for displaying images designed with a
graphics program. This format uses a maximum of 256 Colours and a combination of these i,

create more Colours, The GIF format is not suitable for photographic images or images with
gradient Colours because GIF format has limited Colours,

* Joint Photographic Expert Group (IPEG) is the best format for photographs, as it contains 1
million Colours.

* Portable Network Graphics (PNG) This format is best for images with transparencies or low
Colour counts.

Top Tip - ()
v
image Tag The <img> element does not have a
The <img: lag specifies an image 1o be displayed closing tag. Thus, it is an empry element. The
in an HTML document. The <img> tag has the Risk elements. are all container elements i they

following attributes (Table 3.5): have an opening as well as a closing tag.

Table 3.5 Atrributes of the <img> fag

Attribute Description Valuefs) Example
i 4rC Specifies the URL of an image LIRL <img sre="al.jpg">
alt Specifies an aliernate text for an | text | <img src="al.jpg” alt=
image | "Image not available™>

height | Specifies the height of an image | Valuein pixels | <img sre="al.jpg”
height="100">
width | Specifies the width of an image | Valuein pixels | <img sre="al.jpg”
height="100" width="80">

You have already learnt how to set the margin, alignment, Did you Know? ﬂ
and border properties in the previous class. The same can. In HTHAL €01, the height and
also be used for an <img> tag. You can also specify the height  yideh could be defined in pixels or

and width of an image using CSS. in percentage. In HTML 5, the value
can be specified only in pixels.

O FORD B0 i
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The following HTML code in Fige 111 will help you understand the < ima> lag. The outpul is

shawn in Figure 3,04,

W byl - s
Vir_iin_foa o vy

[ < TN TYPE hail>

|l
“head=
wHEEInsermE Imapes < Bile -
<giyls Bpetlertice ™

i b2 Pl sppencase )

| e

| rad>

| <hody>

i wh2>irerting mm brogge-ch e

<mg o= ~lowerjpg=>

| <img sro= "lowers jpg” ar= “Imags & oot padibie™
ﬁtuﬂ:.?-

okl

| age | border: 2px sobid red, widih: 120ps; heighe Topay

[ v

el |

Fig. 3.13 Code for inserting images

is not fixed

Ordered list  a list in which the order of items
ig foxed

Description list a list of items where each item

has a block of text acting as definithon

: memaory Butes

List items are defined by the <1i> tag,

The items of an unordered list are enclosed by
<ul> and < /ul> lags.

The items of an ordered list are enclosed by
<ol> and </ol> tags.

The tags used for creating a description list are
<dl>, <dt>, and <dd>.

Unordered list  a list in which the order of items

e s
t'n‘:;.b::-:mmpwz' i
&hﬁ"hmth | it
[ h Bda Vs Foosin Teow e |

INSERTING AN IMAGE

Fig. 3.14 Image in a web page

!nmluuﬁi

HTML allows nesting of lists. Any kind of list
can be nested inside any ather.

Craphics can be inserted in a document using
the <img> tag.

The most widely used graphic formats are GiF,
JPEG, and PG,

- -' . n . THH
5 N I @EEE & I -]
i SO EEEE EEE BB

.
GIF Graphics Interchange Format
IPEG  Joint Photographic Expert Group
PNG Portahle Network Craphics
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Objective Type Questions

1. Choose the correct option,

A AN i list 5 used for items in which the ordering is not speeific.

. Ordered ii. Unordered jii, Definition v, none of these
b. Which of the following values can be specified for the list-style-type property

I disc ii. circle iii. square iv. all of these
€. Which of the following property is uted to specify an image as the list-item marker?

i list-style-image &, image jii. style-image fv. nane of these
d. Inan ordered list, the ordering is given by a numbering scheme using

i. arabic numbers {i. letters jii, roman numerals iv. Any one of these
e The ............. tag specifies an image to be displayed in an HTML document,

b <img> il. <image> i, <imsgehtml> iv. none of these
. The attribute of the <img> tag that specifies the URL of an image.

(R 1 5 i, source ii. imagesource iv. none of these
B cooieen. 5 the default value of the font-size property.

i small . medium Hi. large iv. nane of these
h. Each item in the list is specified using the ................ tag.

L <li> H. <listitem> . <item> v, <list>

Descriptive Type Questions

Answer the following.

Differentiate between an ordered and an unordered list,

Mention the values that can be assigned 10 the list-slyle-type property of an ordered ligt.

Name the tags used for creating ordered and unordered lists,

What is the purpase of the <dd> tagi

What are the tags required to create a description list?

Which tag is used for inserting an image to be displayed in an HTML document? Mention any two
altributes of this tag.

What are the various ordering styles that can be given to the items of an ordered list?

What do GIF and PNG stand fos?

I Your teacher has asked you to write a program in HTML which lists some difficult scientific words
and their definitions, Identify theee of the HTML methods used to create lists. Which method would
you prefer 1o use and why?
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i Analyse the importance of iserfing images in HTML codes,

L. a0 Usang vour knowledpe of HTML, write a code for 3 whpage 1o shisw:
o the winners of the last 4 footlall werld cups
o the vears when they wene played
o the picture of the winning team's star player

bt To improve the presentation of your web page, include refevant headings and think carefully
about its format,

Application-Based Questions

& Iram wants 10 insert an image in a web page,
b Which tag will he use to insert an image?
i, Mame any two altributes of this tag and their use.
iil. Mame the attributes of this tag used 1o specify the URL of an image. Explain with an example.

b. Afrah has to create a web page giving definitions related to physics,
I. Mention the tags needed to create this list,
ii. Give the full form of these tags.
HL Mame any two properties used with thess tags,

c. Taria has (o create a list of items in which the order of items matters.

i What is the name given to this type of list?

ii. Which tag will she use to create this list!
iii. Name the lst type property that specifies the type of list-item marker. What values can be

assigned to this property!

d. Identify the errarts) and write the correct code:
<hegd>
ctitle>Creating Ordered List
<atyle typa="texts/ "*
el |list-style: upper |
2 head>
<latyle>

& IN THE LAB

1. Danish has been asked by his teacher to create a web page giving a list of books to be read by a
stugent of class 8. Help him write the HTML code for creating this web page.
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2. Siham's mother is planning to start hohby classes during the summer vacations. She has asked Sikap,
to create a web page giving a list of courses that will be offered in these classes. Help Siham creay
an appropriate web page. Also, set a proper background and text colour, Insert suitable pictures
wherever possible.

s & oo Ll el
3. Jibran’s teacher is poing to conduct . = il

an experiment to show whether a i F"‘"“"'“":T-T}' o

substance is combustible or non- *",: g ¥ ey 3

combustible. The teacher has

asked Jibran 1o make a list of all the List of Materials I

substances that they will lest. He has -
crealed the web page shown on the .
right. Can you write the HTML code for : m
this pagef Replace the repetition in the .

list with a substance of your choice. Matehatick
e Bt = l=]® st
4, Danish was asked by his Science | (B - e
teacher 1o create a web page that lists e a— : :
the uses of non-metals. He has designed T Wam e Teck e
the page shown on the right. Wiite the
HTML code far this web page giving USES OF NON-METALS
some more uses of non-metals, Soene of the e of son-mctals we
5. Graphite i o i Yo kb .
i, Dearnoead in weed for maling jeweliery, 13 in also used bs cming and
grinding toals.
GROUP PROJECT —

You are going to talk about the development of coding for web pages over the past 10 years. Wk
together o find out the information required and present your findings to the rest of the class,

Hint: Showing a timeline of events might be a good way 1o show this progression

2% TEACHER'S NOTES

* It would be useful to demanstrate how o inser an image as a background of a web page.
* Explain ta the students the relevance of having an image file and the HTML document in the same folder
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chaptey
Tables, Links, and

Frames in HTML 5

Hey, Togple, sce
this website contim 3 table | | = AT T R T
Does phar mean e £an wr.-!e/l. £ coisd We E‘
code in an HTAW documens e, Coggle!
to clapliy a table!

or geach mehow

Siare! I rel! o
about a few ooher |
prckE as wiell' o

In the previous chapter, you leamt how to create lists and ,_.-—--:-"__""""f.ll

In this Chapter 1,I

insert graphics in an HTML document, Other important
elements that vou can add to your HTML document are

tables, hyperlinks, and frames. Al

Vau know that 3 website consists of many web pages. These - Linking

weh pages are linked to each other using hyperlinks. A *jp:-:nin::::'-ud-n and Video
hyperlink is usually an underlined word, phrase, Image, or = Lreating frames

icon that leads the readers to a new web address when the

user clicks on it. Hyperlinks can be used to jump from one location to another within the same

page, fram one weh page to another, or to anather website.

CREATING TRBLES
Atable arranges data in rows and columns, Tables in web pages make the data easier to read
and interpret. Professional quality websites always use tables, where the cells contain text,

65 QXFORD
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graphics, and links, Taldles are a powerful tool for Lying out the contents of a weh page, y

using tables, the designer can place text and graphics anywhere on the page.

Basic Table Tans

Talile 41 shows the basic tags that are used to create a tabile in an HTML document.

Tahle 4.1 Basic table tags

- r—

[_ Tag D Al B -D":'.H..'.lu"

<tabled, .«</table> | Table g | This is the main tag used to define a table in HTM)
<tro..e/t _T.;I:Tl;rm-.r tag The nhh_r_nw tag defines a horizontal row of cell,
<rdy,..</vd> | T.;||;|I-|: data tag | | The table data 5|:|.|;ECIfIIE$ an individual block or cell
m a table FOoW.
<th>. </ /th> ' Table Header The table header |n|:||::ale'5 that the cell is & hiader
cell | for a column or row,

<caption®..</caption= T;bieca.punn.n' Table capd_mmhemdmg deﬂnus a caplion for the tith:

 heading tag | of the table,

Let us now move on to the various table properties associated with the <table: tag (Table 4.25

Tahle 4.2 Table properties

caption-side Specifies the placement | tap (default) caplion-side: hattom
of a table caption ' battam
_hﬂ;ial-s_pﬂlr;lﬁ_. Specnliie-;"lhe distance -_'.-';lluel value1 value2 in X, border-spacing:
hetween the borders of | €m, elc.) 10px
adjacent cells If one value is specified, then it | border-spacing:

specifies both the horizontal and  12px 20px

\ vertical spacing.
If two values are specified,
then the first value specifics
the horizontal spacing and the
second value specifies vertical

, | spacing _
| horder-callapse ~ Specifies whether or not - sepasale (defaultl, collapse _ border-collzpse:
' talle borders should be | collapse
~ collapsed | : |
EHHEE [ B EE ﬁ 3 88
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specitivs whether or not show idhetanlt, hicde emgilv-celle: hide

.;-|:1:1p‘.'|.-|.'|.‘||:-
tes elisgplaw: Dordbers and
background for cmply
cells in a table
:-;r]'.h Specities the width of "l as percentage or pisels | width: 1002
table width: 25ps
hh.g-TqE: - Specifies the height of a - Value as percentage or pisels height; 257
§ able hesght: 100p

Consider the code in Figure 4.1 to understand how to create a table and assign table properties:

The output is shown in Figure 4.2

Notice that in the above table, the border is missing. To get the table border, you will have to
use the border properties (border-width, border-style and border-calor).

Ere— ] [
P _— "i-ﬂ-;ﬁﬁ]'!ﬂﬂ aan --I'T! :.jl.'_ufﬁ_h "
<hemin fia [#e Yow Fececin  Tal e lda ea Favoeen T
e ey Tabie et -

:: Srpe=TIr Siemple Table ADE

[ border-colipse: wpETie mpty-orla bide A BC EF

Bordsrapaong Lps i ) aH

A EF il 1

:"’.",: Table

aH

THW Fig. 4.3 Table with
2 Fig. 4.2 Table without a a bordler

==

o SR Mow, let us make a change in the HTML code above and
R following code:

atrFands add the ing

:“ table

I

L

;;"“" border: 2px selid blue;

Nabsle» empty-cells: hide;

w border-spacing: Spx 8Bpx;

caption-side: bottom
|

Fig. 4.1 Creating a table

that in the above example, a barder is applied to the table only. You can apply the .
propertics 1o the <cd=, <tr>, and <th> lags alsa. Other properties that can be applied to

e <td> tag are given in the following table (Table 4.1)

OX PO
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Talde 4.1

Property

Text-align

verhical=align

rruelelle:
parddding Specities e spoce between thes border anid content ina Lkl
Consider the HTML code given in Ty 4.4, orvekany s
Ioe B84 lwmat Vew Pem
In this example, a border for the table has been specified -?-’5*
with the border property. A backpround colour and the tex bareder: 2pm solid b
colour for the table heading row has been specifiod with )
the background-color and Color propertics, respectively. [
The data in the table cells i i i
e data in the table cells is center-aligned. The space lext-abzm comier
between the border and the content is 20 px, ;‘”‘““"F"’“‘
Now, run through the HTML code given below. Here, the ?
border properties have been applied 1o the table’s border i fei b
as well as to the contents of the table. The output is shown 1 e

in Figure 4.51h),

Seds thee botesiintal aliprsroean o tesr inoa talile

Seebs thee wortaeal aligmwent of texd g Lalale

el - bawmcd

Riw i | l—,| — -
b e _
e =1 E

1 “lead—utle Creatay Takle-t=dns

l;;:Lh- Fper="trakicay s

| { Tewder Ipa walid blas; e=prtj-criln: bids bordev-ipacibgy. 1pE
pi wapiron-uide s |

B iE i | bonder: Tpu salid geen]

i {pasing: fpu)

[
L e ————————
]

Fig. 4.51a) Code with border propentics for
the table and its comtents

CE il L jarrajre R Rp T

_ Value _

trape, Baritleammn, oy

Walur: inv paels

'H.-_-.ﬁ'n"

lesdt, rapthit, ear cr

Fig. 4.4 Specifying border properies

] h-ull!q.hﬂl.lp
.._,h--u-.'l-hl.-.
u- Tk .r... 4'4.-,...1.-..

1E[E]

E||F

G|l H

Senple Tabls

Fig, 4,51y Applying boeder
properics o the table contents

Inserting images in a table cell

You can also insert an image in a table cell using

the < img= tag.

Caonsider the following HTML code and view the

output in a web browser [Fips. 4,640 aned 4.6401):



Talibe 3.0 < vaks Lagy properties

text-align Sets thwe horizontal alignment of text in a table | Befl, right, o cen,

o, holtom, e

Sots the vertical alignment of fext in a fable
miclidle

I
; Specifies the space btween the border and content in a fable | Value in pixely

- vertical-align

padding

Consider the HTML code given in Figuee 4.4 Jimacs it I SO
In this example, a border for the table has been specified ':J* T = |:
with the border property. A background colour and the text bonder: Jp sobd bl

colour for the table heading row has been specified with |] 4

the background-color and Color properties, respectively. -

The data in the table cells is center-aligned. The space pm:-lﬂ;;_:‘u::u :
between the border and the content is 20 px, ;ﬂ"“]"*F ol

Mo, run through the HTML code given below, Here, the ?

barder properties have been applied to the table’s horder ﬁ_li_rr;mﬁ-}-em ornge |
as well as to the contents of the table. The output is shown b g

=

in Figure 4.5
Fip, 4.4 Specifying border properie

T - [FN]
HEP—_H

cu:uncr'm:h.up

= e =y

e ||=|1mi-cgh.iu..
L Crusbee Ties

| Fie [ Wirw Fewen

[A1[e][<]
BE|lF

Talsa e

H.—H.u-l;'m
<y e By lieui™e
lp

i| booder: Igm walid bine. emprrtells: hide bordriaypse g Spa
FpL Caption-uide: b |
B, i, o [eorder Tpm dolid pevn]

" alln

Burgple Tahle

Fit. 4.5(b) Applying border
properties to the lable contents
Inserting images in a table cell

¥ou can also insert an image in a table cell using
the <img> tag.

Consider the following HTML code and view the
output in a web browser [Figs. 4.6() and 4.6ik);

Fig. 4.5(2) Code with border propenties foe
the table and its contents
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7 e - Hrbrpad

=

IR THTE himbe

“hamE=

arfaninde-= ritie - reniing Tables < ke
iyl TypE=TiRtica T

iy

| owder 4z gk Thes;
i,

ey

Isspdr-rpuemy; fpu B

anpre-rila Hip)

fh, il & [berder 2o sob )

i [l Spx]

T

ey

whedy>

siatle =

ceapnir=3 PR hD-Usaption

CEF

<i-cimg BT appie. " <hieApplec i Enade
<HETe ETC A o <l Pineapele<ih Dese
ﬁ%mh':— <hi P e e

iyl

wid=Teng ere="chrry g™ ~hl>Chemrithls=g=
“ld-ckng sie="papays jpg e <hEPapayrciiecide

<l sre="wilirmrlre fpp e ol T e el A e e
==

b
<l = bl

Fig. 4.6la) Code for insering images in a table

PRACTICE TIME

e

L N l_—- e ..

Frults

e TRt = e E B o I P U i
1

&

T oalermerian

Fig. 4.6(h) Insered images in a table
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Create an HTML document 1o show a table geing names
of the regional folk theatres and their respective states.
Rashid has creared the web page given alongsde

Can you recreats the HTML code he would have written

for this web page?

SOLUTION

Look ar the output carefully 1o identify the formarting

thar has been wsed on the web page.

You can see in the output that there is a title on the web

page followed by a table.
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The table has twe cofumns and six rows, YT ——— [y

<!DOCTYTE k= C
<hrrds [}
The first row 15 a header row. Alsa, hesboateCredtng Tabler= e

the table has 2 blue border, whils the L | |
indivdual cells have a green border [ESE A o A A T

ik, 1w :‘b-aﬂ:]r;s wpid green
around them. 14 [pedding tpx}

ipylehemd oy
gk aprone=33Folk Thetrrohi</ptog=

=

The cade will be written as shown ﬁwﬂmmm
ngsice I '

:h hil Frrretry Al Sl Al

i

==

b Dysrea<nd=-cl>E Pl

L

<He

< Shirw TR e Pun et

==

=

<ol Thrarnacal =i sands Pl fnanaacrd>

=

e
&) CevieroidaieF A TR wwdr
L o

ey e e, T B

LINKING

Hyperlinks, or simply links, are the most important part of the World Wide Web. Links tie web

pages together in a website or across different websites. Without links, the World Wide Weh
would not be a web at all.

There are three different kinds of links:
* Internal A link to a point on the current page

* Local A link to another page on the came website
* Global A link to a page on a different website

Let us discuss in detail how to link one web page 1o another on the same websile

Anchor Tag

The HTML tag we use to create a link is the anchor 1ag <a>. This tag is a container element

as it has an ON tag <a> and an OFF tag </a> The HREF (H i
_ . : ypertext Reference) antribute of th
anchor tag specifies the destination page or the file where the link will take you. e

For example, if the words ‘Next Page’ are to be added as a link o an HTML file, the code will be

<a href="filename.html®> Next Page </a>
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F

o T |i|-'!||'.. v a F'ﬂE'n'-' on the 'II"-"‘I.'Hlll |||'||'i'|‘ll." lI|.'|."|,-{|I TREE st |'|,|'|1,.'|_' II‘H_"q |l|11|]|l:"|[* |.1i'.|lii|1.'!1!r.
<4 Rr2f=ThUEp wew. hotmatt, com*s HOTHAIL « /4™

['-1?"-' narkd,

breaf="resulre htmi™s 2a .3
1 LeT = -l'.-u---..'l'tn.. = :'I""':!:: T-'l1'1.'|.|'1-|'_"l o

o Tosend an email, ‘mailto: is requined before the address.

a4 . lang =

ad fELELT '_'31llL‘l:ﬂL":_Pl]h'-"tmﬂLl.,|;'|.:-'n'|"'_'\- AREREr

nefining Colours for links

vou can specify the Colour of the link depending on the action performed. In HTML 5 it is
specified using C58,

For example,

<ERyle Type="Lext/iceavs
tiink (Colour: red)
tvisited (Colour: green]

nover jColour: orange)

tactive [Colour: blue)

fatyle>

The HTML code above specifies four colours,

* link (standard link) The colour of a link the visitor has not been 1o vet,

* visited (visited link) The colour of a link 10 a page the visitor has visited,
* active (active link} The colour of a link when it is clicked,

* hover The colour of a link when the mouse pointer is over il.

Aol B W

Note: a-haver must come after a:link and a:visited, and a:active must come after ashover

You can also use text-gdecoration and other text properties o change the appearance of the
hyperlinked text, Consider the following example:

<stple type="text/css”>
a:link |Colour: green:
8.vlink |[Celour: wiolet; font=-family: Georgla]

a.alink [Colour: blue: font-welght: bold)
<fstyle>
In the above code nat only the colours bt afso the font and its weight have been specified,

The following example will help you understand how 1o create and add links,

caxt-decoration: nangl

7 . ik
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Suppose you have two web pages, quiz.html and answer
a list of questions. Clicking on ‘Click to see answers’ will take you 10 an

s himl. The guiz.htm! page CONSigty
swers.html, which

answers to the questions. It also has a link back to quiz.html.

| weTTaligm )

Tl T e fomlnipe: 5.

e, p [calor vipe: x-larga}

< head>

= rdyn

kil

g, Which river |5 Iewa an ke Vellow TiE
el Whick is the larpes peowieee of Pucian?

e o

<pr). Wha was @ firn Chisl bisior of Pabbess

=p= ]
=n brefrmmsin St = Click i pos smpeerrlice

b

Fig. 4.7(a) Code for quiz.html

The HTML codes shown in Figures 4.71a] and 4.4,
format the contents of quiz.html and answers hiy
respectively, The output is shown in Figures 4.7,

4.8ib), respectively.

Laa p
| Bt e B3-S40 Bayhed B gt S, b 2=
] .
T Fda B bew (psmw  Tasls  Hew - — |

1. Whach tiver is knowa as the Yellow River!
2. Which i the largest province of Pakistan

3, Wha was the first Chaef Justice of Pakistan'®
Cleft s 3w wmvnepry

Fig. 4.7(h) web page view of quiz.himl

T e - b

=gille=Creatiog Linksoitles
<gnyle pFpe="ieTlieas">
a:dink {ealar: red)

a:visired {zolor: green]]
a:hares [Dodor: oimagps |
mastive [calir: blee)

p fealor: peen; fomi-yite: a-lape |
= ay] =

=ihead>

gy

=Rd=Asavweriekl>

<p=1. Hwang Ho</p>

=pel Bafockeansips

<), Bir Abdul

ey
it >

b7 {codor maroo exi-aasfiveme uppereis; 1#a-align orpter )

e lhred=" iz Bisd==-Click 1o g back b the quire(a>

2. Balochistan

! 3. Sir Abdul Rashid
K0 e o baark 00 By ey

el

Fig. 4.8(b) Output of answers.htm!

Fig. 4.8{a) Code for answers himl

Image Links

We often want to use an image as a link, so that if sameone clicks on the
another web page. For this, we use the <img> tag within <a>..

<a href="flowers.html"> <img src="flowers.gi

OXFORD

fEiIEES T

image, it opens
. </a> tag.

£ <faz
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(HSERTING ALDID AND VInEg

You can also insert multimedia ohjects, .8 audio and video files, in a web page using HTML 5,

fudio 1ag

HTML 5 defines a new 138 named

the audio ta ifies a standard way to
insert an audio file in a web page, B [<audio>) that specifies a

The attributes of this lag are given in the ﬁ.‘l-”l’.‘lwing lable (Table 4.4}

Table 4.4 Attributes of the <audic> tag

Attribute il Description C Vahe |
autoplay Plays the audio file aulomaticatly when the web page is loaded autoplay
. controls Displays the controls on the web page camrols
& specifies the URL of the awdio file URL
| Indicates replaying the audio file snce it has finished loxaps

Consider the following HTML document 1o insert an audio file in an HTML document using the
<audio> lag, The output is shown in Figure 4.9,

<!DOCTYPE html> =
<hitml> Immting &= Audsa s L3 lllll_ i o=
<head> Q.0 '“E'u"-".I'.E;ﬂilyhﬂHﬁEﬂUpﬂ.uli'_'_, L =

ttitle>InsSerting an Audio
File</title>

< head>

<bhody >

chi>Hava fun!</h2>

<audie controls="controls”
src=*kalimba . .mp3®>

</body>

<fhtml>

Have fun'

Fig. 4.9 An audio file in a web page
Nate: The <audio> tag would not
work in some web hrowser versions that do not fully support HTML 5 andor the file formats,

Currently the file formats supported are WAV, MP3, and Ogg. An Ogg file format has the
=lension .oga for audio files,

Video tay
The videq tag (<vides>]) is used to insert a video file in an HTML document. The attributes of
this 1ag are shown in the table on the next page (Tabie 4.5,

. & T
- gl SEEE B s s
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Tahle 4.5 Attrbuies of the <vidaas Lag

Attribute Descriplion = Value |
SAC | Specifies the URL of the video file to be played LIRL

| height . Specifies the height of the video player displayed on the web page  Value in pivels
wiclth ! Specities the width of the video 1'_|t.1.-_,~r_~| displayed on the web page | Value in pixils
autoplay | Plays the video file avtomatically on loading a web page _ Autoypay

| controls Displays the controls on a web page, such as the Play button Controds 1

Consicier the following HTML code to insert a video file in an HTML document. The output is
shown in Figure 4,10,

L= |2 kil
LIDOCTYPE hemls busrng o Vtlen Pl a1 Y - N _ F

<html> | € O Mle/tDueybosdilUpdationnle; L =
<haad>
ctitledInserting a Video Let's watch a video.
File</titlas l
</ heads
<bhody>
chi>Let's watech a video.</ hZ
seideo controls="controls”
auteplay="autoplay”
src="moviel ,mpd™>
</ body — — e
</ html>

Fig. 4.10 A video file in a web page

Note: The <video> tag is compatible only with some browser versions, The ile formats

supported are MP4, WebM, Ogg. A video file in Ogg file format has the extension .ogy.

Embed tag

You can also add an audio or a video file in an HTML document ysi

: - : ng the <emsn
attributes of this tag are shown in Table 4.6, A mbed> tag, The

Table 4.6 Attributes of the <embeds lag

(AT Sy iy E e
el - =¥ Duﬂipﬂnn R .
: §IC 5|}L|:|.f|es lhr_ LIRL of “’IL‘FIdEu'LI{a 1o be F"lﬂ:r'ﬁd S e iy oy, |

URL

: hejgh1 Epec:rm the helghl -::ul' the md{*u player d.splm,-f.j on 1|'|e wu-h  pa - -
E',e

width 5|'I-!JC1F-E'5 the '.'.|-|:||:h of l:hE -,,.,,j{.u | = T':"_ahJu in F'iH-'l'J_ =
P ;.I'!.E‘I dl'il',ll.[l':,l‘-l}d (W] 1hL weh g |
- i P Value in pivels
X FORD
e & S B R 7%
B B N EEEE ® ]
EE DNE EEEE BEm



For example. [0 insert an audio file using the <esbed> tag, the HTML code is writlen as:

it

chead>

il -_éh -FI_FE_-]'__' = I:|'I_."'|_J-\. .::__'__.:l' _r'r‘.|}

¢ head>

<oodye

€hidlat's llaten to so=6 musiclc/his

carrad srom*kalisba . mpi®s>

</'oziy>

Ll T

Consider the HTML code given below to insert a video file.
% arsteiicion - Siclagand L == - b i e
. < * Embpafegeiidemid =
Fig B Toena Vies il | e — — =

?'ﬁ".-_ﬂ:-l'_l'- f—— \ i E %1 r..-'.'.'l'.'.,1nh.|-.||EJ'.1'|:'.l.p-'.'-ll".rI:|'-"'_ =
| <heenib ol
|| <hend> Here's an interesting fikm clip? |
| <tithe>Embedding a Video File</mie> '
(l o e
i
| <hI>Here's an meresting film cpt<hl> -
| <emibed sro="Wikiide ogv” hejphe="520
| midth="350">
| Shod
| = hireie -

Fig: 4.11(a) Cosde for embedding

a video

Note: Same hrowsers may not support the

<embeds (ag.

CREATING FRAMES

Frames allow us (o open more than one web
page simultaneously in a browser window.
Frames divide the screen info rectangular areas,
each of which contains an HTML document.

<iframe> tag _
The <iframe> lag is now used to define an inline

frame that enables you 1

758

o display a web page within a web page.

Fig. 4.1 1103 A video file inserted using
the <embed> tig

(" nid you Know? ) ﬁ
In previous versions of HTML, the

< f rameaet > tag defined how to divide the
window Into frames. Each frameser defined a set
of rows and columns. The < £ rame> tag defined
what HTML document to put in each frame.




The attributes of the <if rame> tag are given in the following table (Table 4.7):
Table 4.7 Attributes of the <L frame> tag

 Attribute Description g 'il"l]ll.le__j
| sre | URL of the wel page to be displayed in the frame _ | URL

widlh | Specifies the width of the infine frame. "-"ﬂl_uE i_rEPl!_:'P'!lE |
hEigl;_ )  Specifies the height nl the inline rame Value in 1:I1|:'|;E|_5__

Empty, seamiess

- seamless Ehuws an inline frame as part of the containing element

Consider the following HTML code which creates an inline frame in a web page. The output is
shown in Figure 4.12,

" e,

JIWI&I l-l'.lql—llll'l‘l'l'rﬂ'l-._.._

_-\.-p.l-' R —

<IDOCTYPE html> A v Vb 5] = =

enemls e : -

<head> Creating Inline Frames
<pitledCreating Frames</title>

Sioad This is This is

shoay> Frame 1 Frame 2

<hl> Creating Inline Frames</hl>
<iframe src="frl.html™ height="200"
width="200%></iframe>

<iframe src="fr2.html” haight="200" e e
width="200%></iframe><br>

We have created two frames. Fig. 4.12 Inline frames in a web page
</body>

</html>

To add some style to the frame using C55, let us make the following changes in the HTML code
and view the page in a web browser |Fig. 4.13).

<V DOCTYPE html> | |_|-r"l'-l=-rl—l-n-nn-m FARLneaid P b P S000 e e pat
<hemi> 'T":'.: e —
<head> e - -
<title>Creating Frames</title» Creating Inline Frames

“style type="text/css"> '

iframe [margin-left: B0px; border: This is This is

2pr dotted red

e ] Frame 1 Frame 2
</haad>

<body>

<hl> Creating Inline Frames</hl> Woe e crumtnd tuss Eramen with e imsrin B, dotied red bosder of 3
<iframe src="frl. htmL"

height="200" width="200%5</iframa> Fig. 4.13 Inline frames

SR . s am s 76
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<iframe sre~"frl.heml® height~*200" width="200"</iframes<br>
We ]IaallIE created bwo ].:I|||'|'|n:I TR |||.t| rr.._irrr!n F“'Jp_:,:l rlf:"—t.-'-"d- :E'd hUIdEI ﬁf EF‘I-
</bodys

</ hemls Foamx i B as & oo B

- Vw8 i e e R S T PR R e D L

Consider thi Fosllewwings HTML cade m

Creatlag Inline Frames
demonstrate the seamless propuey: -

LITOCTYPE htmi> This bs Frame 1

ElTmim
whoads
<title>Creating Frames</title> This is Frume 2
<ihead>

cele
<hl> Creating Inline Frames</hi>
<iframe sroc="frl html"s></|frame>
<iframe gsesmless="seamless” sro="fr2.
htrl"></iframe><hry>
</ body>
< Shtmls

Fig. 4.14 Seamless inline frame firame 2)

The view in the web browser is shown in Figure 4.14.

o
L ]
Table a grid of rows and columns Padding the space between the cell contents and
Cell a shape formed by the intersection of a the cell border
table row and column Cell spacing  the space between cells of a table
Memory Bytes o
* HTML tables use the <zable>, <tr>, <td>, * To add a title to a table, use the
<th>, and ccaption> 1ags. <caption®...</caption> ag
» Tables are defined with the <table> lag. * Tomake a text or an image into a hyperlink,
* Toadd rows toa table, usethe <tr>. . </tes use the <a> lag.
L. » The Colour of the text links i specified with
* To adid columns to a fable, use the the LINK, VLINK, and ALINK properties
cres ., .4 o> fag. * In HTML 5 you can insert an audio file using
* Toadd headings o a talde, use the the <audio> tag and a video file using the
£thy ...« th> tag, <video> faf.
7 L. . ouomw
il.n :uI--: ==== =II-I=_



w  [he =i framos lag s wsoed to define an inling
frarnes that enalibes you to display anather
PIEAAL dloar immsient within thie samee windo,

* Sorme browesers TEkIyY OO0 supepirar] fha= < wniedd e
aned thwe s oo - lags

*  Frames allowy s o opsen mse i ooe wrels
P semeltaneousdy g broveser wintho,

Ohjective Type Questions

boWrite T for the teae statement and F for the ke one. Correc ihe false statemenlis)

4. An image canngl be set as a hyperlink, =
b, A caption can be placed only a1 the top of a table. —
¢, The padding propery specifies the space between the cells,
d. An interaal link is a link 1o a point on the current page. .:-

e, The <a> lag is an emply element. —

2, Chonse the correc] oplion,

a. Which af the fellowing can be embedded in a web page?

i, Audio i, Video iii. both i. and ii. iv. none of these
b The attribule of the <audis> tag that displays controls on the web page.
i. controls il awloplay ii. loop iv. none of these
e. Which of the following can be added to an HTML document?
i, Tables il. Hyperiinks i, Lists iv. all of these
. 'l.."..lhu:h of thee fnllnwmg properlies can be assigned o the text-align property?
- et il righ iti, center iv. Any of thess
. You can wse the ... 13g o insert animage in a web page.
k£ imagas . <imge ill, <image sgo> iv, none of these
. Which of the following specifies the colour of a link when it s clicked?
i, active b, visited ii. howver v, none of these
g The s attribute of the <a- tag i[:EEIiiEf. the URL of the page where the link should take you
L hred iil. sre . horf iv. none of thess
h. The value of the birder-spacing property can be specified in
. Pixels i, Centimetre i, Either i, or il, iv. none of these
OXFORD
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pescriptive Type Questions

st following,

A L T

what is the purpese of the sre ang
. . aned contrad ari :
what is the difference botween the <. a::r' :?:1::1‘:5;“ W

is the use of the very ;
E;;:rilrzsre the rhizzm:: {.;:-,n,::: E:f ?.Irglg T’Fmﬂ What values can be assigned to this property?
ks that can h&fl?ﬂltdmaumhpage.

R i o g o 1. N one it usd with s

DUF Bavourite wehs| s
that the page has been designed using EHE:'E- Analyse the page carefully, and state why you think

I X : A

HIT,T Ts ?L:u 10 assign different colours to hyperlinks depending on the action taken by the user
g hal pamicukar hype:-. link. Evaluate its usefulness for programmers.
v Tj;fz::gra“:r?& in which YOu create bwa frames on a webpage. One of the frames should have
- it amml‘f song embedded in it, while the other should have a link to its video. Give
your webpage an |l'||!1.=!re:;.|mg heading and background colour.

Applifiﬁﬂ“'HHEEd Questions «style type=“taxt/css">

&

table
[ border: 4px dashed red;
enpty-cells: hide;

Observe the HTML code an the right and answes the
questions that followe:

L What type of border will the table have? bordar-spacing: Ipx Spx;
ii. What is the position of the captiont What is the | RRption=gide: botiom
default position of a caption? th, td, tr (border: 3w

bil. What change will you make in the above code, if you solid blua}
want 1o have a space of 7px between the cell border td (padding: dpx}
and the cell’s contents? </atylex

+ Write the HTML code that will change the colour of a hyperlink 10 maroan when it is clicked: green

when the visitor has visited the link, and orange when the mouse pointer is over the link.

Identiiy the erroris) in the code on the right, and then write the comrect code on the left in the space

providid,
B A I o e el e Ol td

cell-padding: 20px
text-alignment: center
vertical-alignment: middle

; L L e T N PRI L L el I‘
SR e B S S S R A BRI AR E e SR AR R S EAAR IR EET R S th
...................................................................... |
bagk-Colour: orange
"-""'\"'rll---."||____.______.|‘|_|.|||.|-r---JJI.III--““-' i SEE R REER . tEHt‘FEGl nur" I;r&&n
......................................................................... d
a
T B
LT ‘% mEE u LI |
H:_- - - = W -_—-Ll‘“—li=.=.=-..'-.=- - o



d. Dania has created a2 weh page for her school giving details about varkous a0ty s i D scbiy
that cultural evening on her web page. Which HTML statement shoubed shee ackd o e TR gl

lar this purpose?

i IN THE LAB

1. Fatima's English teacher has told the class that there are
many French words that are commanly used in the English
language. Fatima has decided 1o create a web page giving
information about these words. She has created the page
given on the right. Can vou write the HTML code for this

web page!

w I"J-_-l-- --_--- J:I_ ;I-__"“;:'L-.!- v

o i

. — =
‘-lﬂ'r-!-—-r-l—r—

Adr

Tl air o ) s de sl mmring Meemy o s galied
ke Tl el g (ke prows dw raes s sl e o il sk
[LI-§ SR N (- | [T T

=1 ]
E =]
= Ty
Pees Jfrws ]
e | o
E=_]E=Teied
B ]

I1.
n.-,_,u..u-uh_u.:-l p-. |:|| %, ..,Fi
J1-|.|. Ir—.l.l:.i.-m: ===

- — | —
| Fem N oo “l-ll-li T—||| gy

—

T
| The French Connectlion
Humenm, Frenah voonds have a permasgrg i

| s English lusgrage The table behow gives thy
eseamning M o commioaly seid Frend ol

[Frradara] [ Siesming ]
pan | [Goniie |
et | [itend ek |
| Bt [ fovines ]

|ilﬂ--h.‘ul HT_!Tr ol pstlir cm |.|..-q

2. The Science teacher of Class VI had taken up the
chapter on ‘winds’ yesterday. She aleo told the clas
about the names of some local winds ihat Dlow in
different countries. Farthan now wants to create a web
page and give these details in the form of a tabile, He
has created the web page given on the left, Weite the
HTML codle for the page,

4. Creale two web pages, one on ‘Properties of Metals’ and the other on ‘Properties of Non-Metals’,
Ereai.u a link hegueen the two web pages, Set the background colour as yellowy, font for the
heading as Comic Sans MS, and the font far the text as Times New Roman. Preferably, also

nclude suitable pictures of metals and non-metals.

[ 3 Mbetals bave lagh inckaip
5 T s Rt |
b s mew maallealihs el sbacnily,
* Ther mow st sermssd el slectincal comlicion

LR T o [—"

1 AN il i il et ey whisch is Bl ||

%
R
%
5

e
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i
ai.ﬂ
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4, Create a website with two linked web pages on the topic 'Greenhouse Effect and Global Warming'
The first web page should give information on the greenhouse effect and thee second should give
infoemation on global warming. Sample web pages are shown below. Create similar web pages and
alsp include relevant pictures,

GROUP PROJECT

Your challenge is 1o create a campaign website for a topic of your cholce. It could be an environmental,
i |'||_||iril.'..1|, a plobal, or a local issue. You will need 1o keep your campaign website clear and simple to
be effective but try 1o use as many of the skills learmed in this chapter, as possible.

% TEACHER'S NOTES

o Explain 1o the gudents the lmpoance and usefulness of ables in web pages, and the uiefulness of links.

s A demonsiration of how o add audio and wideo fikes 1o a webs page, and how bo create frames that

would be uselul

a1 OXFORD



Audacity

Hey Coggle!
Thinking of

Tomele, toclay mdam -
mentioned a new software caffed
Audaciry. What o it sed forf

Audacity is a popular free software meant for editing and
recording sound. The software can be used for recording
and playing back music or sounds, removing or adding
tracks, multitrack mixing, noise removal, and cha nging the
speed of a narration, or a piece of background music to SYTIC
it with video or 1o make it run for a certain duration,

STARTING AUDACITY

Download Audacity from the Audacily website, Once you

have downloaded Audacity, start the software by clicking
Start» All Programs » Audacity

Or
Double-click the shortcut icon on the deskiop.

CCHORD

LTHEE e e o =} = H E
B B B IEEE = [ 5
B EEE EEEE BEEBR po
" mn EE B EEEREE E A B =

or

T Oh, Ok Audacary o
used o edit miuinc s
sound e

In this Chapter

= 5 arting Audacicy

= Creanng a New Prosect

* lmyporting and Flaying
ALidio Files

=« Lopyng or Moving Portions
of Aucso
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he following screen appears {Fip. 5.1,

Tranypers Toolbar Tools Teelhar ~ MemuBar  Meter Toolbar  [dit Toolbar
iy - =@
o b e Biewped  lawky Gereiss D N vy i e —
m, b, @, a; w; g TR N
x 3 4 .l":' *ﬂ,unulﬁ.u.ﬁﬂ-
l L o et 4 S - T mm ] oo o Aas .E[.I- =0
e e "'.-.ulﬂL'd'nll—ilul-.mu -J;nqi.-.;;:'.-]
pud 4 o 18 34 an
T : : T
| Miiner Tootbar | Deevice Toolbar | | Timelws |
! Whlir’y as
.-_‘I: —_——— = .-.._ e - — !
Frup il s ety Gl cbon Stwt @ End | Leagh Rz FuE s |
HID - dragBs | |06 & 60 mO0 @60 4= B0 EOmOE 500 = !hln“- mED,OaE =

Fig. 5.1 Audacily window

Components of the audacity Window
The components of the Audacity window are shown in Figuee 5.1, Let us briefly discuss the
varioys toolbars of this window.

Pamte Play Sep  SkptaStst SkiptoEnd  Record

Transpon Toolbar

The Transport Toelbar has buttons for
':'Il'rllmhmg |]|.:|'|.-I];L-|;I-; and recording, and n e gl ; Hi by J .}r
for maoving Lo the start or end of a project. : ’ -

Miner Toolbar

This toalbar helps you control the utput Volume Input Velume
volume levels for playback (left slider) = P v
and record (right slider) for the audio ["'ﬁ | — 20, '
B3 DXFORD
:» W meEs & = B B
Hm LE o EEER BEg @8
- - mam & @ B u _uE B EEEEEE i EE W =



devices selected in the Device Toolbar, The microphone icon indicales the: record volume or
the input volume, while the speaker fcon indicales the playback or output volume,

Tools Toolhar
This toalbar has various lools for selection, volume adjustment, zooming ele,

The Selection ool is used o select sections of the audio file 1o Sebection 1 Enwelope 1)
i ., The ako ¢ el =
edit or play, The Envelope tool helps you make smooth i I 3 G| o,
changes. 5. A
. : ; — | Mt Togy
The Draw tool is meant for smoothing out irregularities in the pl o XK Mody

audio wave. With the Zoom tool you can zoom info any part of

- Toowm fol Tilme Shlfy ron)
the audio wave,
The Time Shift tool helps you sync audio by dragging audio tracks or clips along the Timeline,

The Multi-Tool mode allows you to use all the five tools logether. However, at any given point
only one of the tools is active.

Transcription Toolhar Play-at-Speed © s
The Transcription Toolbar helps to change the speed of playback. - "
Depending upon the speed desired, a track can be played slow or fast, P &
Selection Taolbar Top Tip - — —-j';‘l
The Selection Toolbar helps in setting up 5
precise timing and in selection of portions Computers store video data in units cafled frames

; ! while audio data are stored in units called samples. The
of }'Il::li.ll audio tracks. It also helps rrl_ rate at which the computer changes frames while playing
setting the correct frame rates for video dumm_:fu_r the other is called the frame rate, while the
soundiracks and CD audio. rate at which it changes samples i called the sample rate.

bt is measured in number of samples played each secand

Fraid il [Hr) Seiwckon Sles @ End i Lengih Audin Praian
awa, - e.-mml_;[nn_umu.n:rr,|uuumnn.wn|; loehoEmon D00 4%

Frame rabe Srfectian drap-down menis

meter Teolbar
The playback and record meters an the

Meter toolbar display the sound levels of Flayback met Ricord meser
an audio track. These meters provide a I&E . | ; ; __,_;-!
visual way 1o determine the overall sound by o s e o i e oow
levels of your audio track, e %2200y %51 5
E.HE.EE g ] BE B Hﬁ' I
N B N EEEE B & |
| m .=----.-====.ll._u-:.“. Y ‘-'-'.'4



t Toolbar

he Edit Toolbar gives you quick access 1o commanly used functions for editing yvour audio
acks such as, cut, copy, paste, trim audio, eic.

Cat  Copy  Pase Undo  Rede Toomin  ZToom Owut

H[e[R[we] o[ 8] AA2]2

i L

Trim Audie  Sience Audio Gynclock  FloSelecthan  Fit Project

nc Lﬂ-fl'[ i".:'- i fEEITtJ g ﬂ'l:'l'l E[IE-LHE'E- II'IEI a ChEﬂEE i|-| 1E|'IEth in one I:]F rhg l[ﬂ.‘l,fl'ﬁﬁ HF a ErﬂLrFll .]ly[l
akes place in other tracks of that group, thus keeping all the tracks in a group in sync.

evice Toolbar

he Devict: Toolbar is used to select the audio host, the input device, the output device and the
number of inpul channels to be used for recording and playback.

Awdin Hout name Output Device input Device knput Chanmeh

HHE #] i) [Soeskers (Reattek High Defit ¥ | /¥ Maophone [estek bighDefi = | 2 {Stereo) input ¢ |

The awdio host name is the ‘language’ or the interface in which Audacity communicates with
your recording and playback devices. Input channels are either one {mono) or two (stereo).

CREATING A HEW PROJECT

A project in Audacity is a file where you create, import, or edit your audio files. A project can
have a single track or multiple tracks. A project contains the audio files and other information
like volume level, track names, etc. To start a new project in Audacity, select File » New,

To set the preferences for properties like sample rate, sample format, for the project:

1. Select Edit » Preferences.

2. The Preferences dialog box appears. Click the Quality category (Fig 5.2,

Sample formal is the number of bits forming a sample.

The larger the number, more is the information stored in each sample; hence, better will be
the quality of sound,

Natice that the Default Sample Rate is 44100Hz and the Default Sample Format is 32-bit fioat,
Both these affect the quality of the audio file.

. Click OK 1o close the Preferences dialog box.

DX F{RTY
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Fig. 5.2 Preferences: Quality settings

IMPORTING AND PLAYING AUDID FILES

WAV, AIFF, and MP3 are some

of the common audio file formats
that can be opened in Audacity,

1. Toopen an existing file, click
File » Open or File » Import
> Audio. The Select one or
mare audio files... dialog box
appears (Fig. 5.1). Select the
desired file and click Open.

&

You can drag and drop a file

(" fast Forward

0 St wve i ranit: s R

into the Audacity window to
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2. On opening the file, the screen shows a stereo waveform for the fi
channel is displayed in the bottom half of the track and the lef

top half (Fig, 5.4),

The loudness of the audio is direct]
audio is louder where the waveform
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Fig. 5.3 Selecting a file

le opened. The right
channel is displayed in the

¥ proportional to the waveform size, This means that the
reaches closer to the top and bottom of the track.
¥
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Fig. 3.4 Audio file opened

The duration of the audio can be
measured in minutes and seconds

using the ruler (the Timeline) above
the wavelorm,

. To listen to the imported audia, click
the Play button on the Transport
Toolbar, To stop the playback, click
the Stop button.

fast Forward

May/Stop  Spacebar

How to make a Recarding
The sleps 10 make a recording are:

1. Select Speakers as the output device
and Microphone as the input device
in the Device toolbar (Fig. 5.5

2, Also select the Input Channel as
Mono,

'I‘lﬂ

A mono file i recarded through a single mic, so there is
only & single channel, thus making the waves identical in the
lefr and reght channels. This gives the impression of sound
coming from one direction anly which gives it a dull feel

In & scereo fle, chere ane owo mics, and thas two channels
namely, the left and the right channel with daffering waves.
This ereates the impression of sound coming fram mare than
cine direction, giving a richer feel 1o the madse ar sownd,

" Did you Know?
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Fig. 5.5 Start Monitoring option
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3. Click an the dowmward arrow next 1o the microphone symbol in the Meter Toolbar. Then
click on Start Monitoring oy s that you can hear your recording.

4. Adjust the recording volume using the Inpul Volume slider in thie Mixer Toolbar Fig. 5.4,

5. Click the Record bution in the Transpart Toolbar (i 5.7, Start recording the narration,
Notice the wave forms appearing when you are recording, There should be no clippings Iiﬂ
the recording, Clipping occurs when the top or the bottom of a waveform gets shaved off,
This results in sudden harshness at those points during playback.

i, Adter recording, click the Stop button,
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Fig. 3.6 Adjusting Input Valume Fig. 5.7 Recorded sound
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ta know where clipping might have occurred in a recording, click View » Show

In Aurdacity,

Clipping. Audacity will show you red bands in the waveform to indicate clippin
parts of the waveform cut or clipped, it indicates that the recording level was high.

If you have

[rE s 1 mm I...‘].li
T D Nem Temgmd liarle e (Pen hasyle e T r
iIT=7 H|
..I.;-'I " T 1H.- e =.- o | oo B S0l a ’.... o o ap B
g-" A0 IBBHY an & AARE
BTG w4k e Pam et =) P et B s ek | e T =

LF | LF | [F ] s

s

rultiple Tracks in a Project

You can record or import multiple tracks in a single project in Audacity. This helps you
combine mure than one audio file and you can also adjust the volume of each track

|l'|'l'JJ"I|"il‘-|'l.I.:I||1lr.
LXFORD
b L s T E HEI .
O T H ‘oo
¥ & OE B annnne i Ee = = - e e - "'-'.j



Thee slligat iR

1, € hee puevajins | wdaisps ¥ b alteaily reor darebine] o b b,

2 [ FTRLE] vered iy san varid | Trae I.:__ i b b
aiitiarrnit bbby o eyt atuil pew oy

M- Roire varel Vajitiron apanre, Dot o Bt o new track watll b
I'I'!illr" webll daurt Teewn thyrs Frrseirmneng iy S,

Yo 1 an bear the
quinm recording .,
wiald aares por are iy (e
s fareil 0k,

This typae ol reconding
js wasedul i o

first track is an
instrument anil 1he
second track has
vocal recording.

1. “- jl'ﬂl.l weanif [ "'.-"I";'I""""'l ' ) '--'iT-I: :l-_'- N R —— : |
continue recording to "'-"-;-—-.-...::_.,T'._'::::"-. L A L |
the same track, hold : - =
down the Shift kisy Fig, 5.8 Recording a second track
E'"j ::;k “Efdﬂ_rd- ""?:; will natice that the recording is done an the same track. Click Slop
an recording will stop.

4. W you want 1o make a recording on a new track but star a1 the pesition where the first
recording ended, then Click the Skip to the End button on the Transport Toolbar.

This will mowve the =X = ' .
playhead 1o the end of :_;_._._.-_._:__ A p— " - - -
the clip. s a0
a. Click the Record o2 :::"'4 e —th—

button. —_— —
b. A new track will p—— | "

be automatically ~ e " M

created and the e ool i

recording will stari = ;

from the position T e

where the p1.a'!|fhEEIE| r::-“:'l tamts ;T::u.---?:ﬁ’-l?u::u- - ﬁ-::':l-.; ETTNE,

was (Fig, 5,95 P L L b T
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Click the Fit Project Fig. 5.9 Recording in two iracks

button to both the

tracks (Fig, 5.10
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Fig. 5.41 Using the Time Shift il

Fig. 5,10 Fit Project 100l

el

- If vou want to create a pause between
two recordings, then use the Time Shiit
tool. Click and drag the track to the right
Fig. 3,110,

=g

. To change the name of the track:
a. Click the drop-down menu arrow of the Audio Track aption and select Name... il 512,
b. The Track Name dialog box appears. Type the track name and click OK iFig. 5.1,

e S

Fig. 5.14 Selecting an audio file for the background
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Fig. 5.13 Track Name dialog box B A8 " L “'
] . i
Mining Narration with Bachground mMusic "!""":::_" " |
1. To import a background music file: I “
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im' a, Select File » Import»
o Audio,
Liignr
e The Select one or more
Caiaridn audio files.., dialog box
i appears (Fig, 5,14k
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the trawks,
For this, place the cursor

Figh 5.15 Music file added

Between the tracks aned then elick and drag the cursor 1o adjust the height of the tracks

(TR R

selecting a Range in fudio Files

Sametimes vou may hear unwanied sounds,
or you mighl want to wse only a portion of the
audics in your project and discard the rest. For
this youw have to first select the portion of the
audio you want 1o edit,

To make a selection vou need 1o use the
Selection tool and fallow the steps below:

1. Use the Zoom In button in the Edil 1oolbar
1o get a closer look at the waveform,

Click the Selection tool.

Click on the point from where you want 1o
starl the selection iFig 5.171.

d
-

Top Tip '

o can rake a look at the Selettion
toolbar ar the bottam of the Audacity
window to understand exactly where
your selection starts snd stops in terms
of hours, minutes and secands. i you

choase the End Selection option, it
shows the time where selection ends. If

you sefect the Length Selectlon option, it
shiows the actual lengeh of the selection.

.
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Fg. 517 Starting Selection

£
o 4. While holding down the SHIFT key, click to the right
where you want the piece o end iFig. 5.181,

O

Place the cursor over the edge of the selection until
you get the painting finger.

Then click and drag left or right o make the selection.
You can listen to the selection by pressing SPACE.
Press SPACE again when you want to stop playback.
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Deleting Portions of Audio

1. To delete everything except the selected
audio, click Edit » Remove Audio or FT
* Trim Audio (Fip. 5.191
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I: Fast Farward @

portion of an audio file;

artion 1o be copied.

ppy option from the Edit menu.

in from the Edit menu.

Copy Cerla €
Cur Cerl = %
Paste Ciell + ¥
Createacopy Corl+D
an new track

B track, press Cirl + D (Fig. 5.21).
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Fig. 521 Duplicated selection on a new track

Cut and Paste
To move the selected audio:

a. Select Edit » Remove Audio » Cul. This removes the selected audio and the rest of the
waveform jumps to the left to occupy the space where the cut portion was.

b. You can now paste the cut portion of the audio on the same track or in a different project by
using the Paste command.

nd["ﬂg Effects 'n{_-."";:":_ Trmped Tracks  Gevewis :‘*F
To add, say, the Fade In effect to the selected |7 ORI Pl
audio, choose Effect » Fade In (Fig 5221, g AR R A
decsthatanbe | E e e S
There are many other effects that can - = 1 =
applied. Also the same effect can be applied - i
multiple times, Sopyant
The menu also has an option to remove e
unwanted background noise. Noise removal e
has two steps. First, you will have 1o select il

a portion which is all noise. You welect this
part and drag it out. Then, choose Effect »
Moise Removal and click Get Noise Profile,
to make Audacity understand what is noise (Fig. 5.23). Now:

select that portion of the track. To remove noise
o track so that there is no specific selection,

Fig. 5.22 Effect menu

1. To remove noise from a specific portion,
from the entire track, click anywhere on th

2. Again, select Effect » Noise Removal. The Noise Removal dialog box reappears. Specify the
values for Noise Reduction, efc., select Remove and click OK.
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- B (e thewkemee SilEncing unwanted words
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e chck Gt Pt P el v Sometimes }'n_:-u mmay o
. [t o | helosmconsralhow  remove unsuitable sound and
e muchaudowilbe o0 wnrds from an audio file,
TEEIR W) an i THOLE -
Eirate i ingahigher  THE Steps are:
walse well rear more ;
! [ I — 0 of the udho at nowe. 1. Select the Fl'aﬂ D'F-Il'lE audip
. I ¥ If recording & not wery file you want to silence,
| - - racay, o nog charge

thar cebaule value 7. Select Generate & Silence,

| Ay e s 81 —0 The Silence Generator
| P sl Frequency smoothing dialog box appears
| X salue i (e 1o blengd 1alog Dox appe
e Lo | o Jfl o ercies copecher. [Fig. 5.241,
Fig. 5.23 Noise Remaoval dialog box e — (=]
e

[ fast Farwand @ | II

Selecr entire rack  Crrl 4+ A

The exact duration of the
sound is shown in the
dialog box. Click OK.

3. Notice the change in the
waveform in the selected
range (Fig. 5.25..

You can also insert a beep for the objectionable word in the audio file, The steps are:
1. Select the required part of the audio file.

Fig. 5.25 Flat line indicating no sound

—— ]
2. Select Generate » Tone. [ —— = __'_7|"
3. The Tone Generator dialog hox appears iFig. 5.20), QS
4. Specify the values for Wavelorm, Frequenc L and e
Amplitude and click OK. Y S h“ﬁ.{;ﬁ_:_lﬂ

Play the audio file, You will hear a beep in that portion,

Saving Projects
The steps to save a project are:
1. Select File » Save Project As ... (Fig. 5.27),

Fig. 5.26 Tone Generator dialog box
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Fig- 5.27 Save Project As .., option i
o File menu w A .|
B =
3, This will open the Save Project ..... As . Tewwin [l ast C
diaiog bax (Fig. 5.28). Fig, 5211 Save Project .o As dialog box
1. Enter the desired file name and click
Save. Audacity project files are saved in .aup format.
Euporting Audio Files Bt B |
An Audacity project can be opened in ARy UL o
Audacity only. If you want to apen the edited || | 5> iy B Ealu
file in other programs like Windows Media el e
Player, you need to export it. .
2
To expart the file, follow the steps below: v
1. Select File » Export. | B |
2. In the Export File dialog box that appears, E — e ——
enter the desired file name and select a | oot [ vt 10 P G
format in the Save as type: menu (Fig, 5290 | =
3. Click on Save. Fig. 5.29 Exporl File dialog box
PRACTICE TIME @T

The Music teacher af Class VIl has assgned Asjacd 1o mix any two songs of his chowe ina souind
editing software and explain the process r the entire class Hie wants to use Audacicy. Can you help

hirn with the process?

SOLUTION

1. Start Audacity.
1 Toopenan s file, select File® Open. The Open dialog box appears
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[ ] BE [~] - | AR
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3. Select the file, say, "Sleep Away' and
chek Open (Fig 530,

4. Toopen another audio fle, again
select File  Open. In the dialog
box select the file, say. “Maid with
the Flaxen Hair’

Motice that the fle opens ina new

window [Fig 5bY, To copy 2 portion

of the song "Yeep Away'

a  Usethe Zoom In button in the
Edit roolbar 1o ger a closer loak
at the waveform

b. Chck che Selection toal.

€. Click on the pont from where
you want to start the selecton.

d. While haldsng down the SHIFT
key, click to the nght where you
want the piece to end.

Or
Place the cursor over the edge
of the selectson unoil you get
the painting finger, Then click
and drag left of reght 1o make
the selection (Feg. 5cl.
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5 To paste the coped partion of the song Sleep Away' ar a certain poing in the sang 'Maid with

the Flaxen Hair’
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" Audacity is a popular editing software peedd for -+ Torstart a new project in Audacity, select
thting and recording digital audio, File & New.
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Audacity Edit » Preferences.
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You can drag and drop the file into the
Audacity window to open it.

The loudness of audio is directly propartional
to the waveform size.

The duration of the audio can be measured
in minutes and seconds wsing the ruler above
the waveform,

To listen to the imported audio, click the
Play buttan of the Transport Toolbar. To stop
the playback, click the Stop button,

In a mono file, there is only single channel and
identical audio can be heard in bath the left
and right side.

In a stereo file, there are two channels — left
and right channels,

Objective Type Questions

1. Choose the correct oplion.

Vou can record or import multiple tracks in
single project in Audacity.

You can use the Zoom In button in the Ediy
Toolbar to get a closer look at the wavelanm
Yaou ean listen to the selection by pressing
SPACE. Prese SPACE again when you want i
stop playback.

Yo can remove of reduce unwanted backpmyey
noise from an audio file in Audacity.

An Audacity project can be opened in
Audacity only.

If you want to open the edited file in ather
programs like Windows Media Player, you
need to export it,

To export a file, select File & Export.

a. Which of the following audio file formats can be opened in Audacity!

i WAV il. AIF iii. MP3 iv. all of these
b. You can listen 1o the selected audio by pressing the .......oocvee KBY
i. Spacebar i. Backspace iii. Tab iv, none of these
e. Tocreate a copy of the selected audio on a new track, press
i. Shift+D i, Cirl+ D iil. Alt+D iv, nome of these
d. The Moise Removal option s available inthe ._................. menu,
. Effect il. File ii, View iv. none of thete
e. To select the entire track, press
i, Cirl + A il, Shift + A ith, Alt +A iv. none of these
<LORD N B O B 98 :
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i The Audacity project files are saved in the |

................. fosrimal.
i, audo . aup iil. .auda iv, none of these
o wwhich of the following options are available in the File menu?
i lmpon il. Trim Audio fii. Cinl iv. nione ol these
h The kevboard shartcud for the Paste oftion is
i Cirl + C ii. Crl 4V i, Crel + X% iv. mone of these

pescriptive Type Questions

aneaer The following.

5. How can vou Creale 2 copy of the selected audio on the same track

h. Lat the steps to export an gudio file so that it can be opened in a program like Windows Media
Plaver.

¢. What are the default values for the Default Sample Rate and the Default Sample Format?
g List the different audio file formats that can be opened in Audacity.

e, How can the duration of an audio be measured?

L. Mention two ways in which you can play an audio,

g Can you change the name of a track? How?

. How can you import a music file as a background?

. Asad has downloaded Audacity on to his computer to listen 1o music. Unfortunately, he is unaware
of the: file formats that are supported by this software peogramene, List the difierent formats that
tzn be played on Audacity and give their properties. Do you think it is important for there 1o be
restrictinns on how this software can be used? Why is it impostant for *“free, open source” software to
be available 1o use? Do you think it is actually free!

| Saleem is working on a documentary about different kinds of birds and their sounds. How will the
fallowing options in Audacity help with this fascinating and informative documentary? What athes
properties could be used? Why?

* mixing narration with background music
* having multiple tracks in one project
* adding effects such as “Fade in' and the silence generator

Create a recording of the national anthem in Audacity using both musical and vocal tracks. Make sure
st you filter sut any unwanted noise in your recording.
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Application-Based Questions

4. Name the toolbars macked in the « Audacity window e e VR e |
below, o
By e i = ——
'hﬁ-i‘hmmn_-d_l-_ﬁ_ ﬂ '
1 FLi e
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b. Observe the following toolbar and answer the questions:

1 'Erﬁ T i. Name the toolbar shown in the figure.
K|, ii. Identify the tools marked (i.) and (ji.) in the figue

¢. Ohserve the following dialog box and answer the given questions:

Frwesmcat: Qrakity

reri
Magas
Raimrlry
G L. Mame the menu and the option
E.ﬂ._n:: o get this dialog box.
onen ii. What is the default value of the
m DEfﬁIJH sﬂﬂplﬂ Rate!

g iii. What is the default value of the

. :—_i Default Sample Format?




. Observe the following audio tracks in the Audacily whnlew and answer thae questions below.

| Which of the two tracks is 4 mone fike
e which 18 stereo filed

wWhat is the difference belween a mona
anel a stereo audio file?

T s i e S S
IN THE LAB ST ——

1. Ermact loves singing. He has decided 1o recard his song In Al-l-dﬂ-ﬂil','f'- Hi alre,,}dlrl has an audio file
with |h-:_ Inﬂryn'!enlal for that seng. Help him import this audio file and then record the song in his
awn voice. List in your notebook the steps needed 1o complete the task.

2. Yeshal and her friends have to give a presentation in their English class, Before the actual
presentation, they have decided to rehearse and record the presentation in Audacity, Help them
with the steps to complete this task,

3. Kamran has to make a presentation. He wants o insert a portion of a song as background music,
How can he get the required portion extracted from the full sangt

4, Ishayg doesn't know the difference between a mono file and a stereo file. Impon two different audio
filet—one mono and one stereo—to show the difference. Take a screenshat of the windows and
paste them in your notebook with appropriate captions.

GROUP PROJECT

Yeu now have some experience of using Audacity, but there are other different open source digital
audio editors available on the Internet such as ocenaudio, hya-wave, wavepad, twisted wave, and
wavosaur, What are the dangers of using open-source programmes?

Explore these different audio editors and create a list of requirements you expect to find in each
programme and then compare your findings. Do they all have the same basic features and functions?
What makes one programme more effective than another? List and compare their respective features,
antl then give a recommendation on the best audio editor.

Present your ﬂndings in the most appropriate way (o your class. This may be creating a PowerPoint
using hyperlinks or you might create a few linked web pages. Learn from your fellow students; they may
present thedr findings in a very different way 1o yours,

C
T 5 TEACHER'S NOTES
* Explain 1o the students the possible uses of the Audacity softeare,

* Demonstrate how bo downioad this software from the site hipYaudachty sourceforge. net
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b GO B BT Fve Clips?

You may have shot videos of your birthday party or of
vour summer holiday trip. Have yvou had a chance to make E—-__—_.———*—-u""ﬁ
them more interesting by adding. sav, background music, a In this Chapter |

commentary, or some other interesting elements or effects to
it? You have learnt in chapter 5 how to edit sound (or audio) = Harting Liphtwarks

filess. In this chapter we will leam how to edit both vides and : :'Lr'""""? pea
L s Blasic Edining
sound files. T
sound « Trimnming an theTimelnes:

= Tramsition Fiiects
. "n'-.’r.:ll:irq_r. with ALdao
= Enporring bles

There are a number of interesting software options for video

editing. Out of these Lightworks is a very popular one. It has
bath a free version and a projessional one. Please download
the free version to get familiar with the editing interface. Lightworks has a minimum set of
tools so that students focus more on leaming the art of editing videos. Some of the famous
mewies that have been edited using Lightworks are Braveheart, Mission Impossible, Bruce
Almighty. The Wolf of Wall Street. etc.
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STARTING LIGHTWORKS
LIGHTWIIRKS

Once vou have downloaded Lightworks, follow the steps i
aiven below 1o open the soffware:

Double -:_L.I.I.L thir llghl'l.'- orks icon on the [|f_-£.km[:, You will Fig. 6.1 lighlwmln T
spe the Llp,lﬂh-ﬂrlﬁ |L:|.1I'.‘|i|1_|_1I sCroan as shown in 1 lpure .1,

The Lightworks application apens displaying the Projects Browser window (Fig. .2.

Eaa SRR

Type the name of the project [ .
avatn u mewy prject Create Hew FrﬂjE ct

To create a new project, do the following:
1. Click the Name text box and type a name
for your project.

2. Select the frame rate from the Frame rate
drop-down list.

Click the Create button. After clicking this
button, Lightwarks switches from the Projects
Browser window to the Project View screen
i ri_[_ll. B6.1)

Fig. 6.2 Projects Browser window Bid you Know?

A movie i actially mads
- up of an encamous number
Shrink buiten of still images, but gives us an
illusion of motion by showing
these images in apid sequence.
The numnber of images that
are run of photographed per
second i neferred to 25 the
frame rate of the movie and
| e i measured in frames per
second (fps). It shows both the
speed of recarding as well as
playback.

{f you da not know the
frame rare, selecr Auto.
Lightwoais will detérmane the

Clase bunon |

Clck Places

diop-down

g @O

frame rate far you.
Fig. 6.3 Project View
103 " CXFORTY
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PROJECT UiEw

- HW = h‘ﬂ
Project View sives vou all the options required for — e =
EGILINg or making a video, m
On the top left corner, vou will see the menu bar Fig. 6.4 Mtenu bar of Project Vie,

a. Click the name of the project in the top left comes to see the current project details, |

b. You are now in 2 room for the aroject. A project may have one oOf ::_ure rooms. By defzyy,
rew roam has 3 numbered name, for example, Room #1. You can cngnge the name
b clicking the room name, tvping the name you want, and then pressing Enter fo saue
the name.
A room iz where vou play and edit vour files. You can create several ro0ms 107 3 project. s,
ane for the editor, ane for the director, etc. Each room may have some or all of the projec:
companents which are placed in windows.
While creating a film vou may be working with many windows. You can set up 2l the
windows in one room and assign an appropriate room name. This arrangement maxes
it easv to switch between windows while editing a video. Here we will work in only
One rooMm.

c. If vou wish to return to the Projects Browser, click the Exit Project button at the top feft of
the screen,

At the top right comer, we see two Recard I cpens e Record oo o recors o rew oo
burtons [EER == 3. The black
one is the Shrink button which minimizes
the Lighoworks application to the task

bar, and the red one is the Close button,

I & oo che Selert Files to Import 2 205 20w
Edir 17 cpems oo wiewer anc cimeedine (o7 3 rEe =20

Search [ coems o wEarch cogs

which ends the Lightworks session. Bin - cpens 2 e bin

The toolbar provides quick access to Rack &= cpeis a new rack

zeverzl tools you would use during vour Playour 2 ooy rhe Playnet tool for playing am 22t
recording and editing process Fiz. B35, e et s

It is displayed by default in the Project

Ediens Preferences | rhe Editar Prefersnces -2 050
View. g -

_ Fig. 6.5 The Toolbar
importing media files

i i f files into =

1. To import a file or a group o . 'E'SE g ‘=

vour project, click the Import icon ~¥
on the toolbar, The Select Files to Import Video files with the extension AV, MOV, MXF.

dialog box appears (Fig. 6.6.. MPG, and MPEG can be impaorted inte Lightwarks

b RO L
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- Tap Tip =y

If the frame rate of the file being
imported into the project i not
compatible with the project, it i
highlighted in red (o denote that you
catnat import it into the projpect.

You can akso import files in
barched Right-click the Import icon
and select Batch Import.... The
Batch Import diatog box opens, Click
Add Files. The Select files to import
dialog box appears. Choose your files,
click Start, and click Import

Fig. 6.6 Select the files to irmport to proyject

P

. Click on Places at the top-left comer of the dialog box, From the menu that opens, navigate
to the directory containing the files you wish to import.

3. Select the files you wish to import into your project in the Select files to import dialog
box that opens. The Name, Format, Rale, Size, and Date of each clip is displayed here
(Fig. 6.6). Make sure that the frame rate of the file is compatible with the project frame rate.

4. Click Import. A panel reporting the
progress of the import process is displayed
'FI:|': E.7 1.

When the import finishes, a bin named
Imports opens, containing all the files you
have imported (Fig. 6.8),

A bin is a place where you put your audio and
video clips that you want to use in making
vour movie. It helps in organizing your work,

Fig. 6.7 Import pane!

(" oid you Enow? E

By defaile, Lightwarks shows all
of your bin contents as thumbnalls

You can change this o a s view by
iclicicing on the Hin

. Wiew icon at the pop-
Fig. b.4 Imparts bin mglt eorner of you
birt and selecting lise
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Organizing Your Project

many bins wogether inoa rack

Thus, a rack may consist of many related bins, and each bin in a rack would have files of one

Bins

" = i .-- s
To create a new bin, click the I]m icon on the toolbar (Fip. 6.5

This apens the bin. Let us continue with
the default name of the bin, i.e., Binl. Drag
the tiles in the Imports dialog box to Binl
Figt. b.50, Similarly you can create a second
in which can contain the audio files
Fiis. G, 130,

kil
— limj

Top Tip ,
- '-’

There are many other ways of creating a new
bin. You can click Search and enter a criceria to
create a bin of files fulfilling that criteria, You . n =
can click a file and then select 'Make Bin of clip Figg. 6.9 Drag tiles irom Fig. 6.10 q“ﬂ_ with
reference’ or you can click the Cogs icon on an Imports the rmusic Hles

existing bin and select 'Make a Bin'
| 0id you Knows? ﬂ

Rach o ) You can chick the cogs icon on a bin
A rack can be taken as a filing cabinet that you use 1o or a rack and select the Permanence x5
store your hins. A rack has the following properties: Permanent to make a permanent bin or

; rack. The option for a bin is shown here
* It can contain up to 15 bins, The default option is Transient.

= |t can be closed to save space on the screen,

To creale a new rack;

1. Click on the Rack icon E on the Toolbar (Fig. 6.5).

; i you delete a transient bin or rack
2. A new rack opens. To rename the rack, left-click on ; tediekat

it simply disappears, However, when you

the title bar and I!"TJ[' 1|'IE new rack name. delete 3 permanent bin or rack in 3 project
a message bax opens asking you to confirm
Bins Inside a Rack whether you acrually want to delete it

To place a hin inside a rack, do the following:
1. If the hin is still open, click on the Shrink button 1o close it (Fip. 6.11),

2. Lefi-click on the closed bin and drag it onto the rack (Fips. 6,12 and 6.13),

DX TFLOREY
BRI IT rEn A iz n -i u ]uE
H & E EEEE & ki gl
" EEEE @ - "



: -
Piges 0 00 & Bimas Bl Phis 6,12 in) TLREY
ORI

Fig. .08 Bind placed

1o o chenngaes e ordber inowhicly Lok

Canre dhisad vl | e fbeeliede » i
i Bl e AR s i g sy in the rack, beft-click and hele the title bar

el position,

A, Tovopens a by click an the Er‘ilnrnl; batton on the ln's title bar.

1 ¥ I 1 d 1 "
G, Tov close e bin anel stuen 1t 1o the rack, click the Shrink button as discussed in step 1
Matghnch
e chips sour buwee impertioe] wiouled

AL k% Eibiess din 1w hl“_. in 1hyis Case,
i B (g, e 14,

I, Click amywhiere In e picture area
o o Bilee ton sedect i, The boreler of
that particular tile will change 1o FE: 6.1 The: Inpoctst ciiw iy Hinl
Larigght Babuee,

Fast Fonward

Mo, vither use the Play button on the console, or press the

spacehar, for play £ pause.
i ity Play a clip L

Plagjing in o Viewer
Tev open o 0le in o viewer, do any of the following:

1. I you hover your mouse over the tile or clip, a woolbar will appear on the right. Click the
Viewer icon in the toolbar (Fig. 601501l

2. This will also reveal the scrub bar [Fig. 615001, Click the red marker and hold and drag
e marker 1o move backward or forward through the clip [Fig, 6.150h),

Scrub bar
Fg, i 1540 Viewer icon and the Scrub bar Fig- 6 15(h) Red marker position moved
O
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40 Double-clicking a tile will also
open the selected clip in the viewer
(F g b, L),
The name of the clip appears at the top-
left corner of the viewer,

4. I vou wish to jump to a new point,
left-right click the mouse button (very
quickly press first the left mouse button
and then the right mouse button) at the
position you want to jump to.

3. You can also lock the viewer an the Fig. 6.16 Clip in the viewer
screen. Click the Pin button at the top
right corner (Fig. 6.16). Clicking the Pin “op Tip it ]

button again will unlock the viewer.

6. Todisplavaf i ideo. To resize the viewer, click on any edge of
o display a full size video, press the F12 ché viesietaid dhag I THE Va6 o e viewer

key, The viewer displays the clip full screen, displayed at the top left corner while you drag it

marking a Selection

For many editing operations, you need to select a length of the source clip. You can do this
b marking the In point and the Oult point on the clip. This process is called mark and park
in Lightworks.

IMG_Ornr
First let us understand what the

various buttons on the console

\Fig. 6.171 help us do. Refer Table 6.1
for an explanation. Now let us select
a portion of the clip using the mark
and park procedure.

To mark and park do the following;

1. Position the frame marker where you
want the clip 1o begin.

Bl

. Press the “In" mark button on the
console. A blue marker comes up
belonw the current frame red marker.

& =% 40 & R B BRS W
Fig. 6.17 Console buttons and selecting part of a clip

3. Now move the current frame red
marker 1o where you want the clip to end.

4. The portion between the blue marker and the current red frame marker is now selected and
appears in white as in Fig, .17 given above.
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Table 6,1 Console butions and their actions

Button Action Keyboard shortcul |

| ump backward | 2

2 O frame back ar back amow key !

j Playv/Pause I Spacehar

| Cine frame forward | o forvward arrow hiry |

3 fump forvward 5

b . A an ‘In° miark to the curment position i |
_L'.' lear all marks - 1] 3 |

& ___-5--::'[I an ‘out’ mark to the I_'L!rrEIE-;}:JE;II : | o |

4 Replace into the target edi b

10 nsert inta the |4'|r;!_fl'_:l_l.‘I:||I '~_ !

BASIC EDITING

Basic editing involves four common fun tions—Replace, Insert, Delete, and Remove,
The Replace and Insert functions are used to include pictures and sound into the file being edited.

The Delete and Remove functions are used to get pictures and sound out of the file being edited.
Let us first learn how to replace a portion of a clip.

Replace in Edit

1. Click the Edit icon E on the
Toalbar.

2. An empty edit viewer and Timeline ;_I;::::.:‘:_,L,
open on the screen. You can assign
a new name to the edit. The edil
viewer has a red border as can be
SEEN In Figure b.148,

). Select a file by double-clicking its tile
in Bin1.

4. The clip loads into the source viewer.
Motice that it has a blue border.

Fin the edit viewer, source ches e Fig. 6.18 Empty edit viewer and Timeline
and timeline (Fie. 6,191 The pin

icon when clicked will pin or lock the position of that window. You cannot move the
window after pinning it. However, you can still resize the window,
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f.

mailoed by a
blue honder

. Using the mark and park

procedure, mark the In and Oul
points in the clip and click on
Replace. The marked section
goes into the timeline (Fig. 6200

Pk che
FOUFEE ViEWET

ilarkesl wccomiin
i Thmaline

Double-click anather tile, Mow
the source viewer contains the
second clip. Again mark the In
and Out points in the clip using
the mark and park procedure and
click Replace.

The second clip joins the first clip in

Lhets coedit (Figi.

OXIORD
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Fig. .21 The secand clip joins the first clip
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e Gmurlatiy. YERE AR

ailel flobied o gy

Y o an
achd amy BT o
bl Netice tha
i the timeline vach
clip has dhifierem
Colour which is very
|'I|_'.|"||.|| while !'i|||i|'|lr: a
eI F 6% Thmelins Wi i

Before wie move further, |of Us reviewy the fungtion butlons o w50

Fig. .23 Function buttons on e console
%ph:u gm0 ; Ao Drelete

,_:,E,:IJ. 118 T LR Tigde bl e T

IBsart in Edit

The Insert command helps you add a new « lip within a clip.

b Ering the painter in the

1 ':_|l||_-||'||;|-,- II-I:l i rh“
.|.:|-| [= ||‘_"|.'|'I:'r ﬂ“lj n.l”li. ————— e T e

= g3 iriiren ol wanl

Timeline to where you want to insert the new clip

wsing the mark and F'IE*'I'L
PG s Lipis

3. Clic Insert. The new

AR e ||I| 15 I'I"\-'l.'rll':l SRR

e mark iFip. 1524,

Fig, (.24 Timedioe shionwing mew poedion inseried
Fit .l
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Delete in fdit
Mark the start and end point in the Timeline you wish to delete and click Delete (1 g, 635,

The selected clip is deleted iFig. 6 ¢,

Size of thie chp had redrpg

Fig. 6.26 Marked section deleted

Fig. 525 Mark the clip to be deleted

Remove in Edit

There are two options in Lightworks to take out a portion of a clip: Remove and Delete. The
difference is that Delete takes out both the audio and the video portions of the clip, while
Remove takes out either the audio or the video portion of the clip depending on your selection

1. Deselect the video if you want to remove sound.
Cir
Deselect the avdio if you want 1o remove the
1.'”’EI'J.
Here, the audio part has been deselected.

2. Click Remove iFig, 6.27), You will see that a
part of the video has heen taken out,

Fip. 6.27 Selected video portion rEmoved

TRIMMING ON THE TIMELINE

The Timeline provides a simple view of a clip or edit, To trim is to make adjustments to the
tming of culs,

You do this by opening or unjoining the cuts so that when you play the edit, you can move e
posifion of the cut. When you are tone, you rejoin the cuts.

There are three different ways in which you can trim a clip:

1. To trim the incoming and outgoing clips at the same time, left-click a cut in the middle.

a. The viewer changes 1o the Trim viewer, :stpl;t}-ing bath sides of the cut (Fig. 6.28 The
clips curl on both sides of the cut,
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Lid

p, Maying, forward lengiheny 1hy,
oty side ane shoreng (he
incoming, Sk,

playing backward shorens fhe
gulgoing sicle and hnﬁ-!.lh{'l'li-
the incoming side,

To trim an oulgoing clip,
click close 1o the left of a cuw

ST . L |
|_! 1 [ -

. The cul is unjoined on the
oulgoing side.

h. You can now shorten or
lengthen the portion with
the curl. Playing forward
lengthens the oulgoing
Sl

c. Playing backward
shartens the oulgoing
side, The clip on the other
side of the cut does nof
change.

To trim an incoming clip,
click close 1o the right of
« CUL. =S .F_——I_—_—_—_—-——F-l_ll—l-.q.

a. The cut is unjoined on the

L]

.-.-—r—--l:mim'."—"" - paash

'rni'r:ming side, It adeds a
srmadl cul just after the cult J Incoming
| ; el el
it e, 600,
b. You can now sharten or Fip. 6,30 Trim an incoming clip
leenpthsen the portion with
this curl,
ftspwarel shortens the incoming sicdde, while pla ying hackward

As I8 the case-above, |:|.1'|.-i-"|'r',
The clip on the other side of the cut does not change.

lenpthens (he incoming side
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Slip & Shot

Ta slip a shot means to increase or decrease the duration of the fiest clip, without changing y,
duration of the middle clip. This changes the duration of the edit, B

To slip a shot, do the following;

1. Plﬂcﬂ [h;E- MmoLSeE p":l-il"ll:l';"l' to thE‘ MA‘:'

|Efr[ |:|Il [hl'."‘ cul and ||"|_-|:1n click " - — ._I__:,::_Fm mm__
1.hE rE'“ MoLiss hU“ﬂ-I’l Elrll!_'l th_ - g iy

V' key. This unjoins the head : L
and tail of the shot (Fig, 6,31). -
2. Playing forward slips the o -

middle clip so it begins and
ends later,

Fig. 6.31 Unjoined head and tail of the sho|

3. Playing backward slips the middle clip <o it begins and ends earlier.

Meither of the actions changes the middle clip’s duration but the total duration of the
sequence changes.

Slide a Shot

To slide a shot means 1o increase or decrease the firs clip at its tail and to shorten or lengthes
the third clip at its head.

1. Toslide a shot, place the
mouse pointer to the left of
the cut and then click the left
mouse button and the ‘T key.
This unjoins the tail of the
previous shot and the head of ;
the next shot iFig. 6.32). s

2. Playing forward slides the Fig. 6.32 Unjoined 1ail of previous shot and head of next
middle clip so that it starts later

in the sequence. The first clip is extended at its tail and the third clip is shortened at its head

3. Playing backward slides the middle clip so that it starts earlier in the sequence. The first CF
is shortened at its tail and the third clip is extended at its head,

The total duration of the sequence does not cha nge.
After you finish trimming, click Join to close all trims,
OXFORD
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TRANSITION EFFECTS

LY rraﬂﬂﬂlrl‘n I'_lII &f Is 3 S| . r{“ I

that can he adced 1o a cl; iP. To add

. effect, do the follow ing:

1. Click the place where v, Wwant fo
add the eftect (Fig. 6,33,

2. Click the Effects button

1 The Add Effects thalog boy

Fig- 6.33 Click the place to add a special effect
Opens tFeg. 3,34

« 2elect the Category,

kil 1 st

3. Selert Apply to as Current Clip.

b. Click Add,

Lo A h Bl SCrean - ||]I__||a iIrs-(Fip. A.151. ':-ra et the r'l"pf' |.'|I'Id
click the Cloge b Mittom,

i

5, The Add Eifects di alog bo

appears again, Now, click
the Close hutton,

Fig. 6.34 Add Effects

Fig. 6.35 Type selection screen
dialog box

WORKING WITH ALDID

While wnrkmg with audio you can display the awdio waveforms,
Manlally boost or lower the sound level Is, and also add soundtracks
‘L ipecific positions,

“lin Waveformg

Pdisplay the audio waveforms, do the following:

1 g . s
Click the Cogs E! icon on the Timeline.

|
'-'“I rhe T lick on Show audio waveforms
Fi . 1eny thal opens, cli Fig. 6.36 Cogs men

| U'.'i:_‘fll'.}fl._l_:l
\ 15 pg = :
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3. Audio wavelorms are
displayed in the audio
tracks (Fig. (.37].

4. To see the waveforms more
clearly, resize the timeline
(right-click the bottom edge
and drag it down),

5. To Manially boost or lower
the audio level of a clip, do
one of the following:

a. Mark the |',|r_1r|:i:}n in
the clip and type the

dB level you want for 7 mnmmm-

that portion (Fig. 6.38) PSRN L M [ B
(it can be positive or
negative], If the fields
are not visibie, click the
Advanced button.

Lr

b. Right-click the audio
track and mark it.
Position the mouse
over the audio track
and drag the mouse 1o
raise ar lower the level

Fig. 6.38 Specify dB level

(Fig. 6, 349). :
Fig, 6.39 Raise or loweer the level by dragging the moise

Mote: The audin levels set apply only to the individual « lips within the edit,

Add a Sound Track

1. Click the Cogs icon and select Add Tracks in the menu
(Fig. 6.36), The Add Tracks dialog box appears. Change Type to
Audio. Click Add (Fig. 5.40).

2. Double-click the sound file to add to source viewer,

3. Mark the sound viewer, Fio. 6.40 Add Tracks
L

dialag box

Llal 116 :



4.

& Mark and park the edj
view where the sound

snd select the A2 track

Deselect the other tracke

prack is to be added
Fig Bb.41].

Flg. 641 Added wound track in A2

EHPORTING FILES

Once you have finished your edits You can expart the file to 3
desired location. To export a file do the following:

Drag thi Export icon m on the toolbar onto the edil
clip, tile or bin,

Or

Right-click on the edit, clip, tile or bin and from the menu
that opens, select Export,

The Exporl window opens (Fig. f.42)

. Select the destination drive for the exported media. Fig. 6,42 Export dialog box

Type the name of the exparted file.
Click Start.
A Status window opens, displaying the progress of your expart (Fig. 6.43)

After completion, a report displays in a Tasks Log window (Fig. 6441,

Fig. 6.43 Sinius wandow Fig. b.44 Tasks Log window

Euit Lightworks

To exit liE".llH'ﬂl'hi.. Or your F[ﬂii'l.'t, do the foll D'l-'-'il1|::"_

* To leave the application, click the Close button.

* To return to the Projects Browser, click the Exit Project icon,
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PRACTICE TIME [

saiacl oodebiared s sty recemthy | s cousin bas degondid somie videns el ol thie De by
edlebrations Tup s are shiswm b

Mowy S:HFI'I." WANES Lo joviny o 1lyese oo chips, ol At bon, il A ) asonmel sk 1o i
Lan you help Bim in this Lask !

SOLUTION

1. Double-click the Lightworks icon on the deskiop,
L In the Projects Brawser window, type the name of the project, Sekect the Frame rate s Autg

and click Create. This apens the Project View windon with Select Files to tmport diaky b

3 Cick on Places in the Select Files to Import dialop boo. From the memas thae opens, Mavigte
to the directony contaming the files you wish te import. Select the filefs) and click Import,

4, Tosaore the chips ina bany, click the Bin icon Dirag thee files i the Imperts dalog BOx ta the big
You can rename the bin, To make it permanent, click the Cogs icon and sekect Permanence 2
Permanent

3. Chick the Edit icon on the toalbar. An edit viewer and Timeline open

& Double-click a tile in the bin to load it anto the source viewer: Thie chp has a blue border, Yoy
may pin the source viewer, edit viewer, and Timeline

7. Mark the source viewer using the mark and park procedure and click the Replace button

& Double-chck another tile in the bin to lsad it ente the source viewer, Mark the SOUrce viewer
using the mark and park procedure and cick the Replace burion.

9. Samilarly, add other elips,

10. To add a transiton effect, click on the Timeline where you wane to add the rranstion effect
& Chick the Effects button The Add Effects dizlog box appears.
b. Select the Category and Apply to as Current Clip. Click Add
© Another screen appears Select the Type and click Close. Alwo click the Close burton of the
Add Effects dialog box
11, Toadd a sound mrack. do the following
a Click the Cogs icon on the Timeline and select Add Tracks The Add Trachs dalog box
appears
b. Change Type 10 Audio and click Add
€. Double-chck the scund file in the bin 10 add o the source viewer
d Mark the source viewer,

OXFORD 118



& Deselect lf tlye
|, Mark and ”.;Im el ket the A2 track whee the sined track will be aded.
I Park the Edic View where the sound erack i o be added

¥ ag sorme
f: % l.r;'m places, o Wit 1o change the volame of the dudio track right-chck on i
' P the nightmaosy Btton Pressed, and drag a1 up or down.
12. Te export the fe, do the fellawing:
2. Drag the Export icon o, the Toolb
b. Select the destination dfrve Type

13 Toewt Lightworks, dici the Close b

ar to the edit viewer, The Export dizlog box appears

he name of the expormed file and cick Start
ulron

e EE

Cip 2 mn.tinumrs- recording of picture or sound ~— Trim o make adjustments 1o the timing of your
Room 2 window where you play and edit vour filas culs
Bin asort of box where you put your audio and  Slip aShet  to increase or decrease the

video clips that you want to use or edit in duration of the first clip, without changing
making your movie the duration of the middle clip
Rack a comtainer or a type of filing cabinet for a1l Slide a Shot 10 increase or decrease the first
the bins making up your project clip a1 its tail and 1o shorten or lengthen the
Timeline a bar that gives a simple view of a clip third clip at its head
or edit, allows you to mark positions on your Transition effect It is a special effect that can
clip, and provides you information on the be added to a clip,
duraticin of your clip

_ Memory BULESH i 3

* Lightworks is one of the popular software used  » You can play a clip in a file or in a viewer.

for video editing. = The mark and park procedure is used 1o mark
* The Toolbar in Project View provides access the portion of the clip you want to edit,
o several tools you use during your recording — »  Basic editing involves four functions—Replace,
and editing process. Insert, Delete and Remove,
* There are two ways 1o import files—Import i« You can unjoin the cuts in three places—

Project View and Batch Import. in the middle, an the incoming side, or on the

* Bins and racks are additional tools you can use  Oulgaing side.
I erganise and waork with your material, You can add transition effects 1o a clip.

OXF
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* There are two ways to Manially boost o lower

s You can add a sound track to a clip

the audio leval of 2 clip—type the dB level in -+~ «  You can export the file you have Eﬂil“-‘ﬂlnﬂh
the relevant fields, or use the mouse 1o drag desired location using the Export togl,
the saund level in order to raise or lower it

B
Objective Type Questions

Wrile T for the true statement and F for the false one. Correct the false siatement(s),
. The Edil Viewer has 3 blue border. l:
b. To see the wave forms mare clearly, resize the timeline by right-clicking the B

bottom edge and dragging it down. | :l
€. To resize the viewer, click on any edge and drag it, |__-
d. The selected partion of the clip appears in red. [__|
e. The Replace and Insert functions are used to get pictures and sound out of the edit, |___J

Choose the correct aplion,

JI

Which one is nat true about a rack?

i. It can contain up 1o 15 items. i, It can be closed to save space on the screen,
iii. You can drag the closed bin to the rack. v, all of these

The basic ediling functions are

. Replace, Insen it. Delete, Remove i, Combine, Split v, bath i, and ii.
Clicking the Edit icon on the Toolbar will open the

i. Edil viewer ii. Timeline iii. Source viewer iv. both i, and ii,

Il you double-click a tile, it will open the

. Clip in the source viewer H. Clip in the edit viewer

ii. Clip in the Timeline iv. all of these

Which one is true about Remove in edit!

i. Deselect the video if vou want to remove the audio.

i Deselect the audio if you want to remove the video,

lil. Select bath the audio and the video if you want to remeve hoth,
iv. All of the above

120 :
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pescriptive Type Questions

Angwer the t'u]hn'-.in:_:.

A
b.
[
d
2.
I

g
h.

what are the wo ways of iy

Hawling filis#
Iame Al e LA (LT LT il

A Ve il wiiicl wie cann e in Lightworks.

How will you croide 3 e |
gy o, aled o viden anie an suiio . lips, awnel ke 1t permanent!
Explat e mark ancl park procedurng g matking a «lips
! e B 4

How will you export the cdie] file 4, youur deskiog

ﬁh"“_‘-d 15 |'|.'|-,-||1H Iruu|||._. Organisin

u'_'-ll'l!.'l MO, r.:'ll.'L'_-. .'|r|.:| |1||'|': i o
Evaluate the usefulng : : ;
[|1I=-.:|l:_- 1 video albwoy II-: "[h slip a shat', and ‘shicde a shat” functions in making viteos,
% ¥ W sl s .
emall clips ﬂhu}L[ ol g ULTI‘"'F' of different family members and friends. To do this, first shoat
\; F ach individual, rn.LLinH sure they are happy for you 1o film them, Then use

Lightworks to edit and cregie 5 ¢ :
S : : a single video from the short clips. You can add a soundtrack to your
video if you like, : r uritod i

B his viden and audio clips in Lightworks. Share your analysis of
Bamise a project,

Application-Based Questions

.

e

i

= e

. Answer the following based on the figure given alongside:

Arswer the foliowing based on the figure give
. How will you create a new rack? |
. 15 Bim 0 shos

n abongside an the right:

nin the figure an open or a clased bint
itl. How will you add Binl w2 rack?

iv. How will you make the rack permanent?

Answer the following based on the
figure given on the right:

L How many clips have been
poined for editing!

ii. Is there any sound track added 1o
thee clip? If yes, whal is the name
of the sound track?

iit, What will yvou do to increase the
size of the sound track A2 so that
the sound waves are visible!

i. What does the white band in between the grey bands #
the batlom of the sowrce viewer meand
il, Mame the procedure used for marking the clip.
fil. Label the Replace and Insert buttons on the source
VIBWIET.

121 = OXFOILD
HiE [V} o L TR T
4 pEEE = B &
QS mEEwm BEE oo
[= LB 8 1 10 [ [ ] - —




=E

o, Amswer the following hased on the fpure: given oy

(e let:

i How will you mark the initial poimt (n poing)
the edit viewer!

i Lahel the Delete and Remove buttons in the
afil viewer.

e. Answer the following based on the figure given below.

.. i the fields to the rght of the
Timeline are not visible, what will
you dof

ii. How will you change the dB level
of sound (i} Manially and (il by
using a mouse!

iii. Which buttan will vou cleck
to add a transition effect to the
curent clip?

IN THE LAB

1. The Computer Club-Incharge has assigned Sameen to taki video clips of different sections af the
schaool like the labs, the swimming pool, the gym, the music section, the art roame, the badminion
court, the lawn tennis courd, the skating hall, etc. She then needs to use a video-editing software and
join all the clips to make a maovie

Can you make a similar movie of the facilities in your sc haol? Also write the steps to complete the
task described above,

2. The Computer Science teacher has given Rizwan thee task to add background music to the movie file
created in 1, above, Take the movie file you have crealed and add music io it. Also record the seps
you have followed 1o do the same.

1. The science teacher has asked the monitor of class VIH 1o add effects to the movie they have shal
while on a visit 1o 8 nature conservation park, for submission in a competition

Samnilarly, wisit 2 nature conservation park or 2 200 in yOUr area, shoatl a movie, and add s.|.rl:"-'i-1j

effects to it

GETORD .y s leg ‘
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P

ial Sceence teache: | .
The Socid oI5 a5
methods. dams, etc. PRCINg water harvesting systems, water conservation

ect of film similar clipg gn ! :
ﬁclipﬂn BNE OF your trips, and like Sheema make a mavie by including all

l"'-"EdE-D-dip5 of all th A g it

A had t it thi G & activities in the competition and make a
rﬂmﬂ:l;hmr:il:l:: this mowie file in a CD, Similarly, capture the activities during one of your
pyents i Movie and st i inaCDn vour class teacher.

| GROUP PROJECT

Having learned all the different commands and tools in Audacity and Lightworks, you could easily

creale @ comprehensive Blossary of all their important terms. How do vou decide which are the most
important terms to wsel

But better than that can you turn the glossary into a song or posm and set it to music? Or even create
your own video using all your new skills? Quite 2 challenge for you to work on together. It may take a
bit oftime. Think about how glossaries wark usually in alphabetical order. Can you create a cartoon
character 1o help guide your audience through your fist?

a
*4 TEACHER'S NOTES

* i would be useful 1o demonstrate all the steps required in creating a project in Lightworks, since the
software is being taken up for the first time. The versicn described hore is 11.5.

* The iree version of Lightworks may be downloaded from hitpwww, lwks com/ » Product » Compare
Versions. | |

* Encourage a discussion on the other software available for video editing, and enquire whether any of
the students have tried out a video-editing soétware. _

" 1 may be ensured that students create a project in Lightworks to familiarize themselves with the software,

O
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Introduction to

A Photoshop CS3

O Totme! Sormetinies

I S the fedehianes ot Paind are &0
e TR mirwore can oy e ey
-.‘_.,'n." CEEWOr IOy e '|1|"':'.'l:|'.'i1|.;-.

Dl e e sorim?
other soffwaree wath mone
ok Togge!

Yis st e bave
Ceoacnple! We can ime P,
| feat ety dhravangs pog
4 gl Come 1T rol YU g
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e, ot
Pamir carigy e
e for counples
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R

You have worked with Microsoft Faint and drawn pictures

using it. Suppase you wish 10 change your drawing or edil Lt
a stored image. Can vou do that with Paint? Yes, you can, In this Chapter |
but Paint can help you draw or modify simple figures only. R
Professionals usually use Adobe Photoshop to finely edit *_5_.’..'i||"|;||"|';:'|i. Adobe Photashap
complex images and pholos, = SelectionTooli
» Warkingwith Images
Adobe Photoshop can be called a one-stop image editing + Painting Tools.
application thal can salve almost any problem that you face » Drawing Toots
with images. In this chapter, you will learn how to work with s Irmnstoming Objects

images using the tools available in Adobe Photoshop CS3.

STARTING ADDBE PHOTOSHOP
Let us see how to start Adobe Photoshop:

Select Start » All Programs » Adobe Design Premium CS3 » Adobe Photashop €53 to open the
Adobe Phatoshop window (Fig. 7.1),

ogow 124 -
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ﬂﬂl]hl’.' Fh{llﬂﬂ-hﬂﬂ Winﬂuw

Figure 7.1 shows the Adohe
Photoshop window with jis

L S —
components. Pl ol ¥~ — —— Ll
The main components E [P | eenie
of the Adobe Photoshop 2 - Rezoe
: - %) Dicraan
window are as follows: ® E
=+, S :
Title bar  Itis the topmost |7 i o
Ll
window, ™ i :
= | —
It contains the name of ?
the application with s ] S b 1
icon. It also contains the 2 fLT000 panel | Seatun b || image winciow |
Maximize, Minimize, and o
=
Close huttons, @ A
Menu bar It contains the Fig- 7.1 Adobe Photoshop €53 Window
main menu commands,
Options bar It is below the menu bar. It displays the (Tapiip 1=
different options that are available for the tools selected il
from the Tools panel, The Analysis menu in Phatoshop
€53 provides options that help you
Tools panel It contains the various tools available in wake aned record measurements.
Adobe Photoshop, We can mark, scale, or measure
kengiha with the help of this meny,

Image title bar It displays information about the image
opened in Photashog.

Image window It contains the image that is being ediled.

Status bar It is located at the bottom of every document window and displays information
such as current magnification, file size, elc,

Rulers They are present along the top and left side of the image. They help to position the
image precisely,

Adobe Photoshop Tools Panel
Let us now discuss the tools available in the Adobe Photoshop Tools panel iFig 7,2,

Rectangular Marquee Tool: To select part of an image

125 OXFORD
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Move Tool: To select and move images
Lasso Tool: To make a free selection as you go

Magic Wand Tool: For making selections {similar Colours at once,
for example]

Crop Tool: To crop images
Slice Tool: To create slices in an image
Retouching Tools: To correct images

Brush Toal: To draw freehand

Clone Stamp Tool: To select a source and copy it 1o another place
Eraser Tool: To erase an image or part of an image

Paint Bucket Tool: To fill with the foreground Colour

Blur Tool: To blur images

Dodge Toal: To lighten pixels in an image

Pen Tool: To create vector shapes

Horizontal Type Tool: To insert text in an image

Path Selection Tool: To select the active path

Rectangle Tool: To draw a rectangle or a square

Eyedropper Tool: To select a Colour

Hand Tool: To drag an image when you are in the “zoom in’ state

Zoom Tool; To zoom in and out

Using a Tool
To use any of the toals discussed above, do the following:

1. Click on the tool in the Tools panel.

A
Pl A 20N

8

?i!' Gl > <
o M

-

Fig. 7.2 Adobe

Photoshop Tools panel

2. If there is a small triangle at the tool's right bartom " {2 Lama Tocl
corner, hold down the mouse button to view the hidden I} ! Pehygenal Lama Tool
tools. Then click on the tool you want o select from the T Magnutic Lama Tool

submenu, For example, Figure 7.3 shows us the submenu

of the Lasso Tool,
OXFORD
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Fig. 7.3 Submenu of the Lasso Tool



1o ppen an EI'IiE“II[I File
St S G an L"EiEIiHH ﬁ[ﬂ (an
1, select File » Open, Ty, Open 4

3. Using the Look in option select gl ;
’ e location of the fil.
3. Click Open, thie file yvou want 1o open. Then, select the file,

lready sy image) |y fallewing the steps holow:

ﬂlﬂﬂ b AppRears,

To Create a New Filg

In order o create a new fijg, follow 1k o
steps given ::leluw: ® i ]
],SEIEEtFiEIHEw_ThEdem ‘b [P Optmm - -
appears (Fig. 7.4}, VB wlm : 'ﬁl
2. In the New dialng hﬂ.xl mlf the Weghn 117 - >
following: ! S - =
il Modw: @iimler = m§ *

* Name Assign a name 1o the file, By Rl v W— 1 e
default, P"‘IDTEE."IEH} names the files W Aol —_— - ! 81K
Untitled-1  Uintitled-2, eic. =_=—_—_—:;_-__

s Width and Height Enter the width Fig. 7.4 Creating a new fle

and height of the new file. You can choose the
points, or picas), The default unit is pixels,

* Resolution  Resolution is the number of pixels per inch that make up an image, At a
higher resalution, an image is sharper but its file size will aleg be bigger,

* Colour Mode This decides the number of Calours that can appear in the image. You can
choose from the given options (bitmap, grayscale, RGB Calour, CMYK Colowr).

* Background Contents You can choose from white, background Colour, and transparent,
3. Click OK. A new blank file opens on the screen.

required unit (pixels, inches, centimetres,

Saving a File
Alter you have finished working in Photoshop, you can ave your file as follows:

1. Select File » Save As to open the Save As dialog box.
2. Type the filename in the Filename text box,

" fast Farward
3. Click Save. | Ooen s e CTIL4 O
The default extension of a Photoshop file is psd. Mew file CTRL+ N

Save Asdialogbox  SHIFT + CTRL+ §
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Changing Background ang Foreground Colours

Photashop uses thy Foreground Color to paint fill and stoke sedechions. : Foregronacy,
The Backpround Color is used for pradient fill and for filling the: crascd _i ~,
areas of an image. The default foreground colour is black, You can ' 1:

change the loreground or hae kground colour using the Eye Dropper Tool 8
(also called the Colgr Picker].

uE"

To change the
1.

loregraund or background colour, the steps are:

Click the Foreground o Background colour selection box in the tools  Fig, 7.5
P-ﬂnEl (Flg. 7. 5%

: Cofour Fatid
(Fig. 7.6,

2. Drag the Colour slider,

The Color Picker dialog box appears P s o Sl __-_:L"ia
3. Click in the Color Field and choase I = |
a Colowr, $nd e e
4. Click OK, H o TN oy
T &En oy |
SELECTION TOOLS | e,
iy et G . .
In Adobe Photoshop, we can divide the — i ;
I " " - -
selection toals into two ma jar groups: Fig. 7.6 Colour Picker dialog bax

Marquee Tools and Lassa Tools.

=

marquee Tools (=%

Using Marquee Tools, you can select areas of an image in rectangular, square, elliptical, o
circular shapes. The steps for making a selection are;

1. Open the image.

—

=1 F 2
2, Click on the small black arrow at the Li) W [} Rectanguisr Marques Tool H
bottom right corner of the Marquee Tool | () Efiptical Margues Tool M
to open the submenu (Fig. 7.7). cxa Sngls Row Marques Teo!
3, Select the required Marguee Tool from § Sngle Cofumn Marques Tool
the list: ” |
Ig. £.7 Sub ' |
* Rectangular Marquee Tool: To select a ’ VDAL Mg Toc
rectangular area of an image.
* Elliptical Marquee Tool: To select an elliptical or circular ares of an image.
» Single Row Marquee Tool: To select a single row of one pixel width,
* Single Column Marquee Tool: To select a single column one pixel wide.
oxpoR0 128 ;
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place the MOUSE pointer an ha image and dr,
, ra rcler
gurrounds the area you have selecied Fip, 7 mE‘. around the area to select. A dashed bo

“

5-l"|-n:|q|] Aregy

(" Top Tip —] I'fr
—

—

T ke a sguane
welection wsing the
Rectangular Marquee Tool
ar a circular selection using
the Elliptical Marques
Tool, hold the SHIFT key
while making the selection.

fa) Rectangle seleclion (b} Elliptical selection
Fig. 7.8 Marquee Tools selection

lass0 Tools &~

The Lasso Tools are used 1o make free-hand selections in an image. Follow these steps to select
an area of an image with one of the Lasso Toals:

= E::'LEETEII::I

"I;‘,'.'FPnJ-_.-gmduunTﬂul L
@u-;n&mmhnl L

1. Open the image.
2. Click on the small black arrow at the bottom-right

corner af the Lasso Tool. _
3. Select the required tool from the list of available Fig. 7.9 Submenu of the Lasso Taol
tools (Fig. 7.9).
» Lasso Tool; To make free-form selections in the desired ﬁ
ha (" Top Tip L1,/ 8
. Shape -
* Polygonal Lasso Tool: To select polygonal areas by Before m:klr;lg ifs:l:lcm
clicking at different points. To close the selection i m"""“m’ il
hoeder, position the mouse pointer over the starting featurne blurs the edges by
: i hle-click the mouse. busilding a transition boundary
point and click or dou e ke
* Magnelic Lasso Tool: This tool sticks to the edges of the wirrounding pisels.
image, thus making the selection very easy. Ta close the
selection border, double-click the mouse.
4, Place the mouse pointer on the image and drag it around the area you want to select
(Fig. 7,100,
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Imeguiw
selecrion with
fLasso Toed

la) Lasso Tool (b) Magnetic Lasso Tool

Fig. 7.10 Lasso Tools sclecton

Magic Wand Tool R
The Magic Wand Tool is used to select adjacent areas of the same Colour in an image. You cap
use this tool by following the steps below:

1. Click the Magic Wand Tool. The shape of the mouse pointer changes,

4. In the options bar, you can specify the following;

= Tolerance: The higher the tolerance sefting
value, the wider the range of selected pixels. The
tolerance ranges from 0 to 255,

= Anti-alias; Defines a smooth edge.

* Contiguous: Selects only adjacent areas having
the same Colours, atherwise all pixels of the same
Colour in the entire image are selected.

* Sample All Layers: Selects only pixels from all
visible layers. If this option is not selected, Colours Fig. 7.11 Selections done with the
from the active layer alone are selected. Magic Wand Tool

3, Click on one part of the image. All the adjacent pixels with the same Colour get selocted

(Fig. 711}, The Magic Wand tool selects pixels based on Colour values. Thus, you can cul

out foreground objects from the background. This tool works best for selecting objects that

are primarily in one Colour, e.g., the sky, a flower, etc.

If an object has several Colours then you can hold down the SHIFT key and combine several

selections,

WORKING WITH IMAGES

While working with images, a part of an image can be moved, can be copied to another
location in the same image, or copied to some other image. Let us see how we can do that.
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aaving an Image

The Move Tool is used for moving an image
anather. The steps are;

~ Click on the Move Toad in the Tools panel.

. OF @ part of an image, from one location 10

L —

2. Place the mouse pointer aver the image or the selected part of the image (Fig, 7.12).
. Drag the mouse (0 move the selected part
without selecting any areg,

iad

o another location iFig. 7.1 31 If you do this
the entire image will move.

i
ate

Celecoed afas
heing moved

Fig. 7.12 Select the area to move Fig. 7.13 Selected area being moved

Copying Images

While working with images, we can copy a part of an image to another location on the same
image or to same other image.

Copying a Belection to the Same Image
The steps 10 copy part of an image to another location in the same image are:

1. Open the image. e —
Select an area using - -
the Marquee or the
Lasso Tool (Fig. 7.14).

2. Click an the Move
Tool in the Tools
panel.

3. With the ALT key
pressed, drag the
selection to another

location (Fige. 7.15), Fig. 7.14 Select the area to copy Fig- 7.15 The selected arca has
been copied

]31 = L a
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appears (g, 7o,

3. Click an a brush '.‘-I'!"ll' of your choice,

+ Ulick the arrow beside the Brush command in the Cptions hiar, The Brush Presel Picker

b. Click on Set foreground Colour in the Tools panel. The Colour Picker Paletle appears,
7. Choose the Colour you want from the Colour Picker Palette and click OK,

8. Click and drag the mouse pointe,

= S —
I-I."-""'"""-"l'l-lr-—.r—--l-',_
'r""':'ari:"-l'l-- ]
| ~—

i

= =
| g | g [ [

—— on the image to draw strokes of the

selected Colour iFig. 7.19),

Fig. 7.18 Hrush Preset Picker in the Options bar

Mote: The Brush Tool draws only in the
selected area. Nothing happens if you drag
the mouse pointer over the unselected part

of the image.

Gradient Tool [
A gradient Is a fill consisting of two or mare
Colours blending together. The Gradient
Tool is used to fill a selected area or an
entire layer with a gradient. The steps are:

1. Open an image.

2. Click the Gradient Tool in the Tools panel,

3. From the Options bar, select a Gradient
type from Linear, Radial, Angle,
Reflected, and Diamond (Fig. 7.20.

OXFORD
HE B & EENE B ©®© ©
EN EEE EEEE EEE BO

(" Top Tip

Fig. 7.19 Applying brush strokes

)
== .'..'
The Gradient Tool i behind the Palnt Bucket Tool,

If the Gradient Tool is not visible, click and hodd the
moiese aver the Paint Bucket Tool to reveal the tool,

Cradent cample Gradient nypes Slerned anea

'u—n—_fimu—“ ;
i 1 brags Las Geieet T Avslyin Vo Wiies  Filn
||J'||:' JIRlS 1. 1= - e ol |

+

Fig. 7.20 Gradienl Tool
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Fig. 7.21 Gradient Editor dialog box

ORAWING TOOLS

Adobe Photoshop has a collection of
drawing tools: Rectangle, Rounded

Reclangle, Ellipse, Polygon, Line,
Custom Shape, etc. To draw a shape,

say a rectangle, do the following;:

1. Click the Rectangle Tool in the
Tools panel.

2. Select the required taol from the list
of oplions (Fig. 7.23).

3. Click on the Set Foreground Colour
box in the Tools panel 1o get the
Colour Picker Palette, Choose the
fequited Colour.

+ Uick on Create new shape layer in
the Optians bar,

B. Drag and release the mouse in the image. The
selected area will be filled with the gradient
[Fip. 7.2,

Fig. 7.22 Cradient fill

Custom Shaps Toed  Creste new shape yer  Suyle pickes

-H-nmmu—.- e - il
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Fig. 7.24 Drawing shapes

1. Select the Custom Shape Tool,

2. Click the arrow beside the Shape option in
the Options bar and select the required shape

iFig. 7.25),

3. Click and drag the mouse to draw the shape.

TRANSFORMING DBJECTS

5. You can also click the arrow next to Style ang

choose a shape style.
Drag the mouse with the button pressed to dr,

the shape (Fig. 7-24).

6.

custom Shape Tool

Using the Custom Shape Tool, you can draw
shapes other than the basic geometric shapes,
This tool has a collection of predefined shapes
like flowers, mocn, arrows, leaves, etc. To draw 3
shape with the Custom Shape Tool, the steps are

I Aot Tt U1l Bt o B |
T e e et VA fespm e Wede Sy
E.‘.]'~'IEHD!-:I-.'I“EI-.J-‘:D*-.EHH"-IEE-JJ'-H.
n ] e by '_'E
ST b s Y TICIAY = -
A | R
2.7 o v SeEE |
11;:?':3 T

a2, (8}

g4 B

2.T.0e

Fig. 7.25 Custom Shape tool options

You can also scale, rotate, skew, distort, and apply a perspective to an image in Photoshop.

You can flip the image vertically or horizontally too.

The steps are:

1. Select the image, or the part of the image, you want to

transform {Fig 7.26).

2. Select Edit » Transform » Scale (or any other option).
3. Do one of the following according to the option you

chose in the Transform menu:

« Scale: When you position the mouse pointer over a
sizing handle, the pointer becomes a double arrow.
Drag a sizing handle to change the size. Press the
SHIFT key as vou drag a corner handle, if you want

to scale the image proportionally,

B st v ped 100 Loy 1, R [

R -

—d

L

e
Fig 7.26 Original image
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Rotate: When you place the mouse pointer over
a comer handie, it takes the shape of a curved,
two-sided arrow (Fig. 7.26), Click and drag the
handle to rotate the image (Fip 7,279,

Skew: Drag a side handle 1o skew the image.
Distort: Drrag a corner handle to stretch the
image.

Perspective; Drag a corner handle to apply a
perspective to the image,

Fip Horizontally: Flips the image harizontally
iFig- 727,

Flip Vertically: Flips the image vertically.

4, Press the Enter key to apply the transformation.

PRACTICE TIME

L ELRLE

- HiL, L. AL |

.1

‘-—-—llﬂlﬂ'l.-'lﬂrﬂlllﬁ FERES

" ® P E

&

Fig 7.27 Image after rotation and
harizontal flipping

The Ary and Crafr teacher has asked the soudents
of class WM to create a scenery by inserting different
shapes and wsing brush sorokes Mehreen has
created the image seen alongsade. Creare a smilar
scenery using the tools in Photoshop.

SOLUTION

1. Start Adcbe Photoshop C53

3 Toinsert the shape of a dog, a woetomse. 3 bird
ele:
2 Salect the Custom Shape Tool,

Click the amow beside the Shape opton

—_—
Aard LEL e |y
'. I?m--l- . - g 5

'I'. .IIH;. L I."
fONE e

. 't A
3 [Ty \

in the Optians bar and select the required

shape
Chick and drag the mouse (o draw the shape.
d. You can akso change the Colour of the shapes.
3. Toadd grass sorokes to theimage:
3 Click the Brush Toel in the Toals panel.
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b Click the arrow beside the Brush command in the Options Bar, The Brush Preset Picker

appears.
€ Click on a beush sayle of vour choice.

d. Select the foreground and the background Celour.
e Click and drag the mouse pesnter on the image to draw strokes of the selected Colour.

ik

Resolution number of pixels per inch Marques tools tools used to select rectangular,
Colour mode number of Colaurs that can appear square, elliptical, and circular shaped areas of
in an image an image

Crop 1o remove unwanted areas of an image Lasso tools  toals used to make free-hand
selections of areas in an image

* The Options bar ic below the menu bar. It » Lising various Marquee Tools, vou can select
displays different options of the curmently rectangular, square, elliptical, or circular aneas
selected tool. of an image.

* The image window contains the image to be * You can use the Lasso Tools to make free-hand
edited. The title bar of the image window selactions in an image
displays information about the image that has

*  Use the Magic Wand Tool 10 select adjacent
areas of the same Colour in an image.

* The Gradient Tool is used to fill a selected
portion or entire kayer with transitions of ane
Colour to another.

been apenad.

* Toopen an existing Photoshop file, select
File » Open and then salect the file in the
Open dialog o

s To create a new file, select File » New, s ‘Photoshion piovides  callection ﬂidmwing

»  The defaull foreground Colour is black and toods, like the Rectangle, the Rounded
the default background Colour is white. You Rectangle, the Ellipse, the Polygon, the Line,
can change the foreground and background Custom Shape, etc.
Calouss ying the Colour Picker. * The Custom Shape Tool lets you draw things
» Todisplay the Colour Picker Paletle, click other than basic geometric shapes,
either the foreground or the background
Colour bex in the Tools panel,
OXFORD 138
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Y
objective Type Questions
1, Choose the correct opfion,
" '!.ﬂ.ﬂ'lich.nf_me tallowing butions arg available on the title barf
i. Maximise ii. Minimise il Close iv. all of these
b. It displays i_ﬂfﬂrmatinn such as current magnification, file size, etc. of an image.
I. Image window il Status bar iii. Rulers iv. none of these
e. This tool is used 10 make a free selection.
|. Lasso Tool ii. Marguee Tool fii, Blur Tool  iv. none of these
d 1.'.rhjr:I-! of the following can be chosen as a backgroundi
I White il. Background Colour 1l Transparent  Iv. Any one of these
e '|."l."|'li:5h af the following can be used 1o select a circular area of pixels?
i, EIHEI? Row Marquee Tool ii. Single Column Marquee Tool
ii. Hliptical Marguee Tool iv. Rectangular Marquee Tool
. The it Tool lets you draw things other than basic geometric shapes,
i. Custom Shape il. Rectangle ifi, Line iv. none of these
g. Which of the following 1ool sticks to the edges of an image, thus making it easy to select the
shape of an imagef
i, Lasso Tool ii. Polygonal Lasso Tool
iii.  Magnetic Lasso Tool v, none of these
h. The kevboard shortcut to get the Save As dialog box is
i, Alt+5 il Shift+ Cirl + 8 iii. Ctrl + 8 iv. none of these
Descriptive Type Questions
Answer the following,

. Mame the various Marquee Tools.

b. What is the default foreground and background Colour?
t. How can you create a new file in Photoshop €531

d. What is the use of the Gradient Tool!

& List the steps to change the foreground Colour.

£ What is the use of the Circular Marquee Tool!

8 Differentiate between the Marquee and the Lasso tools.

i M . s oeow o  (Eom
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h. What do you understand by the term ‘resolution'?

I Alizeh is working on 2 picture of her pet dog and wands to show the image in different perspectiveg
Explain the different ways in which an image can be transformed in Photoshop. What are the
potential benefits of doing this?

Jo Bilal has been given the following pictures and has to make the required changes in them. How
waotild he do this? Is it an easy task? Justify your response,

* a picture of playground where he needs 1o focus on the two children in the foreground
* an image where he needs 10 blend two background colours together
* A picture where he needs 1o tum the people in the picture to the opposite side

k. Open the picture of your favourite super hero in Photoshop. Make the following changes to it and
nate down the steps you take for each of them, Why do you think is it important 1o follow the steps
in order?

* Change the backgroundforeground colour of the picture.
* Crop away any details you do not like.

* Copy the image within the same file.

* Adda gradient and transiorm the picture,

Application-Based Questions
a, Observe the following figure and label the parts marked:

B adebe Fhotaseos 011 Eterded

Fie_Gdt mage Loyer “Selerl Fiter Avstyin Vo Wincom_big
to- lwede T Eoghs | eskie e | [Froctinage | [ Car
DU e .
I":;-;;;“ Woyppeirnpcan © (o TE | |1 e
I — (| ] g
i 7 b "
= -..ﬂ-{”
#ﬂmm
EPM;
-
=l =

b. Tahir has to create a new file in Phateshap.

i. MName the menu and the option he will use to create a new file.
i, What is the default name of the file?
iii. What is the default unit of measurement for height and width?

c. Pinky has opened an image in Photoshop. She wants to select some portions of the image.
I. Which tool should she use if she has to select a rectangular area of the image?
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. Name the toal she shauld uge 1y select a circular area in the image.

ik, f"h;-rm?r'n' wans to make 3 frechand selection in the image. Which ool would be the suitable

4 Dina has created an imape
i How can she copy this
i, What steps will she

fier THE LAB

1, Ghazanfar has two images—an image of a landscape and that of 2 horse. He has to copy the image

of the horse 1o the image of the landscape which should form the background. Select similar images
Il'ld hlend the two 2o that IhE'lrl seem like part of one im&gﬂ‘.

in Photoshop, and has selecied a part of the imape.
Part of the image to another location in the same image?
need to follow to copy the selected portion to another image?

2. Harmain wants 1o create an image of an aguarium, He has different pictures related to this. Collect

relevant pictures of your own on the theme, and combine them to create your own image of an
Aruarium.

3. Select an image of a landscape and apen it in Photoshop. Using different selection tools, select and
copy different images of trees, and add them to the landscape so as to increase the number of rees,
Also, add pictures of birds in the sky and create a beautiful nature scene,

4. Tanya has learnt to change the background Colour and insert different shapes in Photoshop. She has
been told 1o create a bosder design in Photoshop. Create one on your system too in Photothop.

GROUP WORK:

You have now learned the basics of about Photoshop but there are other easily available image
editing software such as GIMP, Paint.NET, and Seashore. In your group carry out some research

and assess whether these software packages work on Windows or MAC or both. Note down
their similarities and differences. Present your findings in a chart,

4% TEACHER'S NOTES

» Explain to the students how 1o change the dimensions while creating a new file and discuss why it Is
imponant 1o do so.
s Demonstrate how 1o create different shades and blends with the Gradient Tool.

* Ersure that the students undersiand the differences between the Lassa, (he Polygonal, and the Magnetic

Lasto Tools.
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"5 S mem ssss Sam e
.-_" s & B Em @B - R S



Well Coggle
You can ede the phog, |

and o it quite well s
. Fhlnﬁap'

| ook e sovme spocs on them,

some are o bright, whils 1ome have
(ome-owt foo dard | dant know

. wiharto gol

Fairing m Photashop
— .J:'.mi'.'fc:-n; Iﬂ%.l:[-_"‘ o

o
Ll -

In the last chapter, you had learmt about the various drawing w

and painting tools in Photoshop but, what if you need to in this Chaptar |
edit an image? The answer lies in the set of retouching tools - !
available in Photoshop. In this chapter, you will learn about
some of them. You will also learn about layers and fillers
that help you work with images in a better way.

= Retotching Took
« Woarking with Layers

* Working with Text
= LIsing Filvers

RETOUCHING TOOLS

The Retouching Tools help to change or edit the pixel arrangements in an image. These too
can be used on a selection or on an enlire image.

Some of these are the Spot Healing Brush Tool, Patch Tool, Red Eye Tool, Clane Stamyp Tool
Eraser Tool, Blur Tool, Smudge Tool, Dodge Tool, Burn Tool, and the Sponge Tool.

OXFORD 142 r
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5

spot Healing Brush Tool can remove blemishes, scars

- _riections in your photograph, Yoy can simply click ,,,;

nler ACTOSS the affected area and the flaw disappears, L
1o e this tool:

open the image (Fig. £.1),
_select the Spot Healing Brush Tool from the Taols panel.
; ﬂpetif'!r' the following in the Options bar (Fig. 8.2}

E;.

» Brush size

* Type: Choose from Proximily Match or Create Texture

o Sample All Layers: Select to sample data from all visible layers
Deselect this option to sample data from the active layer only.

spots, and other
d dmg the mouse
et us see the steps

e

Fig. 8.1 Original

image with flaws

S ] r=J —

= !1. x |"'“|"'F"""" _'!TH'FF':,:IWM 8 Craste Teture | [| Sampla Al Laywrs

Fig. 8.2 Spoi Healing options

4. Click the area you want to fix, or click and drag, to remove the flaws
(Fig. 8.3}

Fig. B.3 After
'|P|"r1|.'&-1.-i|'|3 wamie 1w

Healing Brush Tool

You can use the Healing Brush Tool to paint with sampled pixels from an image. The sample is
called the source. The flawed area is called the Destination. This tool also matches the texture,
lighting, transparency, and shading of the sampled pixels,

The steps to use the Healing Brush Tool are:

I. Open the image.

2, Selact the Healing Brush Tool from the Spot Healing Brush Tool menu,
3. Specify the following in the Options bar:

* Brush size and brush mode |
* Type of source Choose Sampled to use pixels from the current image. Choose Pattern to
use a pattern from the Patlern Picker drop-down palette,

4 " Em wm N QXERD
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.1: _ﬂl EEE EEEE mEE Do

- . s W e 1B LBBEER =W Em m m



* Aligned Select 1n sample pixels continuously without losing
the current sampling point, even if you release the mouse m
button, Deselect 1his aption if you want to continue using the
samypled pixels from the initial sa mpling point each time you
stop and resume,

* Sample All Layers Click to samiple data from all visible
layers,

4. Place the pointer on the image area to select the sample Colour.
Press ALT and click the mouse to select the sample,

3. Click and drag in the image (Figg. .41 Fig. B.4 Afer using the

Healing Brush T
Clone Stamp Tool @

The Clone Stamp Tool can clone or duplicate selected areas of an image. The steps to use the
tool are:

l. Open the image (Fig. 8.5),

2. Click on the Clone Stamp Tool in the Tools panel. (Top Tip i"I-;lh'l-r
L o
3. Hold down the ALT key, click the part of the image You can change the opacity vakie
you want to clone, and release the ALT key. brush size, ete, in the Options bar.

4. Click and drag the mouse over the area where you
want to place the cloned pixels (Fig. 8.6),

= {1
B rsitied-1 @ T1LI% fLaywe 1, AW B rome 1 @ BN Laywr 1, 0500 [ L6 i
F-F o | L Lk - D *f [ ji |if N L
]
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T
T
T
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Fig.B.5 Imape to be cloned Fig. 8.6 Image cloned to the top right comer
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patterm stamp Tool E]

gefine a pattern and then elone i, The steps to use the tool are:

1. {].Pen dan Irn.i+|.=',!': and SEIECI I!hl: dAree VO wanl Lo dfefine as a PE'”'L"'“ il i .7l

Fig. B.7 Image with a pattern

Type a pattern name and click OK.

B

Loy
]

2. Select Edit » Define Pattern. The Pattern
MName dialog box opens (Fig. 885,

ANTHIT Masw

o |

# Herre: TELLH) I_:“EEI )

Fig. 8.8 Pattern Name dialog box

Open the image where you want to apply the pattern.

Select the Patlern Stamp Tool in the Tools panel,

6. Select the Aligned checkbox in the Options bar. This will maintain the pattern’s continuity
with the original start point, even if you release the mouse button and then conlinue
painting. Deselecting the Aligned option will restart the pattern each time you stop and start

painting.

7. Open the Pattern Picker palette (Fig. 8.9)

B. Place the mouse pointer on the image and drag it over the part you want to fill with the
pattern iFig. 8.10). The pattern will be duplicated on the image or on your blank canvas.

Patuern Picker pileine 210w

B 1 mn -
b nrers o O U i "l e 1

Fig. 8.9 Selecting 2 patiem
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Fig. 5.10 Using the
Pattern Stamp Tool
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Eraﬂarluul_ Ig w J EraserTool E
b : } EF Background Eraser Togl £

The Eraser Tool can erage portions of an imape, It S

has three options (Fig, 4, 1 | X Mugic Criser 3

* Eraser Tool Fig. 18,11 Submenu of the Eraser Tog|

Background Eraser Tool This erases parts of an

image and makes it transparent, If the image has multiple layers, it erases the pixels of the
Background layer,

* Magic Eraser Tool This too| erases pixels from similarly-coloured areas.

Let us see how 19 use the Eraser Tools:
1. Open the image,

2. Click on the Eraser Tool in the Tools panel.

3. Select the eraser mode in the Options bar. The

shape of the Eraser Tool changes according to
your selection,

* Brush The Eraser Tool takes the shape of a
brush. The eraser strokes are like those of the
Painthrush tool,

* Pencil The Eraser Tool takes the shape of a
pencil, The eraser strokes are like those of the . R
Penedl ton]. ‘ Fig. B.12 Using the Eraser Tool

* Block The Eraser Tool takes the shape of a |' :
wooden block of fixed size. | Top Tip

4. 5et the value for Oipacity in the Options bar. The higher the opacity vahue, the more
h Fips s
3. Click and drag on the area to be erased g 8.12], VAR RUMORE of pioels erased at & time

Blur Tool Q.
The Blur Tool can blur or soften an image or part of an image. The steps to yse
1. Open the image (Fig. 8.134
2. Click on the Blur Tool in the Tools panel,
3. In the Options bar, you can do the following;

* Select the appropriate brush from the palette in the Options bar,

» Set oplions for the blending mode and strength.

* Select Use All Layers in the Options bar to blur using data from all visible |a yers, If this
option is deselected, the tool uses data from only the active layer.

it are:
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4, Click and drag on the Image to blur the mixels iFig #5145
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Fig. .13 Befoew using the Blur Tool Fig. 8,14 After using the Blur Tool

smudge Tool )

The Smudge Tool creates an effect like wet paint smudged with a finger. To use this tool, follow
the steps given below;

".l--.—lu-lnlhlﬂ'l—:- Fl-'._.ﬂ
ip_H : .

1. Open the image (Fig. 8.15).

2. Select the Smudge Tool in
the Tools panel.

3. In the Options bar, you can
do the following:

Choose the Brush type.

Select the blending
miode,

Select Use All Layers to

smudge using Colour Fig. .15 Before using the Fig. B.16 After using the
data from all visible Smudge Tool Smudge Tool

layers.

Select Finger Painting if you want to smudge using the foreground colour at the beginning
of each stroke. If this option is deselected, then the Smudge Tool uses the colour under the
pointer at the beginning of each stroke.

4. Click and drag on the image to smiedpe an area (Fig. 8.16),
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Dodge Tool [ %

The Dodge Tool can make darker portions of

an image lighter. Follow the sleps below to use
this tool:

@ LT RIRE
b N O N

1. Open the image (Fig. 4.17)
2. Select the Dodge Tool in the Tools panel,

3. Click the arrow next to Brush in the Options

bar. Select a soft-edged brush 1o get better
results,

e

4. Select the Range and sat the value of
Exposure in the Options har,

3. Click and drag the mouse on the image
area to lighten the pixels (Fig, 5.18).

Burn Innl@

The Burn Tool is used to darken the pixels in
an image. The steps to use it are:

1. Open the image (Fig. 8.19),

2. Use any of the selection tools to select

an area to darken, or you can darken the Fig. B.18 After using the Dodge Tool
whale image.

3. Select the Burn Tool in the Tools panel.

4. In the Options bar, set the Exposure percentage,
5. Drag the brush over the image to darken it (Fig. 8.20),
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WORKING WITH LAVERS S

Layers allow you to werk with ane element of an image without disturbing [ i i Mgt

lh!-ﬂlhf'l‘s- .E. : P g
L]

You can think of layers as transparent sheets stacked one on top of the S

Ol Tﬂu et thraugh transparent areas of a layer to the layers below, W o :W

A new image in Fhotoshop has 5 single layer, You can add a number of " B s

additional layers. E: B dnes

|ayers Paletie

The Layers palette lists all layers, aroups, and layer effects
in an image (Fig. 8.211 You can use the Layers palette to
show and hide layers, create new layers, delete layers, etc,

To display the Layers palette, select Window » Layers,

Fg. 8.21 Layers paletts

Background Layer

The Background is a special layer. It is created automatically

when you create a new image. An image can have only one Top Tip %
background Ia}r:Er. It |5I F.'r&hlnd all the other [a:.-r:-rs and '!r'-l:ﬂ.l - b

cannot change its position. You cannot delete it, move ils image with & transparent

eantents, or change the opacity. But you can convert it inlo a hackground, then the image does
regular fayer, not have a background layer,

All the other layers that you add will appear above the
Background layer, The following cannot be done on the Background layer:

* You cannot move the contents of the Background layer.
* You cannot move the Background layer above any other layer.
* You cannot move any other layer below the Background layer.

* The Background layer doesn't support ransparency.

Renaming the Background Layer

1. Seloct Layer » New » Layer From Background
2. The New Layer dialog box appears. Type a new name for the layer. The default is ‘Layer O,

Click OK.
3. Now you can see the name of the Background layer changed to the new layer name,
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Creating a Hew Layer Mra Liyer et
When you add a new layer, it is always || jaene: T
above the selected |ayer. Follow these [} ise Pravious Layer b Create Cloping Mask [ G ]
steps o create a new layer, L Lo = '
1. Choose Layer » New » Layer. ode: Nomml - Opacky: 100+ |
2. The New Layer dialog box appears [ {hia mestral colar exszs for Hgmal mode.)

{Fig. 8.22). New L P el

Fip. B,22 iakog LOX
Set the following options: » MEEE

* The default name of the new |layer is Layer 1. You can
change it 1o something more appropriate.

* Click the drop-down menu arow in the Colour text box,
and select a Colour for the tayer.

* Sel the Opacity value.
3. Click OK,

You will see a new blank layer in the Layers palette (Fig. .23,
selecting Layers

Hg. B.23 Layers paletie

You can select one or more lavers to work on them, For

activities like painting, drawing, and editing, you can Fast Forwari
work on only one layer at a time. The selected layer is

called the active layer, rsertalayer SHIFT + CTRL+N

To select a layer, click a layer in the Layers palette. To
select multiple adjacent layers, click the first layer and then

press SHIFT and Click on the last layer. Tap Tip f:]'
w

To select all layers, choose Select » All Layers, To showihide & biyes; dick

changing Order of tayers il k"'::::r_‘“’“’”'“

To change the order of layers:
1. Click and drag the layer up or down in the Layers palette,

2, Release the mouse button when the highlighted line appears where you want to place
the layer.

Rename a layer

To rename a layer:

1. Double-click the layer in the Layers paletie,
2. Type a new name.
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gelete A LBUET

1o delete 3 Byer ot layers, the siups .

(. Select one or more lawers in the Layers palete

s Click the Delete icon in the Layers paletie,

O
select Layer » Delete » Layer,

flatten LALEFS

Flatrening reduces the I.“? size by merging all visible layers into the
packground. Any remaining transparent areas are filled white. To
flatten the layers, make sure that all the layers are visible, and then
wolect Layer » Flatten Image,

payet Effects

Photoshop provides a number of effects that let you quickly change
the appearance of a layer’s contents, like shadows, glows, bevels,
eic. The steps to apply Layer effects are;

1, Select a layer in the Layers palette,

'|hl—li|ff1ml_m_

gl - Sgarkr CERY 5

(LR EE | il

ighae Chanrisy. -
=Ty Cranriey
Futiem Doy —
ook

Fig. 8.24 Layer Styles

2, Click the I.i'}'H' SIYI'H buttan at the bottom of the IJFH'E PilE't"l'E Menti

and choose an effect from the list (Fig. 8.24),

Cir
@ tadzte Fromudag CIH [reie =1

Select Layer » Layer i o

Style and choose an "2 @ g =1

effect from the submenu | ’ .h“"‘"" e =r

Fig. B.25], | H E*::_ ] : .':: :.: -
3. The Layer Style dialog By N e Ly o Ot

box appears (Fig. 8261 || 528 e ot o M Wi S

Choase an effect, for e Lipweielt |* ey OO

EHEH!PI"E, D"]ll] gﬂm.l IE’E m::“m ABsCwisi it ::"'""'5"""“1'—

and set effect Erpliﬂlﬂir .i:? | .:.-...t.n:q-u: v hu:_

If desired, you can add n (IO} gy | Copy Loy iyl

anoither effect by clicking | 2. {- | e s [t mens

the check box to the left "% g pRrErT ‘ Gona o

of the effect name, . Covup Ly Cri s H.nul;:h
4. Click OK and <ee the o - o [ il

result {Fip, 0.27),
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Fig. B.25 Layers moeny
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Fig. 8.27 Drop Shadow efiect
applied to the image

Fig. 8.26 Layer Style dialog box

g
PRACTICE TIME i J:

Rada recently visiced Thailand with her family mernbers. Her mother has rold her to create a degital
collage of the phoragraphs they have taken, What are the sceps she needs te follow?

SOLUTION
1. Stare Photoshop £33
2 Create a new file
1 Toadd a new layer
4 Select Layer  New & Layer

b Give the 2yer an appropriate name.

e Chek O You will see 3 new Blank layer in the

~AYENE DA

4. Copy the reqisred image and paste it into this new

layer.
3. Tochange the size of the image
3. Select the lzyer,

o Select Edit » Transform P Scale Scaling handles appear,

il rrere— B U L] SEE
L i

£ Click and drag the scaling handle to resize the image.

d Double-click inside the image to apply this ransformanion
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g Torotate the image
a
b

C

Select the Layer or Image.

. Click and drag the roratinn Pandle.
d

Select Edit™ Transform p Rotate The ropa:

o handles appear

Double-click inside the Image to apply the transformatian,

Repeat steps 3 to i
7 Repe ps 610 add moee Imiages. Each image will be in its cwn fayer

WORKING WITH TEHT

For typing text in a Photoshop document, we use the T

ype Tool. When we type text in

photoshop, it is added ta a separate layer called the Type Layer.

The steps to add text to an image

.- oty Flmmm—n 1) | i — C'|_.-I'|:|'|I.E.Ir '_-m
grggi'.'El'I:hE'm"l'lFi!.-',.-HEﬁfl: -"':lifl-l-l;-b-huu- o — - L SR
- Tol@mie & oma o iftme Fue= -[Mea @ LD
1. Open the image. | s:t: ] e - =
- . . ] B || S argra
Tools panel. % 1 Birthday 5"'" §
3. Select font, size, and Colowr in Ei 1 Ssbect che Type Tool l%::-
' aell . .
the Options bar, e e
3. Click the left mouse buttonon || 55| 4
the image and type the text. daf -
Notice that the type is created  [|° |2
: T
| ! =
m a new layer = A o
Maving Tewt Fig. 8.28 Using the Horizontal Type Tool
You can move text from one position o [ errrr— =)

another on the image. The steps are:

. Select the Type layer in the Layers
palette.

L. Click the Move Tool in the Tools
panel.
3. Click on the text, drag it to the desired

position on the stage, and release the
mause button (Fig. 8.29).
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Fig. 8.29 Moving Text
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Warping Tant

Warping lets you distort 1oxt into 2 variely of shapes, For example, o
shape of an arc or a wave. The SIOps are;

- 3elect the Type layer.

- select the Type Tool in the Tools panel.

- Click the Create Warped Text button in the Options bar (Fig. 8.30)

u can warp text into fhy

[ —

Ik

Creats Warp Text button

T"'lﬂ_ﬂ'lll'-l-"ﬁl ®  Bagule -|.ﬂ'“|:||,-| _Elp!ﬂ-:‘! *:mi: -:1|E

Fig. B.30 Options har

o

. The Warp Text dialog box appears. Select a style from the Style drop-down list. In this case
we selected Are (Fip. 8.11).
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e IR - R T e s o w | fEe [ '[l]-'-'--":_“_i
“remo Conat | (] | e
B w3 % - I
| -_;.-li
| et T P om :}-.-I Fﬁm
'nt—:—-nu . "F"'.'i a
i [ Tl '
HS, T Pt w‘d .
1 . . AL a iEI | e 4 -
', I e B e o o
) l. r
Fig. 8.31 Warp Text dialog box ¥
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Fig. 8.32 Warped text

5. You can also select the orientation, Horizontal or Vertical.
If required, specify the values ior Bend, Horizontal Distortion, and Vertical Distortion.
6. Click OK to see the result of your selections (Fig. #.32).

USING FILTERS

Filters are used to add a variety of special efiects to an image. You can madify the image ina
number of ways, For example, you can use filters to change the look of your image by giving
the appearance of mosaic tiles by adding lighting, or distortion.

OXFORD 154

__ _i@m_mEE_@SEEE LD o o . -Eﬂ



[

|ying @ FILLET [ToE] S orw Wi sy

Il'I]p b l.-.-| T el

collow these steps 1o apply a filter: R

. To apply a filter to an entire layer, make sure that the oy ekt
|ayet is active. To apply a filter 10 part of a layer, select e ek
fhat area.

. Choose a filter from the submenus in the Filter meny
|'-|!-'.- f.3 i

3, Fill values and select options in the dialog box

i I i 34,
1. Click OK to apply the filter (Fig, 8,35,

Nole: 'l."l.l'i.l‘l"l some filter EHE'C‘I'!‘-. you willl pot see 2 di.]]l'_'lE
box. The effect will be applied immediately,

Fip. 8.33 Fller menu

L et T e L, BN Ce 0

= | =i [

234 mossic Tiles dialog box Fig. 8.15 Applied filter
Fig (Mosaic Tiles effect)

Filter Gallery
Filters are used 1o change the appearance of an image, layer, or a selection in Photoshop.

The Filter Gallery in Photoshop lets you apply filters incrementally and apply individual filters
mate than once. You can view thumbnail examples of what each filter does, rearrange filters,

and change the settings of filters you have applied.

| Todisplay the Filter Gallery, select Filler Filter Gallery. Click a filter category name to display
thumbnails of available filker effects.
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Follow these steps to apply filters irom the Filler Gallery:

I Toapply a filier to an entire layer, make sure that the layer is active or selected. To apply 5
filter to an area of 3 layes, select that area.

=3

Select Filter » Filter Gallery,

3. Click a filter to add it to the image. The name of the filter appears in the applied filter list 3
the lawer right corner of the Filter Gallery dialog box (Fig. 8.36),

. Enter values or choose options for the filter Yo have selected.

5. To apply filters cum ulatively, click New Effect Layer and choose an aiiditiona} fiter 1o ply
Repeat this step to add mare filters.

b. To remove an applied filter, select a filter from the applied filter list and click Delete.

7. After applying all the filters, click OK ig. 8.37),

i s o
e

T T R TR R R R |

R TR = 'J

Fig. 8.36 Filter Gallery dialog box Fig. 8.37 Multiple filters applied

_ichy Terms

Retouching tools 1ools for changing or editing Layer effects  effects like shadows, glows, efc.,
pixel arrangements jn an image that are provided in Photoshap to allow you 10
quickly change the appearance of a layer

Clone  to duplicate an image or part of an image

Warp to distort text into a shape like an arc,
d wave, alc,
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Memaory Bytes

cetouching tools are used 1o change or edij

gixe! arrangements in an image,

1he Spot Healing Brush Toal can,

emove blemishes, scars, spots, and other

mperfections in a photograph,

The Clone Stamp Tool can clone o duplicate

salected areas of an image.

+ The Eraser Tool can erase portions of an image.

» The Blur Tool can blur or saften partions of an
image.

. The Smudge Tool can create the effect of wet
;]-.lil'lr EI'I"IUd'E".'d 'ul'l'iﬂ"l - | ﬁl'l-g,Ef

+ The Dodge Tool can lighten parts of an image,

+ The Burn Tool can darken parts of an image.

o Layers allow you to work with one element of

an image without disturbing the others,

o Anew Photoshop image has a single layer.
You can add additional layers,

.5

The Layers paletie lists all layers, groups, and
layer effects in an image.

You can add a new layer by selecting

Layer = New & Layer,

Flattening redwces the file size by merging

all visible layers into the background. To
flasten all the visible layers, select Layer &
Flatten Image.

You can type text in a Photoshop document by
uting the Type Tool,

Whenever you type text in Photoshop, it is
added on a separate layer called the Type layer,
With filters, you can add a variety of special
effects 1o your images.

The Filter Gallery fets you apply filters
cumulatively and apply individual filters more
than once.

Objective Type Questions

1, Choose the correcl oplion.

#. Which of the following options of the Eraser Tool will erase pixels of the Background layer?

I, Eraser Tool

il. Background Eraser Tool . Magic Eraser Tool

iv. nane of these

b. Which of the following layer is created automatically when you create a new image!

. Background i, Image

iii. Tex . nome of these

£ Which of the following options are available in the Layer menut

I Delote i, Flatten Image

. Tools panel i, Layers palette

i Type Layer i, Text Layer

157
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iii. Layer Style iv. all of these

d. The I-Elfr"EF 51_3.]55 buttosn is present at the bottom of the ..o

ii. Image window

iv, none af these

2. When Irlw 1_?p-,E {ext, a “-P_ﬂm.! j;l'!ll'EI" |:-|-|.|tfd ‘hE SRR |5 ﬂddﬂd.

i, MNew Layer . none of these
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. To distort text into a shape, use the Create Warped Text button on the .........

I, Toals panel ii. Layers Palelte iii. Options bar i, none of these
B sorermamanianian, are used to ivdd special effects 1o an image.
I, Filters ii. Animalion ii. Custorn animation  Iv. none of these
. Which of the following effects are available on clicking the Filler rnenud
L Texture i, Blur i, Artistic . all of these
Descriptive Type Questions

Answer the Folbawing,

Can you select multiple layers in Photoshop? If yes, how!

What is the use of the Spot Healing Brush Tool?

How can you flatten all visible layers? What is the use of flattening the layers?

What is the currently selected Layer in Photoshop called?

What are the steps to rename a layer?

Analyse the importance of warking with layers in Photoshap.

Harmza is having trouble waorking out how a number of tools work in Photoshop. Explain the
workings of each of the following tools; blur, clone, smudge, dodge, burn, These are great tool
names, but why are they so called?

b, Using the image of your superhers which you designed for Question 3 in Chapter 7, add more
layers 1o it and give it a more detailed look. At each step document what you did and why you
did it.

e R

Application-Based Questions
a. Diya clicked her grandmother's photograph. When she opened the photograph in Photoshap, she
noticed some dark patches on the face.

i. Name the tool she can use to remove those dark patches,
it, List the steps (o use that tool,

b. Kamil has created a collage in Photoshop on the topic ‘Festivals of Pakistan', Each picture was
added In a separate layer.

i. How can a new layer be inserted? Also write the keyboard shortcut for the same.
i. She wants to change the order of the tayers. Can this be done? If yes, how!

c. Shaheer went for a picnic with his school friends and clicked many photagraphs, Naw his friends

want him to make a digital collage of these photographs. For this he created a new file and inserted
these pictures in different layers,

I When he insens new layers, what are the default layer names that are given 1o these layees?
bi. 50 that he doesn't get confused, he wants to give appropriate names 1o these layers. List the

stéps 1o rename a layer,
oxorp 158
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r

has 10 design ﬂEI"EHinE eard for her fri

d 5=ilfm-,,.-.,n‘mui:h layer is added when you end in Photoshop, She has typed some text on the card.

b ach buttan do you use 1o ch P et o et
i which ¥ o change the shape and style of the text? Where is this button F"&E“H

&LWTHE LAB

yumna has writien 2 collection of short staries that she wants to publish in the form of a book. She
15 decided 1o design a book cover for it. Help her design a book cover using the tools available in
photashop.

3 Ghazal class teacher has asked her to design a cover for the attendance register of the class. Which
wols should she use? How can she change the Colour of the background?

3, ishad [rves 'n'l-'iﬂtl'llil'lﬂ_. EEII"h_'JﬂI'rE-. she has opened the imape of her favourite cartoon character in
phatoshop and appl:e-f;! different textures to the image. Open an image of your favourite cartoon
chasacter and apply difterent filters 1 see their effect and create a collage.

4. tma has to participate in an Fid card design competition wherein the design can be created in
Photoshop. Mame the tools shé can use for this purpose. Create an Eid card design of your own.

GROUP WORK

¥y are 2 ieam of software developers and have been tasked with coming up with some new user-friendly
witwase specifically for the older generation who are not as quick on computers as you are. These users will
need 10 easily manipulate text and images and be introduced to the basics of using audio and video, Based on
your new found knowledge of different software packages, create a fist of features you would like to use in your
mwn software programme. Justify why you would include some features but not athers. How would you make it
imeresting and relevant to vour tanget sudienced

o TEACHER'S NOTES
* Tall the studbents how to scan pictures and open them in Photashop. Then demonstrate how to use
retauching tools to edit these prelurs.
* Demonstrabe how Lﬂ.a,p-lpi'rl filters and layer styles effectively.
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Introduction 10
Dreamweaver CS3

WS iy
g el wiul | was ineng 1o
ramerrsber’ VWi exany dosy |

I.\..f

Fum:[c_ it s
AN PAsT WAy f0 Create weh

papes? Wichour g HTAAL

mde, for sample! A

Y, Coogahed ir 5
posihie ¥ you ume a
WYSWYES editor

You have learnt how to create simple web pages by writing
HTML code. However, it is possible to create web pages
even without writing HTML code. If yow use a web design

program (also called a WYSIWYG HTML editorl, you do not : :

+ Adobe Oreamveeayer
need to learn HTML tags, as the software creates the HTML e e
code by itself. This chapter introduces one such program - Adding Test and Images
called Adobe Dreamweaver. The version we will use s 83, - Working with Hyperfinks

+ Adding Flash Buttons

ADDBE DREAMWEAVER

You can use Adobe Dreamweaver o create individual web pages and complete websites. It
has a What You See Is What You Get (WYSIWYG) editor, which means that you design your
web page as you wish to see them, by placing elements in the editor window, As you know, 3
collection of related web pages forms a website. When you upload this website 1o a web server,
then anyone on the Infermet can see this website, The term ‘site’ refers to a local or a remote

storage location for the documents on a website,

160

=] 4
E = m E
B EEE BEO un BT

L i s



jeaver site consists of the following folders:

-"F:j ol jolder This folder is an your local
per and stores the files you are currently

compY Dreamweaver refers to il as your

-.-ﬂr’FI”E oa.

ot ]5IIE

ote folder  This folder is on the computer where

: peme . el server software is running, Dreamweaver
you s o this folder as your ‘Remote site’.

elet

o, the local and remote folders enable you to
gl " piiles between your local computer's hard disk
e weh Server, making it easy to manage files in

mweaver gites.
1:Urﬂm“

o this chapter, We will use only a local root folder for
aling @ website and will preview this website in a

adting DrEAMWEAVET
fallow these steps o start Dreamweaver:

Oid you Know?

Sofrwares like Dreamweaver et
Wi arganise and manage your web
docurrents, upload them to a web server,
track and maimtain yaur links, and share
fides. Other such programs are Amaya,
Microsodt Expressions Web, Micrasoft

ShiarePoint Desiprer, and Kompoder.

2

You need space on a Web server o
work with a remote folder. It is not free;
you have to pay for ic

Did you Know?

| select Start » All Programs » Adobe Design Premium CS3 » Adobe Dreamweaver C53

|_f-'ig. g1l

3 The first screen will appear (Fig. 9.2). Here, you can open a recently created document of
sart a new cpcument,
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Fig. 9.1 Starting Dreamweaver Cs3
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Fig. 9.2 Opening screen of Dreamweaver C53
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Creatp Wehsitn ] "'""‘-*"h;:_-;;,—:“;ul H—'::E'_'"L — '_:?:‘__
To create A mew wielisite, follow ':_;.TEIH IEHEI“I G- 08 - ::“ Ty
the steps below: = : i e £ £l '-"'-'**-E-:j:
1. In H'H." I;J|.!|L'I"|IIHH g, .%% ::..-..h ':"':-""::.:
under Crpate New, click T SR iy Chsss g iy

Dreamweaver Site,.. 1 it .20
Or
Click Site » New Site... to open a new website (Fig. 9.2

2. The Site Definition for screen will appear (Fig. 9,45 It hﬂ:’" "“‘E
Basic b is selected by default. Here you enter information for
screens that appear as you keep clicking the Next button.

i [ St mdi
Fips. 2. Mew Site..- arpaticn oF 3¢

sabs, Basic and Advanced. The
your website in a series pf

= E___.,— q_-i| = Logate the roog lolde
Enter Slte name
. e e e S ety tF# Brcomme beomg,
Site Defimtion il Tl s e
CTETT | | E | oD e o
| s | R 8
_::.n:l—-:-b—ﬂ-l."-lrmi'h T R T m e i W 8 et | REe
N—— e B e bas msi
B e BT i L] i a e
il Pl b |or veee srme b ey
Base o wma marsay g L i Eratly ks
e e g e
= — i L P T L
Click 0K
N T | Cary e
Fig. 9.4 Site Definition diabog bon Fig. 1.5 Advanced tab of the Site Definition diakog hos

Alternatively, you can click the Advanced tab. In this, you enter all the information in

just one screen (Fig. 9 55, Enter the site name; here it has been entered as new wishsile,
Enter the local root folder or locate

it using the Browse button, Finally |75 G i}
click OK. | ¥ Tog uperiae 1
m-- . = A

3. You will now see the new website i |
folder in the Files panel on the E-""":"'“' it M5 g e T
rfghlll'rjz. 9.6}, R — e _J

Fig. .6 Files paned with NewWebSite folder
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dind web Pages to the foldar

a now add pages 1o the

o
" Follow these steps:

I
1o create 3 wel page,
- golect File » New.

The New Doacument di.ﬁlr_‘.g

ﬁil‘

!"{ﬁ

-
-
e
=
-
s
-
-
-
LT
-
-
-
-
-
-
s
-
-
-
-
-

appears (Fig. 9.7), i
By default, the following E?":'
pplions are selected: the s
new document is a Blank o
page, the Page Type is i
HTML, and the Lavout is

wnone. Click Create,

3. The Document window
appears. Type the text as
shown in Figure 9.8,

4, Click File » Save to save the HTML file, The
save As dialog box appears (Fig. 9.9). Type a
name for the file and click Save,

o Lkt Do wrest CE R
P Ll Ve Tamd Vsl ot Commsn fm Wendes i
e pr—— e T

AT E-4-BD0 w002
deoman o] e it (6| C D6
—— ELr

1 Thet ey e W o pege o Dermrwe e T51

|| it irrnelen Brgrachrm ]
-

- =

Fig, 9.0 Document window Fig 4.9 Save As dialog box

Follow these steps for another method of
creating a web page:

Hew Fie
1. Right-click the folder in the Files panel :-:m
and select New File from the context N ‘
menu (Fig. 9.14). :-n :

Fig- 9.10 New File option of context menu
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Pt
.

The untitled i web page is created (Fig. .11k

Click on the filename and type the new name, 53, Seco
the panel under the website name {Fig. 9.12),

ndwebPage-html. You will see;i

—

XTI

ady e TS S ——

B e 0 C |8 0 2 4 8
L]

ol =] I'.."*"""E"L. -

Uy N - g Edmm -
= PFrirsiridtugn vy P Dveew o EPA0-EHA HRID
il |~ - gy (PRSI

Fig. 9.11 The Untitled.himl web page

4. Double-click SecondWebPage. html ta edit it
The Document window will appear (Fig. 9.13),

5. Add the content and then save it by selecting
File » Save.

Fig, 9.13 Document window for
secondWebPage_htmi
ELEMENTS OF DREAMWEAVER

The different parts of the Dreamweaver window are labelled in Figure 9.14.

Py Insecoon

Fig. 9.14 Deeamweaver windaw

Title bar  The title bar displays the page title with the fi

le path and filename in parentheses
IFig. 2,15, If the file has unsaved changes, you see an asterisk after the ﬁ|En:imEP
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v

o
H-u—m-{-.l;:.lu:.'-:

Fig. 9,15 Title Rar
rd roolbar  The File and Edit me
flﬁd C P
ys, Cul, LOpY, Faste, Undo, apf
» Toolbars » Standard,

s have common operations like New, Open, Save,
e Redo (Fiy, 9,161, 1f the standard toolbar is not visible, click

yiew

File
Le_ton View iy Modly Test Commands Ste Window Help |
Fig. 9.16 Standard tooltbar

bar Th";'“’”' bar contains buttons for creating and inserting objects including tables
ﬂn,dim.tgﬁ- When you move the Pointer over a button, a woltip appears with the name of the
, The buttans are grouped into Categonies which you can see by clicking the tabs at the

sap- Figure 0.17 shows the buttons on (he Common tab.
| Did you Know? _ﬁ

— Tabls  Frages  Aeds

Comman * Layont | Forms | Duta | Sory | Teat | rovasts W]
3 3 e : Each object is 3 plece of
lﬁliﬁn't*ﬂmﬂg.g.lﬁ_g HT.I-'Lmemcinu:
various attnbutes

ypeleh Fig. 9.17 Common tab of the Insert bar

Some buttons on the Insert bar have an arrow with a drop-down menu, When you select an
opticsn from the drop-down menu, it becomes the default action for that button. For example,

the Images button usually inserts an image. However, if you select image Placeholder from
the Images drop-down menu, then the next time |

you click tmages, it will insert an image placeholder | TopTip -'E"IL

rather than an image. i
The Property Inspector panel 1 at the

Property Inspector It lets vou see and edit the most  Jower edge of the workspace by defaule,

You can dock it at the upper edge of the

cemmaon properties for the currently selected page S o e i Moatings pamal

element, like text, image, etc. (Fig. 9,168},

| k&3

15 0 e

E'EE' Lak e, ,

Fig. %18 Propenty Inspector
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Eﬂ':ifi E-"H-ll“ T|'|t'!5,|_! are sois of related meL-f, grﬂupﬂﬂ tl:lgﬂlh'ﬂr
neter one heading, To cxpand a panel group, click the arrow 10
the left of the Browup’s name, The Files paned lets you mandage fles
an {{Il{[ﬂr\s i a Iuciﬂ mﬂl.'III[I'H:' or an the remale SUATL T i}, 144,
It also bots vou access files o your lacal disk in the same way as

"|..'l..rir1|_1:|'..-|;5 E:FJFI}I'ET.

Document Window with Toolbar
Figure 9,20 shows the document taolbar with many buttons on it.
* Show Code view It displays the HTML code for the web page.

* Show Code and Design views It displays the web page in the
upper half of the windaw and the HTML code in the lower hall.

Fig. 9.19 Panel groups

Show Design view |t

Fig. 9.201 Document window with toolbar

g z - ex) ¢

el e mgicmaveem]  dilaysthewebpage
o o] Document title  Herg

k 5:-:;: rﬂ 55:-.';: nu::m s you enter a title to be
g i Design displayed in the browser's
] wiew F3l title bar,

If o e p— PreviewiDebsg | »  Preview/Debug in

1 o webs page i becusad browser It allows you
. Mo & (% = Wi Kiiw to preview or dE'IJ'lJE. your

document in a browser,

You can select a browser from the menu that appears on clicking the button.
* Refresh Design view Changes in Code view do not appear in the Design view

automatically. You have to first save the file or click this button,

* View options It allows you to set options for Code view and Design view.

Status bar  The Status bar is at the bottam of the Document window (Fig, 9,211, | provides
additional information about the document you are creating,

Sliect Hand
ioal icel

o
toal

Ser
fagnfication

Windorw  Dagurment use and

ciéwnioad e

|chody

[E1® Q [ v|453x 243% K] 136t |

Fig. 9.21 Stahus bar

* Select toal Enable / Disable Hand tool,

* Hand tool It lets you click the document and drag it in the

OXFORD 166
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, Zoom tool and Set Magnification 1 fote

: \Window Size i logs you

yiul set the magnification level for your document.
! fesize ihy ,
dimensians. “ Documeny windhow o predatermined or custom

fime for the page Including 4| ¢ It shows the estimated document size and download
#Pendent files such as images and other media files,

ﬂuulﬂﬂ TERT AND IMAGES

gt LS NOW see how to add ext and Images io 3 Dreamweaver document.

7o ingert text simply click inside 5 document

wi i
press ENTER, Dreamweaver aytomg ndaw and type in your content. When you

press SHIFT + ENTER. tically adds paragraph spacing. To add a line space,
Open an existing document or create g & L.
sew document. Here, a document callpd i Add Text
MEHFHEE htmn| 15 Open in DHIE“ ; To add text, simphy elick inside o dorament widow and E
yiEw. tvpe i yoaar content. When vou click ENTER,
[ Dreamwenver mitlomaticadly adsls paragraph spacing, Ta
b 4 acdkd a line space, click SHIFT « ENTER.
1. Type some text in the Document | A r— i 5 s ke |

window as shown in Figure 9.22, Fig, 9.22 Text in the Document window

1, At the bottom of the screen, you will see the Property Inspector for text properties (Fig. 173,
select the text and click Bold, The selected text will appear in bald,

Foort  Unisofforisoe  FomiColour Bold  imlc o algnmers

* P R

o gt <] @iyl - () B/ B S AW — vea §

:H'H.Tbﬁ-r hl“t_E!w 15};11}1-:-.,:.. . -._ ) )

font  FortSae  Guflmecbst NumbersdBst  TeeOccdent  Tesoindere
Fip. 9.23 Text Properly Inspector
3. Click the Page Properties... button to display the Page Properties dialog box (Fig. 9.24)

You can make more changes using the options in this dialog box,
- 167 4 EE B u s
i:“ @ § EEEE B © &
Wit e Lil_EED_sEES_seo_ng
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Clek OK

CE == ]

adding IMages _
place the curso! where you want 10 insay

an image on the web page and follow the,,
steps: -

ihe Image @%E&
1. Click the i -

button and [ Roao lmage
sefect Image iy Fitpmpriy WIRE,
from the menu (B et s

that appears |1 SrmSeeuegs etrs

[ ]

Fig. 9.24 Page Propertics dialog o

. The Select Image Source dialog box
appears (Fig. 9261, Navigate 1o the
lacation of the image file, select the
rmage, and click OK.

L

..l'm_'ll-
3y

| Top Tip

Ta insert an image, you an #ho select
the mage option of the Insert menw.

g
5 Nl it Pt

{7 Darwe Pefpgan ot

o D Do Ol Hetapet
(Fig. 9.25).

e, |

Fig. .25 Image meny
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Alternatively, add the image using these steps:

1. In the Files panel, click the Assets tab.
The folder will appear on the left

Fig. 9.26 Select Image Source dinlog hox

side of the panel. Click the Image
fexbcer.

All the image files in the folder
New Website will appear.
(Remember, a folder Mew Website
was created on the Desklop which
has all thee web pages, image files
and any odher file that is required
for the website). Select the desined
image and drag it to the desired

lncation in the Document window

(Fip. 9470
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5, The Image Tag Accessibility Agyriutes dli
jelds: Alternale text ;| Long deseriptio

n.
._._,_-—-—T_'— ———
“,-lrrnl'"""'l s
- Snrimim e "N
i BT [T |_|:'_
mm h-'.ﬂ Ly I ;lihll
[
:::'::e:r:-r:n_u:hh:q_“
Fig. 9.20 Image Tag Accessibility Attributes
dialog hox

Alternate text  Enter a name qr
50 characters long,

Lﬂnglq;igcﬁpliun Enter the location of the file here,
This is displayed when the wser clicks the image.

brief description up o

with either of these two methads, the image will be
inserted as shown in 'r'l:,;u re 9,29,

You can sel image properties in the Property Inspector

(Fle, 5301

« WandH This is the width and height of the image
in pixels. When you insert an image in a web page,

[ Top Tip o)

alog box will appear (1. %28, You will see two

A,
You can enter inforination

i ane or both the test boxes

depending on your needs. The

screen readler will réad only the
alternate text for the image.

g
£
Z
3

Fig. 9.29 Picture inserted in the
web page

Dreamweaver fills these text boxes with the image's ariginal dimensions.

* Src It specifies the source file for the image.
* Link It specifies the hyperlink for the image.

* Alt It specifies the alternate text that appears in place of the image for text-only browsers,
v Align It specifies the alignment of the image on the web page,

Brighiraey Aigr Lefr, Cenper
Lk TagetFame Borde  Cmp ond Conbaar and Reghw
¥ Peopeie: ]
- bmage. ™ [ru S |GelatAronpg (D23 M - D Fara E
Wm e 90 =/ OHEKD A
H_::'-m s i B Targrl farder | 101 Exa (hMange
- M OO it Lo ey DIy see Defmit T *| Algrimers
Fip, 9.30 PFroperly Inspector for image propertics
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s nn B i emTrRAL Y i
i . H SEEE B O @
BEm BEE BEEEE DOE L6



Crop It trims the size of an imape by

removing unwanted arcas (1 011 Dirag the
comer handle to resize the image o 9000

* Border It defines the widith of the image

border in pixels, The defaul value is 0, for

no border. oo 913 shows an image with a

1 2-pineel border,

Fig. 9.33 Imape with borders

PRACTICE TIME

« Brightness and Contrasl
by imape brightn
= Sharpen

= Haotspol Tools (Po
Polygon) It is use
on the selected image.

B

il _
A 1,]1 -,:;- o Fig. 9,34 Resized image
il i

It ackjusts the settings related
pas and contrast.

¢ adjusts the sharpness of an image.

inter, Rectangle, Circle and

W

Rashid has beven i-.:.-EnHJ [0 CTeare 3 'weh
Page On Cloud Computeng He as 1o
gxpizn doud computing and suppart
the texr by adding an image. The web
page should loak a5 green in The figure
alongside. How should ke prooesd?

SOLUTICHN
1. Create a folder calied Website1 oni
the desktop Mow stant Drearrmyveaes

Pt

iClick Site = Mew Site. The Site

o] AT Bl P ey eSS | Y el S
N TLE

i Frovats cleaad o aapplen i i § e abar of paaple

= .

1 . SR
_——T " ™

Cloud Computing

il pasvpriing b tecfeeidngp Pald shEi T 1TiEmal grdd cenive ramEle
PRI [oampuren | oo brid dele el ot BT 3 el BN CETINE @0
ainiy I8 s spgkratim witha ol Mvibalieg B polfledra, Thip Jdh B0TeiE Dl
owd gl AT T B SRS wITY (el o . Cerdrei el Eneege,
PR Fearp, B il T e BT e oo EE omaLre)- TRANE
pervkipy piw @ edad b Wik Dl

= infmpirectes a0 0-Zerdos [hexd]
& Farorn-n-o- Srers [Feach)
B ol nl- b e e )

& sl gin By pablis pr e,
Wb fhmadl | [L moppdan me-enl B aPrETsE oF 18§ | FLeanE]

WA s Sabm

Definition for dialog box appears

3 Chckon the Advanced tab. Type the site name as Website 1, Set the local root folder to the

Webste folder and click OK Score the image file of doud computing in this foider

4 Right-click on the Website1 folder in the Files panel Select New File fram the conress men

Mame it as CloudCoamputing htmil

i

(8 PO

DCioarbee-chck CloudCompunmg himl o apen the page.

170

%

d 1o draw hotspots in various shapes




& Type the rext a8 shown i the figure.
7, The text is formatted g fellerars:

A Select the relevant tex and click the bald buttan

b. Select the relevant tewr an click the Ft:.li:]:-u:tr-r;

c Select the text and lick the Text C .
Colour fram the paletre

d Toadd a bullered

mbour down-arrow: a colour paletre appears Select a

ST, SElRCT the relevant tewt and click the Unordered list button.
e Tocenter the text, select the rext and cick the Align Center burton

E. 1 ad.':l: [hE Tﬂa-ﬂll. TI-ElE'E |.|-|-F' ||IT'EEE iI'I rh|_' Hh m“d iang 'E'-I].E 10 the :E'I:Iulrl?ﬂ. msl[lnn o6

the web page

9. Tocenter the image, select the image and click the Align Cemter burton

0, Tosave the web page after mizkirg all these changes. press CTRL + 5.

1. Preveew the web page by clicking the Preview/Debug in browser button

WORKING WITH HYPERLINKS

A hrpl!l"liﬂl'li is a word, phrase, or image that you can click on to move to a new document or a
new section within the current document. Nearly all web pages have hyperlinks, allowing users

io click and move from one web page to another. When you mave
the cursor over a hyperlink, whether text or image, the arrow changes
o a small hand pointing at the link. When you click it, you go to a
new page of 1o a new place in the current page,

Satting Tewt/image as & Hyperink
Follow these steps to create a hyperlink: _
1. Select the text or image that you want to lal Selected text (b} Selected image
sef as hyperlink (Fig. %.34), Fig. 9.0 Select the text/imape to be set a5 a hyperlink

i

Click the Hyperlink button on the
Common tab of the Insert bar (Fig. 9151,

1. The Hyperlink dialog box will appear

tFig. 9,36}
Hyperink tsmon
Vil Comses  fayout | fwe | Dake | Seay | Tesk | Pemestia I
ve2ieaE-4-8250-90-0
Fig, 9.35 Common tab of Insert bar Fig. 9.36 Hyperfink dialog box
LR
k 171 o, owow
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a,

5

6. Enter a title for the link in the Title text box. This appears in the

7. Enter a one-letter keyboard equivalent in the Access Key fexi

A. In the Tab Index text hox, enter the link's number in the

9, Click OK. The selected textimage is changed to a hyperlink Fig, 9,381 Hypedinked image

__#-_

Click the Browse bution, The Select
File dialog box will appear i, 9,190,
Browse 1o the folder that has the
target document for the hyperlink
and select the file. Then click OK to
return 1o the Hyperlink dialog box.

From the Target menu of the

Hyperlink dialog box, select the P

window in which the tarpet file - e [

should open, Choose from the T ;::___J_

following; - ) et = u

o _blank: Loads the linked file in a || smesnsimmestinssss I
new unnamed browser window. e e =

___F
- RALLY " t File dialog box
» _parent: Loads the linked file in Fig. 9.37 Selec

the parent frameset or window of
the frame that contains the link.
o self: Loads the linked file in the same frame or window 35 1 ’
« _top: Loads the linked file in the full browser window, thus Fig, 9.38a Hyperlinked fex
remaoving all frames.

broweser window.

bax. This will select the link in the browser.

tab order.

il ] i 1H1,

10. Select File » Save to save the document.

11.

Press F12 or click Preview/Debug in Browser to preview the page in a browser, When you
click the hyperlink, the linked web page will open in the browser.

Mow, there is a quicker method to create a hyperlink:

e

lect the text or image and drag the Point to File icon next to the Link text box in the Property

Inspector to the target document in the Files panel iFig. 9.34). Then select the option in the

Target text box,
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Fig 9.39 Point to File ican dragged 1o target document in the Files panel

named Anchor Links

You can link 10 a particular point of a web page by first creating a named anchor, A Named
Anchor lets you set a marker in the document, typically at the beginning of a topic or on top of
2 long page. Then you can create a link to the named anchor,

S0 creating a named anchor link is a two-step process. You | fast Forward
first create a Named Anchor and then you create a link to

the Named Anchor. Createa CTRL+ ALT+ A
riamed anchor

Follow the steps below to create a named anchor:
1. In Design view, place the cursor where you want

the named anchor. In this case, the cursor has been
placed beside the title Save Earth,

. Select Insert » Mamed Anchor.
Cr
Click NMamed Anchor on the Common tab of the
Insert bar.,

1, Ihe Named Anchor dialq}g box appears :|'.-r: .40, Type a name -ﬂS aAve Eﬂ r.l.h
ior the anchor, for example, Top, and click OK. The name cannm

contain any space. The anchor icon appears where the cursor is in Fig. 9.41 Anchor icon
the: Document window (g 9410, at the cursor position

P

Fig. 2.40 Mamed Anchor dialog box
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4. Select the 1o - ‘

; b et that will become the hyperlink, e Link tet box of the Property

F+ Type the name of the named anchor along with a £ sign 0 !
Inspector, Here we type #Top iFig. 1424

_-—-_-_-_-_

B 3

T Freparias
— - ——;_—
fratitegah ik ghylp-- (&) @ ERTE T B
et GongaTees v G B = s = [ o0 Exgaree e
et F L f__?Ft]I _1||__E" P |

Fig, 542 Link text box in Property Inspector

B. Select File » Save to save the file.
7. Select F12 or click Preview/Debug in Browser (o view
B. Click the named anchor text, it will move 1o the place where the anchor

9. Close the browser.

the page in a browser.
icon s sed.

Setting Link Colours
You can conirol the Colours the links on the web page show up in as described below:

1. Click Page Properlies... in the
Property Inspecior. The Page
Properties dialog box appears. Click
the Links category (Fig. 9435,

2. Set the Link font and font Sizes as
per your cholces.
3. You can set the following four
Colours for links:
* Link Colour: The default colour
of all the links on the page.
* Visited Link: The colour of 2 link
aftes it has been clicked. Fig. 943 Links category in the Page Properties dialog hox
= Rollover Link: The colour of a
link when the cursor is over it
» Active Link: The colour of a link when the user is clicking it
4, Choose one of these four underline styles: Always Underline, Never Underline, Show
Underline Only on Rollover, and Hide Underling on Rollover, Always Underline is selected
by default.
5. After making the desired changes, click Apply and then OK. Natice that the link Colour has
changed to red (Fig. 9.44),
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qdifying links
a gh!*tfi‘:k thie linke lext, The

: COMext mye
(Fig, 5441, el
.I,FF'EE[E -

vauy can change the linke file or
you can also see the contengs of

s clicking Open Linked Pape he linked page

A00ING FLASH BUTTONS

Flash butlons are

images that ¢ T e
Yiou can insert Fl an b h!rPErhnkerl.

: ash buttons in YOur documen
o make your web page maore attractive. Some of
these buttons have built-in animation

remove the link

(e 1 '
el gy v iy
L e T
' B L
By o

G |t T h:.'pl:ﬂl‘l:‘
Lren

Dipmcas.

L il brimipr

Remasr

Ve s ¥
L Ry 1 e .

Fig, 9,44 Context menu of linked imagedext

1. Place the cursor where YOU Wwani o insert the Flash buttan.
2. On the Common tab of the Insert bar, select Media and

choase the Flash Button aption from the men (Fig.

Or

select Insert » Media » Flash Button (Fig. 9.46),
3. The Insert Flash Button dialog box appears (Fig, 9.47).

Fig. 9.46 Media menu

Select a Style for the button. Type the Butlon
text. Select the Font and font Size. Browse 1o
the file linked to this button. Select the Targel

window.

0.45),

—= —
Tl Commwn  Logwd | Bases | Bele o ipw

wEAMEnE-¥-IDOY

e =
£ =

‘}dﬁij“l_"-E;HvEH

= Plah® e
XA Ninke padew

Fig. 9.45 Hash hutton in the
Insent pans]

Fig. 9.47 Insert Flash Bution dialorg boy

You can also change the hackground Colour of the button if you wish to.
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i_l:.ir””“,lullllln- riirir|
After selecting the desired options, click Apply- Thebulte™ 5
will appear on the wels page i, 1.4, 1f you like the m |
button, click OK.

Otherwise, change your selectians and click Apply 383i0 19555 gy 0,41 Button 0n the web gy,

hm'l.l- i |l_'n:|||c5‘ Flnﬂ” . 'I:IL k OK.
> i.'-'hl','k Hi‘r in the Wtf |f't!|]g¢tﬂf -“'IEI
her viewing the animatian.

Note: If it is an animated button, select the button and
Play bution will then change to a Stop button. Click Stop 2

e

rrr v
PRACTICE TIME @’

The computer science teacher has asked the students of dass WiIi g meke I“mf”al in Dreamwegver
53, Sobia decided to make 3 website on the Intesmet and the rerminology associated with i The
webste consists of two pages: InternetindexPageham| and internet Terminclogy homl The image
placed has 1o be finked to the web page explaining the terms associated with the Intermet. What would
be the steps you will have ta follow to create a simskar website?
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SOLUTION

Creare a folder called WeebSite3, say, in the My Sites folder on the C- drive, New, open
Dreamweaver.

Click Site ™ New Site. The Sive Definition for dialog box appears

Click on the Advanced rab Type the site name as The Internet and its Termmnalogy. Sec tha
local root folder to the WebSite3 folder and click OK_Store all image files in this folder.
Right-click the WebSite3 falder in the Files panel. Select New Rle from the conted menu
marme it IncernetindexPage huml Add one mere page and call it Internet Terminology homl
Mow, double-click InternetindexPagehtml o open the page.

Type the text an the Internet as shown in the figure

To formas the e, sefact the text and choose the required options in the Property Inspector,
To set 2 background Colour, click Page Properties in the Property Inspector. Thit will apen
the Page Properties dialog box Select the tackground Cotour and dick OK.

To insert the image. select the image in the Files pamel and drag i 1o the required position and
click Align Center in the Property Inspectar to center-align the image

To hyperlink the image, first select it and then in the Link text box, drag the Point to File con
oo Intermet Terminalogy html in the Files paned, The name will appear in the Link text box The
image will now have a blue border. This shows that the image is hyperinked

Sawe the page by pressng CTRL + 5.

Now to create the InternetTerminology.html web page do the following
1 Dﬂul:-le-r:lhzl.-m:m:Tennﬂdngr.h:ml in the Files panel to open it in the Document window

1 Type the content as given in Fl

vatwe of the pa
InternecTerminology heml.

puirers S and G, As It s a long page. the figures show two
ge—the upper part of internet Terminology heml and the kower part of
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link 1o the fop of
1 Asthe Page covers more than g screen, the batrom of the F.EIH.E'!'J'I'DI.IH havea

the page for easier navigation. To add a link follow these STeps

4 Bring the cursor to the heading e Internet Terménology an
burten on the Commeon tab of the Insert bar.

b. The Mamed Anchor dislog box appears. Type the na

Appear at the insertion pont
; , : ktext bo
€ At the bettom of the page, select the text Top of Pageand fype #Top'in the Lin »

of the Property Inspector The text will now be blue in Colour and underlined

& Now, tocreate a link 1o the IntemetindexPage horml click Media on the Comman tab of the
Insert bar 2nd select Flash Button from the submenu. Select che required Surton Lype. entel
text 35 Previous, and click OK. The button will be inserted. Resize it to the required size

5 Select the ‘Frevious” burton, In the Uink text b, drag the Podnt to File icon to
InternetindexPage homl in the Files panel 5er the target as _blank

6 Save the page by pressing CTRL + 5.

Mote: Save your web page whenever you insert any obyect or text,

7. Preview the IntemetindexPage hrm| page by clicking Preview/Debug in browser. Click the
hyperlinked image, which should open Internec Terminclogy.htmil Clicking the Previous butzon
should take you back 1o IntemetindexPage html, Clickng Top of Page should ke you to the
top of the same page.

websile 2 set of linked web pages related 1o a Hyperlink  a word, phrase, or image on a

4 click the Named Anchor

me ‘Top' and dick 0K The anchor will

particular topic decument that you can click to move 1o a new
Site  a local or remode storage location for tecument or 4 new bocation within the current
documents that belong 1o a website document
WYSIWYG  What You See Is What You Cet Named Anchor & named positian in a document
Memory Bytes £ .
a il
¢  Adohe Dreamweaver C53 s a full-featured * Together, the local and remote folders
commercial web editor. I helps to create, enable you to transfer files between the bocal
build, and manage websites. computer’s hard disk and the webs server.
» A Dreamweaver site consists of a local rood " The two ways 1o create & new websiie are:
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Cir
5 Click Site » New Sigg,
The tweD ways [0 Croatp
w Seloct File & New,

Or

» Right-click the website falder i the Files
panel and click New Fije from the contesy
nEnu.

+ The elements of the Dreamwesver sereen are
the Document window, Standard toollar
irsert bar, Document toolbar, |
Ingpector, Status bar, and Panel Broups,

s There are three ways to spt lext or image as 3
hyperlink:

A Mew weky pape are:

# Click the Hyperlink button on the Common

taby of the Insert bar.

Objective Type Questions

Cr
# Click the Browse ta File icon in the
Property Inspector,
Or
# Drag the Paint to File icon in the Property
Inspector 1o a document in the Files panel,

There ate two ways to insert Flash buttons in

your document, Some of these buttons have
built-in animation

¥ On the Insert bar welect Media on the

Common tab, and click the Flash Bulion
aptian in the meny.

Oy
F Select Insert B Media » Flash Butlon

!

1. Wrile T for the troe statement and F for Uhe false ane. Correct the false statementis),

a3 Dnce an image has been added 10 a web page, you cannot resize it |

B By default, the Property Inspector appears at the top of the window. ._ |

€ To preview a web page, click Preview/Debug in browser button in the document toolbar, | |
d. Split view allows you 1o see both the code and the web page for the same documient

in a single window,

&, The Property Inspector shows the cusrent properties of the selected element, B
. A named anchor lets the wser link to a specific location within a document, | v

L Chogse the correct oplion.

TR oo saseensenn, 12701 OpENs the destination document in the same document,

1, _blank ii. _parent iih, _child v, _sell
b, Dreamweaver displays afan ..., Tollowing the file name if you have unsaved changes,
by i, - . * L
OXFORD
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nd Calour through the
C. You can modify default propertics, such as the wih page backgrod
LT TSPARRRU . " ') 11| & ' iv. Page Modify
L. Page I?ij}lf-‘ng: Design ifi. Page Propertics
d. The Set magnification option appoars on thee e iv. Menu bar
i. Insen l1-.=|rE . I:I::l.u I:E:rp il, Documer! mdbmh-,pprllmk
e The o hox allews you lo {uern fhe S-E'!Etiﬂd pexd Into 2 g LIJ-F“_
i, Tanpet ii. Link i, Sre
Descriptive Type Questions

Amswer the follewing,

Differentiate between the local roat folder and the remote foldet

What are the different ways to start a new websited

How will you add a web page to a website folder? : )
How will you set a text or an image as a hyperlink using the Point 10 file icont
What is a Flash button? How will you add a Flash button to a web pagef

~p AN TH

Bilal's Science teacher has asked him 1o create a web page for his Science project. Bilal is

confused whether 1o use HTML or Dreamweaver to make this page. Analyse the advantages and

disadvantages of both software. Which one would you prefer?

g Dreamweaver provides a nummber of options when it comes 1o dealing with hrpl-'i‘|liﬂ|:!-. such as
where to put the hyperlink, defining anchor links, and giving different colours 1o links, Evaluate the

usefulness of all three features in relation to browsing on the Internet.

h. Create a web page for yourself entitied ‘This is ME!’ Use s many of the features as possible that
are mentioned in this chapter. Your page should include some personal infarmation, som pictures
flinked and not linked), and any ather information that is imponant to you. Make sure to save yow

wark as this will be needed in the next chapter.

Application-Based Questions
a. Saba has added a web page titled Untitled-1 to her

[

wehsite using Dreamweaver, She has typed some text in

l':'
ne

I B
this web page as shown in the figure given alongside, | S P L STV T W o P
L. What is the meaning of the * sign after the web l] A best friend is someone

page’s narmed

i, The pointer moves by 2 lne spaces alter she presses
the ENTER key. Now she wants to move the pointer
by 1 line space. What should she dof

b. Consider the figure shawn in QT again and answer the o

who knows all about you
and loves you anyway

iyt Pkt -

L | |
mﬁ_l_-. T i [ L

following:
i. Which button is used to view the web page in 3 web broweer?
ii. Which button should be clicked 1o see the HTML code of the web pape!
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. Consider the wieb page pivog

1 SWOT - Ll s el 1.
:;_ﬁ:;ﬁ and an thie qu:r.-..-ing up..; o —— T BB | € I Gl e iitin
: O N W OO . VN L VT L VR POV . PPN ., P [, P O Y.
i ﬂDwislhELm:hg-“mml = E m“m&um.mwﬂ:‘h~ Bikstio b
hhledifhﬂ'ﬂnlfrmnlmmﬂ screen. There are two types of printers:

il. Which property in the

Property Inspector has been
used?

e N e T TF I Wl

d. MName the butions used in the Property
Inspector to format the text in the web

page given alonpside on the left,

e, I:mvrla has ad!:ied an image to her web page by selecting the image in the Files panel and dragging
it to the required place, Mow she wants ta set the properties of

- the image as given below using the
Properties Inspector. b

i To give a border of 10 poims around the image what should she do? What will be the colouwr of
the horder?

. What will be the quickest method 1o furn this image into a hyperlink and link it to WebPage! htmi?
Ik, After setting the image as a hyperlink, what will be the colour of the border?

ﬁ IN THE LAB

1

. Rahman, the monitor of the class, has been given the task to create a web page for his class. The
web page should list the various subjects taught in the class along with the respective names of the
subject teachers. He then needs to insert a picture of the class teacher and save the page by the
name Claseyiil itml. The teacher has asked Rahman to format the page as per his choice. Design a
similar weh page for your class,

2. The head bay af the school has been assigned to create a web pape regarding the facilities availabie

in the school—Iabs, sports facilities, swimming pool, Smart classes, school bus, etc. Also emphasize
on the dedicated staff for these facilities in the school, As the page & very lang, create & named

anchar linking to the top of the page. Help him complete this task.
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Images and framesets
In Dreamweaver 853

I ' -— o
: wwekrhray b rbim | - = -
i .. E & (1 j AM Miess vt pridiee Framesetd 20l frames
sETIE 2] e wer IFHEE D s
5 8 14l T r HEPE i I_f‘-rqlll-F “m-rn . -"-I.:..I"' T AT il
i T

wurtg Framesets and

Corme ey e
bt e

¥eni st have seen websites that have 3 hanner at the top
il 4 mavigation bar on the lett. On clicking an option an

i bl (e LT ining information APpHERTS-0 the ﬂﬂht.
In this chapter, we will discuss how to make professional
lnoking wiebsites using framesets and frames; As you knonw,
I make a website mote attractive We will also discuss
follover images and image maps and learn (0 insert date/timse
and tables in a web page

There are many different file formats foF SEOTING IMages,
I:"JI '::'T!'Ill' ||'I[l;'r ol It et IR TTRE S e I-' r|-'|:'-'" Ed 1|:|r LisE '”.I WEh
:“'j!:'["_i., Miost !.“"l.'ll-'. LS .,.|||;.i'||_]r| thiesa Tormaes:

* Graphic Interchange Format (Gl
* Joing Photographic Experts Liroup (IPEC
* Portable Network Group (PNC]
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INSERT DATE

Dreamweaver provides a lhhuhin-:lud-ti:h
format (with or without time} and provides t
the file, i
L luﬂmhmmwhﬂm place
Mimﬁmpmwmm
want the date to be inserted.
2l s
mﬁcumuhumaam :
bar, click the Date bution.
3. The lsert Date dialog box e _
i e teaon. O B ————

B i

5. Click OK 1o insert the date and time.

INSERT TABLE

You can use the Insert bar or the Insert
ment 1o create a table, Add text and

images to the table cells the same '|.e|.'.1_',rt|-|qd.r
you would add text and Images on it b
web page. 1
1. In the Design view of the Documenl
window, place the insertion paint X
whese you want the table to appear.
2. Select Insert » Table |
(8]
O the Comman tab of the Insert bar,
:ﬁni‘l‘illt. '
3. The Table dialog box appears (fig, 102
St the following attributes;

'ﬂl-ﬂﬂ
. MlﬁﬂmhﬂﬂummhﬂdmﬂmnWe
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Follow these steps 1o create a rollover image: e My
1. Place the insertion poim whese you want the g
rollover image to appear in the Document window.

2. Click Images on the Common tab of the Insert bar
and select Rollover Image (Fig 1040 1| G Forwmarka TS
Or T rT—

Select Insert b Image Objects » Rollover Image
tFig. 10.5),

Image dialog box
appears (Kl 106,
Enter the following
information and click
OK when done:

= lmage name
The namae of the

HTIaRRE.
* Original image
ﬁf‘"ﬁ“'

iy 10,6 Insert Rollover Iowage diilog o

« Preload rollover image  Specifies whether to preload the images
50 there is no deliy when the aser rolls the pointer over the imag

* Alternate Text mﬁnnal: Text tn describe the

4. Pross F12 or click Preview/Debug buton and select
t:l-r )
Select File » Preview 1o view the web page ina browser |
5. Mave the pointer over the oniginal image to see the rallo
m & (1] ] w 'mz
L deneed g
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Fig. 10.7 Origjnal Image Fig. 108 The mllover image

sGE PLACEHDLOER
npetimes (| may so happen that the image or images you wish 1o use in your web page of
wetisite may ot be ready. In such cases you can use image placeholders.

an image Fhl:l'!hﬂmﬂ 15 & graphic you use antil the final iImage o be added 1o a weh page s
dpcided. You can set the placeholder’s size and colour as woll 33 the text label,

I the Document window, place the inseriion point where you want ko jnser 3 placeholders

gm—phit. B
1 Click Images on the Common tab of the Insert e s s S
hat and select Image Placeholder i 10.41.

Cr

select Insert » Image Objects » Image
PMaceholder (Fip 1050

L The lma;t- Placeholder dialog hox appears
in Hinn: optional) enter i
as 3 IEIJE; i?: the image placeholder, Leave the text box blank if you do mmm a Iﬁel iﬁ
ipqsaar, The name must h.ugin with a letter and can contain ﬂnl‘r’ lmﬂiﬂmm

are not allowed.

C. FﬂMTﬂlﬁFﬂﬂﬂilh mrlrﬂtﬂ:bl'-‘l‘ibﬂ-lh!'
waﬁewmuﬂmi ext-only browser.
ik Click OK.
4 mtp!mldﬂ‘i calour, size attributes, ﬂﬂd |abel
ﬂmﬂﬂniﬁﬁﬂmﬂ Lo,




3. 'When viewed in a browser, the label and size text do not
apxpear (Fag, 10,111, What is seen is the alternative text you
have specified.

IMAGE MAPS

An image map is an image divided into clickable regions called
hotspots. Hotspots are hyperfinks.

When a user clicks a hotspot, the destination of the hyperlink is

displayed. A hatspot can be in the shape of a rectangle, a circle,
or-a polygon, For example, cansider Figare 10112 showing various

When vou click on any one device, you can make infarmation

on that device appear,

Do thie following to create a haotspot.

1. Select the image in the Document window, ‘ ]

2. i you are using multiple image maps in the same document, '

type a unique Map Name for each in the Property Inspector

e 10130 Fig: 10,12 Image showing
virioas lnput devices

Fig. 1011 Imeage
in bronwser

input and output devices,

Ao Type Pajs heame

S bt gy O3 M Poddeanm - L pe——

B — Bl LR
o Ve tem| | wel | RES
M DD swew  tewhe =i D M Dewa =)

1. Tos defirie the image map area, do one of the following:

Sulect the Circle or Rectangle tool and drag the pointer aver
the image to create a circular or rectangular hitspol

Or
Select the Polygon tool and click the cormers for an irregularly
shaped hotspot.
Lot us, as an example, select the Rectangle ool and drag it
over the (rmage of the track ball (Fig. 10141 Click the Arrow
tool to close the shape.
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L T]'!E' Hﬂt'.'rl.'-“ Frﬂm"'}' Il'l:l:l]:!'f_‘lur EFPEHH- Fig 10
ppen when the user cfj; ks the link.

155 The Link text box specifies the file 10

Fifi, 10,15 Hatspol Property Inspector

Click the folder icon to browse 1 and select the file.

Che
Drag the Point 1o File icon 1o the required file 1 the Files

 Select one of the following for Target:
o _blank Inads the linked file o g fw, e bowsts
window

o _parend loads the linked file into the pasent frameset o
winelow

o _self loads the linked file into the same frame or window

o _top loats the linked file into a full browser window,
therely remiwing all frames

7. In the AR text bow, type the alternative et that will display in
ret-only browsers,

(5]

-

Fig. 10,16 dmage map willi
thriw hotspols

b. Repeat steps 1 10 7 o define additional hotspots
in the image map, Figue 1016 shows the image

Filie

E Cib e SN Sy O«
L View  Fauordes  Tpew *

map with three hotspots: rectangular, circular, and
9. Adter you finish, click a blank area in the document
‘o change the Praperty Inspector
- View the page in a browser by pressing F12, o
clicking Preview/Debug in Browser, o selecting
File » Preview ([ 10071
1. Mave the pointer over the track ball image. Hotspots
are: hyperlinks. so the pointer changes 1o a ‘pointing
finger’ symibol when it moves oves them. Click a

183
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PRACTICE TIME ﬁ

—

The: History reacher wants the students of class VISl 1o mriake & web page showing the Seven
Wonders of the Warld. Fark of the Wanders should be x hoespot, VWien o Lser clicks i hotspat-a

web page with details of the Wonder should appear, How should they proceed!

SCOLUTION
L Create a root fokder forthe websne You can use the one you created in Chapter 3.

L Rightclick the folder in the Fibes panel and select New Folder
from the contest men

Hename the folder and ca¥ i« Wonders Image Map.
Seven Wanders of the World
4 Hight-click the lolder and sdact New File from the

COniest el

P

2 Hpname the ffe SevenWonders homl

B, Create another hle and terame as TaMahal heml

7. Double-chick the file Seven'Wondershtrid The New
Document dialog box appears

& Vype the teax and msert the miage 18 shawn In

Famame 1oa
9 Now, select the irtage in the Document wincomw
i i the Property Inspector. select the Rectangle tool S evea Wondars of the World
and chick aroand thie frage of the Taj Mahal w0 make i
a hatspot (7 106 Click the Arrow todd 1o chse the
shape
T - After creating the hotspot s shown, ko Property
Inspector dsplays the Hogspol properties
Do the following
a  In the Link box, drag Point to File o the tequied -
e ip the Fﬁ'ﬂﬂﬂ e -
b in rhe Target popup menw wlect _self so thit the e e
linked web page appean i the same window
e in the Alt box, type the altesratre teat for test-0nly browsess
72 Repour s 18 and 11 b0 define additional hatpats in the image
appropriace files in the Wionders Image Map folder . | .
15 Afver you finsh, click the blank ates i the document mdmp_ﬂ-:,_ roper ¥ Inspecter
14 Doublicick the flle Tapahal biml in the Fikes paned and type the fegy '

Fig. 100 SevenWanders htm







P

LD g [Fm—

-'h-il—l- L3 e S s

"’*Hﬁ-ﬂ!

B "

¥ -~

Fige 10,11 New Document didlog box:

4. The Frame Tag Accessibility Attribules dialog box appears (Fig 10,750 Change frame titles as
required and click OK.

Fig. 10.1% rmﬁm
Attribites cliilog bux

4. Amhnuﬂwm:m
of thres frames s insened
g 102001, i the Frames
panel s not visible, select
mi-lmumuﬂmm . i
The Frames panel visually represents the frames within a frameset. A v
sistrounds the frameset. s

5. To resize 4 frame, drag the frame bardor (1ie. 10.41).
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Book Piracy and
Plagiarism

are criI"I'IES_
Beware of both! 4

® A colour shift oval with an image of thie Quaid s
mausaleum changes calowr from srange to grasn
whan viewsd from different angins.

& Tha labsebs tmar if peeied from the book cover.

& The labels hawe securisy rut marks on the Top and an
the bottom ta prevent them Tiam being pesled o and
Fetasad,

& The word TRIGINAL appesrs whan the sres under
Rigls Here i rabibed with s coli,

® Thee wards ONFOND UNIVERSITY PRESS * weitten n
wary vmill print becoms visible when viewed through
n magnifying gass.
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